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1 Overview 

Introduction 

GLOBAL IP ESTIMATOR is an easy-to-use program that generates 
estimates for Intellectual Property applications in most countries of the 
world. The estimates are based on the Minimum Fee Schedules supplied 
by associates in these countries. The user selects the countries desired, 
then supplies the particular information requested for that application, 
e.g., the number of pages in the application. Estimates are then 
automatically calculated, and presented in both summary and detailed 
formats.  

Patent Estimates that include the PCT or EPO phase can be created in 
one step for all phases in the application process, including the National 
and EPO Validation phases. Also available is the ability to exclude 
specific fee categories, as well as various stages, e.g., Filing stage.  

The user may edit the In-House fees, creating different sets if desired. 
Currency rates may also be edited. While the Foreign Associate fees are 
accurate as supplied, the user may set fees and costs for all countries as 
desired. Scenarios of countries and application data can be saved for 
future use.  

GLOBAL IP ESTIMATOR creates estimates for Patents and 
Trademarks. Additional software packages are available to create Design 
Estimates, Assignment Cost Estimates, and the projection of costs on a 
Timeline. 

 Supplemental Software Packages 

Supplemental Packages are available as follows: 

••••    Design Module: for Design Estimates. 

••••    Assignment/Modification Module: for Assignment and 
Name/Address Change Estimates. 

••••    Prosecution Module: for charges related to the prosecution 
process of patent applications. 
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••••    Timeline Module: to create Excel spreadsheets with costs 
allocated to specific years. 

••••    User Fee Rules – Detailed Module: with the ability to specify 
User Fee Rules under complete user control. 

Installation and Getting Started 

•••• Program installation instructions may be found in Appendix A. 

•••• License installation instructions may be found in Appendix B. 

Once the program is ready to use, it is important that the user 
customize the data to conform to his or her practice. A discussion of 
this “Initial Customization of Data” process may be found in 
Appendix C, covering: 

•••• Review of In-House Charges. 

•••• Data settings for users in the U.S. and outside the U.S. 

•••• Home Country Charges. 

Getting Help 

 Training  

 Tutorial Slide Shows 

The slide shows take just a few minutes to review and give a 
good overview of the estimate preparation process. Demos are 
available on the following subjects: 

•••• Patent Application Demo: Provides a brief overview of 
how to prepare an estimate for patent applications. 

•••• Trademark Application Demo: Provides a brief overview 
of how to prepare an estimate for trademark applications. 

•••• Menu Options Demo: Provides a brief overview of the 
various options and functionality available in the GLOBAL 
IP ESTIMATOR program. 

The Tutorial demos can be viewed from the Help Menu. 
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 User’s Guide 

The User’s Guide gives instructions for working in all areas of 
the software, from preparing basic estimates to advanced editing 
of settings and values used within the system.  

 Troubleshooting 

 Help Menu  

Help can be accessed by selecting the Help Menu at the top of 
the first screen that appears for GLOBAL IP ESTIMATOR. 
There you can choose to review information by content, index, 
or search mode. When on other screens, click the Help button 
that appears at the bottom left-hand side of each screen. There 
you can choose help by content or search mode. 

 Technical Support 

If, after reading the User’s Guide and accessing the Help 
sections, you feel you need further assistance, please contact our 
Technical Support by calling Quantify IP at (808) 891-0099; by 
sending email to support@globalip.com; or by sending a fax to 
(808) 891-0299. 

GLOBAL IP ESTIMATOR includes some tools that will 
automatically send information that may be useful in diagnosing 
and fixing problems. These tools are located on a submenu of the 
main Help menu. If they are needed, you will be directed to that 
menu item, and further instructions will be provided by our 
Technical Support. 

 Uninstall 

There are two separate installation packages associated with 
GLOBAL IP ESTIMATOR – one of the initial program and 
files, and the second for the monthly update. Both packages need 
to be uninstalled to remove GLOBAL IP ESTIMATOR. 

An easy uninstall feature was added in December 2005 in order 
to facilitate uninstallation of either the full GLOBAL IP 
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ESTIMATOR program or the monthly updates, if it becomes 
necessary. 

From the Windows Start Menu, choose Programs, then choose 
the Global IP Net option, and if the full program has been 
installed since December 2005, the option “Uninstall Global IP 
Estimator” will appear. The option to “Uninstall Global IP 
Estimator Monthly Update” will always appear. 

GLOBAL IP ESTIMATOR may also be uninstalled through the 
Windows Control Panel, Add/Remove Programs. Both the full 
and monthly update packages will be found there. 

The Initial Registration  

GLOBAL IP ESTIMATOR uses a license registration process. Every 
computer using the program is issued a Registration ID. This ID 
must be sent to us so that Monthly Updates can continue to run at 
that computer. You will be asked to send your Registration in when 
installing the license for a computer.  
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Generating an Estimate – Basic Steps 

To start the program, click on the GLOBAL IP ESTIMATOR icon. 
The initial screen will be displayed, as shown in Figure 1-1: 

 

Figure 1-1  Initial GLOBAL IP ESTIMATOR screen 

Click the appropriate radio button to identify the type of Application 
desired. Then click the Proceed button.  

The ‘Country Selection’ screen is presented, as shown in Figure 1-2: 
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Figure 1-2  Country Selection screen 

The list on the left shows possible destinations for an application, 
and includes all countries in the database plus the EPO and PCT (for 
patents). To select destinations, click on them in turn. The 
destinations selected are then displayed in the list on the right. In 
Figure 1-2, Australia, China, and European Patent Office have been 
selected. 

Click on the Proceed button after destination selection is complete. 

Based on the destinations you have selected, the program determines 
the relevant application parameters, and presents the ‘Enter 
Application Information’ screen, as shown in Figure 1-3: 
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Figure 1-3  Enter Application Information screen 

In this screen, you enter the appropriate numbers into the list on the 
left. You can tab or use the arrow key to move between the fields. 
You change the values of the Yes/No options on the right by either 
tabbing into the box or clicking the item so they are highlighted and 
using the space bar to change the value. 

At this point, you have the option of saving the scenario for future 
re-use or reference by clicking the Save Scenario button. A new box 
will appear, allowing you to name the scenario. Scenarios will be 
discussed in more detail in Chapter 5, Scenarios. 

Click the Proceed button when all data about the application has 
been entered. 

The estimate is calculated, and presented in Condensed Summary 
Report format, as shown in Figure 1-4: 
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Figure 1-4  Estimate Condensed Summary Report screen 

You can also choose to view the Summary Report of the estimate by 
clicking the View Summary Report button which brings up the 
‘Global IP Estimate – Summary’ screen.  

Clicking the View Detail Report button brings up the ‘Global IP 
Estimate – Detail’ screen, which displays a detailed version of the 
estimate. This screen is shown in Figure 1-5: 
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Figure 1-5  Estimate Detail Report screen 

Estimates may be printed from any of the report screens. To print, 
click the Print Reports button while viewing the report you wish to 
print. 

Additional information abut each of the report formats is available in 
Chapter 6, Reports. 

Data Used in Generating Estimates – Fee Rules 

For each country, Fee Schedules from associates are used to 
determine the fee rules used by the database to calculate estimates. 
Some fee rules reflect fixed amounts, and some depend on the 
attributes of the application, such as the number of claims.  

The fee rules for a Patent application include categories for the 
filing, examination, prosecution, granting, and maintenance stages. 
Another set of categories is for official and associate’s charges and 
translation costs. For some countries this categorization is not 
possible, since the Minimum Fee Schedules do not separate these 
charges. 
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For a Trademark application, categories for the stages of search, 
filing, registration, and renewal are used. 

A further set of fee rules reflect in-house charges, such as the U.S. 
user’s costs for handling the application, and various costs incurred 
locally. 

The program calculates estimates based on current Official and 
Foreign Associate’s fees and current exchange rates. Historic fees or 
exchange rates are not available, and projected future fees and 
exchange rates are not available, unless the user enters Associate fees 
and exchange rates themselves. (See Chapter 8, Edit Menu, for 
additional information on making data changes.) 

Data Modifications Available to User 

The display currency of the reports can be changed from the Report 
screen. The default currencies available are Euros, United Kingdom 
Pound Sterling, and United States Dollar, but any world currency can 
be selected by editing the Favorite Display Currencies on the 
Reports screen. Additional details are available in Chapter 6, 

Reports. 

Foreign fee rules can be modified using percentages. You can 
specify that a percentage of greater or less than 100% of the given 
official fees, associate’s charges, or translation costs be used in the 
estimate. These percentages may be specified once to apply to all 
countries, or specified on a country-by-country basis. 

You can also set foreign fees and costs by country and application 
type. Several methods, varying in complexity, are available for 
entering these fee rules. 

Each estimate contains monetary amounts for in-house fees and 
miscellaneous costs which are based on local processing charges. 
You can change the values used in the fee rules in these calculations. 

You can also specify the actual translation cost per page for one or 
more languages. This specified cost will replace the system-supplied 
translation cost. 
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The user can also modify the currency rates. The Monthly Update 
will include the latest currency rates. 

You can also enter a comment to print at the end of the Summary 
Report and Detail Report for a particular country, as well as change 
the Report Headings for in-house amounts.  

Chapter 8, Edit Menu contains a detailed description of how changes 
may be made by the user via the Edit Menu. 

The Main Menu Bar and Other System Functions 

The initial screen (shown in Figure 1-1) has a menu bar at the top. This 
menu bar is used to access various functions, such as changing the in-
house fees and costs used in the estimates. 

 File Menu  

Figure 1-6 shows the File Menu: 

 

Figure 1-6  The File Menu screen 

This menu allows you to access the setup for the printer, the default 
path for saved files, password function for the Edit Menu, and to 
exit the program. 

 Edit Menu 

Figure 1-7 shows the Edit Menu: 
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Figure 1-7  The Edit Menu screen 

This menu accesses the ability to modify both the numerical data 
used in calculating estimates and certain report headings. It also 
allows access to certain user-defined information, including 
exchange rates, country specific settings, in-house data, translation, 
and user defined associate charges. You can password-protect access 
to the Edit Menu by choosing “Edit Menu Password Setup” from 
the File Menu. 

 Reports Menu 

Figure 1-8 shows the Reports Menu: 

 

Figure 1-8  The Reports Menu screen  

This menu is used to view and/or print certain sections of the data 
used in generating estimates. 
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 Licensing Menu 

Figure 1-9 shows the Licensing Menu: 

 

Figure 1-9  The Licensing Menu screen  

This menu is used to register your license, view and print license 
information and end-user license agreement, as well as activate 
additional licensing options. 

 Help Menu 

Figure 1-10 shows the Help Menu: 

 

Figure 1-10  The Help Menu screen 

This menu is used to access the Help section, as well as information 
about the software, licenses, and registration. The Tech Support 
option will be used as directed by the GLOBAL IP ESTIMATOR 
Technical Support personnel for assistance in troubleshooting. 
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 Monthly Update 

The data used for generating the estimates are updated on a monthly 
basis. The Monthly Update is ready by the second business day of 
each month and may be downloaded from our web site. Clients are 
notified by email when the update is ready for download. U.S. and 
Canadian clients have the option to have the Monthly Update sent on 
disk, via U.S. Mail. 

The Monthly Update contains: 

•••• Current Official and Associate Fees 

•••• Current Exchange Rates 

•••• The Latest Version of the GLOBAL IP ESTIMATOR Program 

The Monthly Update does not affect the User settings. For example, 
In-House Charges are not affected by the update. 

When installing the program on a new computer, or re-installing the 
program, use the original program CD (or original full program 
download), and the latest Monthly Update. The program and data 
will be fully up-to-date, and earlier updates need not be installed. 

If the program is installed on several computers and the same 
settings for user-defined data are required on all of them, one way to 
ensure this is to have the main “gipuser.mdb” file on one computer, 
and copy this file to other computers whenever a data change is 
made. 

If the program is re-installed, user settings may be retained by saving 
the “gipuser.mdb” file and copying it into the application folder after 
re-installation. 

 Is the Latest Update Installed? 

To check the date of the update being used, go to the Help Menu at 
the top of the initial ‘Global IP – Main’ screen. Click the “About” 
item. The screen displayed will show the “Data ID”. This is the date 
of the latest Update being used. 
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 What’s New 

As seen in Figure 1-1, at the top of the initial GLOBAL IP 
ESTIMATOR screen is a What’s New button. Every release of 
GLOBAL IP ESTIMATOR will include a quick overview of what 
new functionality has been recently added.  

 Share 

This is a quick and easy way for you to share information about 
GLOBAL IP ESTIMATOR. As seen in Figure 1-1, the Share button 
near the bottom of the main screen allows you to send an email to a 
colleague, whether within your company or not. You can change the 
text or subject of the email; the email is added to the ‘Outbox’ of the 
email program your computer is configured to use. 
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2 Country Selection 

Introduction 

After you select the type of application desired from the initial screen, 
the ‘Specify Destination(s) of Application’ screen appears as shown in 
Figure 2-1. This screen is used to select countries/destinations for which 
application estimates are needed. 

Stages may be excluded from the estimate via this screen: 

 

Figure 2-1  Country Selection screen 

Selecting Countries 

To select a country, click on it in the list box on the left, which 
moves it to the list box of selected countries on the right. To de-
select a country, click on it in the list box on the right.  

To find a country in the list box on the left, use the scroll bar. A 
quicker method is to press the first letter of that country on the 
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keyboard. The left-hand list will immediately display countries 
starting with that letter.  

Selecting EPO and PCT Applications 

To specify an EPO destination for a patent, either click in the check 
box marked EPO Application, or click on European Patent Office 
in the country list box. Specifying EPO removes EPO members from 
the list of available countries. 

To specify a PCT destination for a patent, either click in the check 
box marked PCT Application, or click on PCT (International) in 
the country list box. Specifying PCT removes PCT members from 
the list of available countries. 

If you wish to include one or more PCT or EPO countries as well as 
the PCT or EPO, select these countries first, and then select PCT or 
EPO. Additionally, after selecting either PCT or EPO, a Show All 
box is displayed below the country list. Checking this box redisplays 
all countries. 

Search and Examination for PCT 

When the PCT Application box on the upper left of the screen is 
checked, the current PCT Offices settings are displayed to the left 
middle of the screen, as shown below in Figure 2-2:  

 

Figure 2-2  Receiving Office/Search/Exam 

This option is included because the estimate for a PCT application is 
affected by where the search and examination will be performed. 
Also, the estimate for sending a completed PCT application to the 
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EPO is affected by where the search and examination were 

performed. 

To change the settings, click the Edit button. This will bring up the 
PCT Offices screen, discussed in Chapter 8, Edit Menu, PCT 

Offices. Change the settings in that screen. From that screen, you can 
set the new selection of Offices as the default by checking the ‘Set 
As Default’ checkbox at the bottom of the screen. 

Two- and Three-Stage Estimates 

An option is available to create estimates in one step for all phases in 
a PCT or EPO Patent application process, including the National and 
EPO Validation phases. 

The ‘Specify Destination(s) of Application’ screen (with PCT 
selected) is shown below: 

 

Figure 2-3  Specify Destination(s) of Appliation with PCT selected - Two-

and Three-State Estimates screen 

Notice that PCT is chosen. When PCT is chosen, a checkbox to the 
middle right of the screen is displayed – Add PCT National. If this 
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box is checked, after the Proceed button is clicked, another ‘Specify 
Destination(s) of Application’ screen is displayed, in which the PCT 
National Phase countries are selected. 

Similarly, if EPO is checked in the first ‘Specify Destination(s) of 
Application’ screen, the Add EPO Validation checkbox is 
displayed. If PCT is chosen here, and EPO is chosen in the second 
‘Specify Destination(s) of Application’ screen, the Add EPO 

Validation checkbox is displayed in that second country selection 
screen. If checked, a third ‘Specify Destination(s) of Application 
screen’ is displayed with EPO countries for the Validation phase. 

All countries selected in these screens appear on the same estimate 
report. 

Excluding Stages 

The lower left of the ‘Specify Destination(s) of Application’ screen 
(see Figure 2-1) has boxes that you can check to exclude some of the 
stages of an application. 

Excluding a stage may be desirable if, for example, you need an 
estimate based on the filing and examination stages only (for a Patent 
application). 

If you exclude all stages except maintenance for Patents, the 
Condensed and Detailed Reports will display information; the 
Summary report will be blank for this selection. 

For a Trademark, you can exclude each of the search, filing, 
registration, and renewal stages. Note that the Exclude Search and 
the Exclude Renewal boxes are checked as the default position, and 
need to be unchecked to include search or renewal costs in the 
estimate. 

For Trademarks, a Renewal Only option is available. 

Please Note: For some countries, separate information is not 
available for every stage. For example, when you exclude the filing 
stage for a Patent, the estimate may provide only the maintenance 
fees for a particular country, since the fees for the examination and 
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granting stages are not explicitly specified in the fee schedules for 
that country. 

Specifying Range of Years for Patent Annuities 

The default setting for range of years for Patent annuities is 1 to 20. 
To change this setting, click in the Include Maintenance for Years 
boxes for the beginning and ending years. 

Whenever a range is entered that is different from the default setting 
of 1 to 20, a comment will be added to the estimate.  

Excluding Categories of Costs 

You can exclude each of the four categories of costs, individually or 
in combination, to create an estimate that shows only the types of 
costs that you wish to include. These categories are: 

•••• Official Fees: Official Fees in the country, if they appear 
separately in Fee Schedules from that country. If not, these fees 
are included in the Associate category. 

•••• Associate Fees: Foreign associate charges, including VAT if 
any. 

•••• Translation Fees: Translation costs, if necessary. 

•••• In-House and Miscellaneous Fees: In-House fees for various 
stages of the estimate are calculated from numbers entered by the 
user. Miscellaneous in-house costs, such as fax charges, are 
calculated from numbers entered by the user. 

Running a Madrid Protocol Trademark Estimate 

In order to run a Madrid Protocol Trademark estimate, choose 
Madrid Protocol in the Country Selection screen. Do not choose the 
countries to be designated in this Country Selection screen. 

A second screen listing all the countries party to the Madrid Protocol 
will appear as shown in Figure 2-4; select the countries you wish to 
include. GLOBAL IP ESTIMATOR will calculate the number of 
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countries designated, and will include Individual Fees where 
appropriate. 

 

Figure 2-4  Madrid Protocol Country Selection screen 

The Select All button will choose all of the Madrid Protocol 
countries which have Individual Fees. 

There are three Yes/No item specifically associated with the Madrid 
Protocol estimate: 

•••• MP T/M filed with USPTO: If marked as Yes the Official 
Certification fee charged by the USPTO is added to the estimate. 

•••• MP T/M filed with UKIPO: If marked as Yes the Official 
Handling Charge charged by the UKIPO is added to the 
estimate. 

•••• MP - Subsequent Designation: If “Yes” is selected, this option 
includes the costs for extending the scope of the international 
registration to members of the Madrid Union for whom either no 
designation has been recorded to date, or the prior designation is 
no longer in effect. 
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Eurasian Patent Convention Help 

To include the Eurasian Patent Convention in the estimate, choose 
Eurasian Patent Conv. (EA) from the Country Selection list. 

A secondary screen will appear as shown in Figure 2-5, from which 
the individual countries can be chosen. Choosing a country will 
include that country’s renewal fees in the Eurasian Patent 
Convention estimate, as well as other fees and charges specific to the 
Eurasian Patent Convention. 

 

Figure 2-5  Eurasian Patent Convention Country Selection screen 

To select individual countries, click on the name of the country. To 
remove a country from the selection, click on that country on the 
right-hand side; it will be moved back to the left-hand list. 

The Select All button will choose all of the Eurasian Patent 
Convention countries. 

After the countries have been selected, clicking the Proceed button 
will return the user to the Specify Destination(s) of Application 

screen. 

Clicking the Reset button will remove all of the selected countries, 
will remove the Eurasian Patent Convention selection from the 
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country selections on the Specify Destination(s) of Application 

screen, and will return the user to the Specify Destination(s) of 

Application screen. 
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3 PCT and EPO Estimates 

Introduction 

The Patent Cooperation Treaty (PCT) implements the concept of a single 
international Patent application with legal effect in the countries bound 
by the treaty and designated by the applicant. By filing an original 
application in one of the PCT-member countries, the applicant reserves 
the right to file patents in each country at a specified later date.  

Choosing to pursue this option is usually less expensive initially, and can 
allow the applicant time to test-market an application before filing 
Patents in individual countries. 

The European Patent Convention (EPO) offers the same sort of 
protection and process. 

After the initial filing, search, and examination steps, the PCT approach 
requires that applications be filed in the individual countries specified by 
the applicant. 

After the grant of an EPO patent, a validation step is required for the 
chosen countries. 

GLOBAL IP ESTIMATOR allows you to estimate the costs involved in 
both the PCT and EPO, either individually or in concert, and affords a 
great deal of flexibility in creating accurate estimates. 

The process is best described via examples. This section assumes you are 
familiar with the overall process of generating an estimate.  

Examples Including PCT and EPO 

The following examples illustrate the process of generating estimates 
that involve the PCT and EPO. Suppose that a Patent is desired in 
Japan, Australia, the United Kingdom, and Germany. 

 Route 1 - File Applications Directly in Selected Countries 

In this example Patent applications are filed directly in each country. 
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To generate this estimate: 

•••• Choose Patent on the ‘Global IP – Main’ screen. 

••••    Choose Countries: Japan, Australia, United Kingdom and 
Germany on the ‘Specify Destination(s) of Application’ screen. 

••••    Enter Application information on the ‘Enter Application 
Information’ screen and obtain the estimate. 

 Route 2 - The PCT Route Followed by National Applications  

Since these countries are all members of the PCT, the PCT route 
could be taken. First, file a PCT application. Assuming that the full 
delay possible via the PCT process is taken, national applications 
would then be filed 30 months after the initial PCT application.  

Two options for generating this estimate using the software are 
available: 

either 

 1) Generate an Estimate in One Report: 

•••• Choose Patent on the ‘Global IP – Main’ screen. 

••••    Choose PCT Application on the ‘Specify Destination(s) of 
Application’ screen, and check the box Add PCT National. 

••••    Choose Countries: Japan, Australia, United Kingdom and 
Germany on the second ‘Specify Destination(s) of 
Application’ screen presented. 

••••    Enter Application information on the ‘Enter Application 
Information’ screen and obtain the estimate.  

or 

 2) Generate an Estimate in Two Separate Reports: 

This method gives you an estimate for the entire process as two 
reports. The two reports reflect the fact that the two steps are 
performed a long period apart. 

•••• Choose Patent on the ‘Global IP – Main’ screen. 
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••••    Choose PCT Application on the ‘Specify Destination(s) of 
Application’ screen. 

••••    Enter Application information on the ‘Enter Application 
Information’ screen and obtain the estimate for the PCT 
phase. 

•••• Go back to the ‘Global IP – Main’ screen using the Return 

to Beginning button and choose PCT Patent – National 

Phase. 

••••    Choose Countries: Japan, Australia, United Kingdom, and 
Germany on the ‘Specify Destination(s) of Application’ 
screen. 

••••    Enter Application information on the ‘Enter Application 
Information’ screen and obtain the estimate for the national 
phase step. 

If you were preparing an estimate close to the end of the 30-
month period after the PCT filing, for the national phase only, 
the PCT Patent – National Phase item would be used for a single 
report for this phase only. 

 Route 3 – The PCT and EPO Route Followed by National 

Applications 

Since the UK and Germany are also part of the EPO, the EPO could 
be included as part of the process. 

First, file a PCT application. Assuming that the full delay possible 
via the PCT process is taken, national applications would then be 
filed 30 months after the initial PCT application. File an EPO 
application at this time, as well as national phase estimates in Japan 
and Australia. Then, after the EPO grant (perhaps four years later), 
validate the EPO Patent in the UK and Germany. 

Two options for generating this estimate using the software are 
available: 

either 
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 1) Generate an Estimate in One Report: 

•••• Choose Patent on the ‘Global IP – Main’ screen. 

••••    Choose PCT Application on the ‘Specify Destination(s) of 
Application’ screen, and check the Add PCT National box. 

••••    Choose Japan, Australia and European Patent Office on 
the second ‘Specify Destination(s) of Application’ screen 
presented, and check the Add EPO Validation box. 

••••    Choose United Kingdom and Germany on the third 

‘Specify Destination(s) of Application’ screen. 

••••    Enter Application information on the ‘Enter Application 
Information’ screen and obtain the estimate.  

Note that the Application Information items will include items 
for Number of Designations for the EPO and Number of 

Extensions for the EPO. These values may be changed by the 
user, if desired. 

or 

 2) Generate an Estimate in Three Separate Reports: 

This method gives you an estimate for the entire process as three 
reports. The three reports reflect the fact that the three steps are 
performed long periods apart. 

•••• Choose Patent on the ‘Global IP – Main’ screen. 

••••    Choose PCT Application on the ‘Specify Destination(s) of 
Application’ screen 

••••    Enter Application information on the ‘Enter Application 
Information’ screen and obtain the estimate.  

•••• Go back to the ‘Global IP – Main’ screen using the Return 

to Beginning button and choose PCT Patent – National 

Phase.  

••••    Choose Countries: Japan, Australia, and European Patent 
Office on the ‘Specify Destination(s) of Application’ screen. 
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••••    Enter Application information on the ‘Enter Application 
Information’ screen and obtain the estimate for the National 
phase step and the EPO process. 

•••• Go back to the ‘Global IP – Main’ screen using the Return 

to Beginning button and choose EPO Patent – Validation 

Phase.  

••••    Choose Countries: United Kingdom and Germany on the 
‘Specify Destination(s) of Application’ screen. 

••••    Enter Application information on the ‘Enter Application 
Information’ screen and obtain the estimate for Validation 
phase in the European countries. 

If you were preparing an estimate close to the end of the 30-
month period after the PCT filing for the national phase only, the 
PCT Patent – National Phase item would be used for a report 
for that phase only. If you were preparing an estimate after the 
EPO grant for the European countries in the validation phase, the 
EPO Patent – Validation Phase item would be used for a report 
for the validation phase only. 

 Example Including EPO - Without the PCT 

The following example illustrates the process of generating estimates 
that involve the EPO without the PCT. Suppose a Patent is desired in 
Austria, France, the United Kingdom, and Germany. 

 Route 1 - File Applications Directly in Selected Countries 

In this example, Patent applications are filed directly in each country. 

To generate this estimate: 

•••• Choose Patent on the ‘Global IP – Main’ screen. 

••••    Choose Countries: Austria, France, United Kingdom, and 
Germany on the ‘Specify Destination(s) of Application’ screen. 

••••    Enter Application information on the ‘Enter Application 
Information’ screen and obtain the estimate. 
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 Route 2 - The EPO Route Followed by National Validation 

Since these countries are all members of the EPO, the EPO route 
could be taken. First, file an EPO application. After the EPO grant, 
validate the EPO Patent in the individual countries. 

Two options for generating this estimate using the software are 
available: 

either 

 1) Generate an Estimate in One Report: 

•••• Choose Patent on the ‘Global IP – Main’ screen. 

••••    Choose EPO Application on the ‘Specify Destination(s) of 
Application’ screen, and check the Add EPO Validation 

box. 

••••    Choose Countries: Austria, France, United Kingdom, and 
Germany on the second ‘Specify Destination(s) of 
Application’ screen presented. 

••••    Enter Application information on the ‘Enter Application 
Information’ screen and obtain the estimate. 

Note that the Application Information items will include items 
for Number of Designations for the EPO and Number of 

Extensions for the EPO. These values may be changed by the 
user, if desired. 

or 

 2) Generate an Estimate in Two Separate Reports: 

This method gives you an estimate for the entire process as two 
reports. The two reports reflect the fact that the two steps are 
performed a long period apart. 

•••• Choose Patent on the ‘Global IP – Main’ screen. 

•••• Choose EPO Application on the ‘Specify Destination(s) of 
Application’ screen. 
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••••    Enter Application information on the ‘Enter Application 
Information’ screen and obtain the estimate for the EPO 
step. 

•••• Go back to the ‘Global IP – Main’ screen using the Return 

to Beginning button and choose EPO Patent – Validation 

Phase in the main screen.  

••••    Choose Countries: Austria, France, United Kingdom, and 
Germany on the ‘Specify Destination(s) of Application’ 
screen presented. 

••••    Enter Application information on the ‘Enter Application 
Information’ screen and obtain the estimate for the 
validation phase step. 

Note: If you were preparing an estimate close to the time of the 
EPO Grant for the validation phase only, the EPO Patent – 

Validation Phase item would be used for a single report for the 
validation phase only. 

PCT Application Search and Examination Authorities 

The estimate for a PCT Application is affected by where the Search 
and Examination are to be performed. Also, the estimate for sending 
a completed PCT Application to the EPO is affected by where the 
Search and Examination were performed. For additional information 
about Search and Examination, see Chapter 2, Country Selection, 

Search and Examination for PCT and Chapter 8, Edit Menu, PCT 

Offices.  

PCT Patent - National Phase 

PCT Patent - National Phase provides an estimate for the national 
phase of the PCT process and can include EPO application and 
validation step estimates, or the EPO application step only. An 
example with three variations follows: 
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 1) Generate an Estimate: PCT Patent - National Phase - 

No EPO Included: 

•••• Choose PCT Patent - National Phase on the ‘Global IP – 
Main’ screen. 

•••• Choose Countries on the ‘Specify Destination(s) of 
Application’ screen to select individual countries for the 
PCT National Phase. 

•••• Enter Application information on the ‘Enter Application 
Information’ screen and obtain the estimate. 

 2) Generate an Estimate: PCT Patent National Phase - 

EPO Application Included: 

To include an EPO Application in the PCT Patent - National 

Phase estimate:  

•••• Choose PCT Patent - National Phase on the ‘Global IP – 
Main’ screen. 

•••• Choose Countries on the ‘Specify Destination(s) of 
Application’ screen to select individual countries for the 
PCT Patent - National Phase and check the EPO 

Application checkbox on the left side of the screen. 
Specifiying EPO removes EPO members from the list of 
available countries. Checking the Show All box redisplays 
all countries. 

•••• Enter Application information on the ‘Enter Application 
Information’ screen and obtain the estimate. 

 3) Generate an Estimate: PCT Patent National Phase - 

EPO Application Included with EPO Validation: 

•••• Choose PCT Patent - National Phase on the ‘Global IP – 
Main’ screen. 

•••• Choose Countries on the ‘Specify Destination(s) of 
Application’ screen to select individual countries for the 
PCT Patent - National Phase and check the EPO 

Application checkbox on the left side of the screen and the 
EPO Validation checkbox that appears on the right side of 
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the screen. Specifiying EPO removes EPO members from 
the list of available countries. Checking the Show All box 
redisplays all countries. 

•••• Choose Countries on the second ‘Specify Destination(s) of 
Application’ screen presented; at least one additional country 
in which to have the EPO Validation performed must be 
selected from this second screen.  

•••• Enter Application information on the ‘Enter Application 
Information’ screen and obtain the estimate. 

EPO Patent - Validation Phase 

EPO Patent - Validation Phase estimates are estimates for the 
validation phase of the EPO process and can include the EPO 
Application Grant step or Validation Phase only. An example with 
two variations follows: 

 1) Generate an Estimate: EPO Patent - Validation Phase: 

•••• Choose EPO Patent - Validation Phase on the ‘Global IP – 
Main’ screen. 

••••    Choose Countries on the ‘Specify Destination(s) of 
Application’ screen to select individual countries. 

••••    Enter Application information on the ‘Enter Application 
Information’ screen and obtain the estimate. 

 2) Generate an Estimate: EPO Patent - Validation Phase with 

EPO Grant phase included: 

To include EPO Application Grant phase in this estimate: 

•••• Choose EPO Patent - Validation Phase on the ‘Global IP – 
Main’ screen. 

••••    Choose Countries on the ‘Specify Destination(s) of 
Application’ screen to select individual countries and check 
the EPO Grant checkbox on the left side of the screen. 
Checking this box will add the grant costs to the estimate, 
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and will select the European Patent Office as a destination. 
Annuities will not be included for this EPO grant estimate. 

••••    Enter Application information on the ‘Enter Application 
Information’ screen and obtain the estimate. 

Note that the Select All button does not automatically select the 
EPO grant stage. To do this, you must click the EPO Grant 
check box or select the European Patent Office as a destination. 

 Completing the Selection 

Once destination and options selection are complete, click the 
Proceed button on the lower right of the ‘Specify Destination(s) of 
Application’ screen. The ‘Enter Application Information’ screen is 
then presented. 

Clicking the Return button cancels the estimate request and all 
information entered about that request. 
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4 Application Information 

Introduction 

Based on both the type and destinations you have entered for the 
application, various attributes of the application will be automatically 
selected and will appear in the ‘Enter Application Information’ screen, as 
shown in Figure 4-1: 

 

Figure 4-1  ‘Enter Application Information screen 

Data Requested for Application Information 

You can use the “Note to display on estimate” box at the top of the 
screen to identify the estimate being generated. The text you enter 
here will be printed at the top of the reports. It can specify 
identifying information such as a client name, file number or 
attorney name, or notes about the estimate. 

In the remaining boxes, either numeric information or Yes/No 
information is requested. 
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•••• Enter the numeric information appropriate to the application into 
the boxes on the left side of the screen. To move into a data entry 
box, either click on the box with the mouse button or navigate 
from one box to the one above or below it by using the tab key 
or the arrow keys on the keyboard.  

•••• Yes/No information is entered into the list of boxes on the right. 
You will need to either tab to a box or click in the box to 
highlight the value, then use the space bar or “Y” or “N” keys to 
change from “Yes” to “No” and vice versa. You can navigate 
from one box to the one above or below it by using the arrow 
keys or the tab key, although pressing the space bar will be 
required to change it. 

 Item Definitions for Application Information Screen 

Use the Help button to access definitions for the application 
information items that may appear for an application. Choose “Item 
Definitions” from the Help screen that appears for the list of 
definitions. 

See Appendix G for a complete list of definitions. 

 Stage Used for EPO Designation Fees 

When running an EPO estimate, a Yes/No box labeled EP 

Designation Fee in Exam Stage is one of the items displayed. “No” 
is the default and indicates that the EPO Designation Fees will 
appear in the filing stage of an estimate. To move the EPO 
Designation fees to the examination stage in the EPO estimate, click 
the box to change it to “Yes”. (Note that this option only appears for 
EPO applications.) 

Generating the Estimate 

All data entry must be completed before you request an estimate. 

Click the Proceed button to initiate calculations and proceed to the 
Report screen. From the report, if you decide you wish to make 
changes to the application information, choose the Return button to 
go back to the ‘Enter Application Information’ screen.  
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Clicking the Return button will take the program back to the country 
selection process, without generating an estimate. 

 Save Scenario 

A Save Scenario button can be found at the bottom middle of the 
screen. This option allows the user to save all the data specified up to 
this point including the application type, countries, and application 
information as a scenario for future use. For more information on 
creating and saving scenarios, see Chapter 5, Scenarios. 

Assumptions Made in Calculating Estimates 

This section discusses some assumptions made by the software in 
generating estimates. 

••••    Translation Costs are usually quoted as a fee per 100 words. 
The assumption made by the program is that a page contains 300 
words. However, this assumption can be changed by the user via 
the ‘Translation Settings’ screen on the Edit Menu. The user can 
also set the costs per word, as described in Chapter 8, Edit Menu 

– Translation Settings. 

•••• The translation cost for filing equals the number entered in Pages 
for Translation multiplied by the translation fee for 300 words, 
plus typing fees per page. 

Note: For multiple-country applications for Patents, an option is 
provided to incur the cost of translation into a language only 
once. You can also set the amount for using a copy of the 
translation. (See Chapter 8, Edit Menu, Translation Settings.) 

•••• Where applicable, the Value Added Tax is added to the 
associate and translation categories. It is not added to official, 
miscellaneous, or in-house categories. (For some countries, VAT 
is already included in the official amounts.) 

•••• With Trademark applications for non-multi-class countries, not 
all charges are incurred in the full amount for each class. Some 
charges, such as application fees, are multiplied by the number 
of classes. Others, such as the associate’s fee for filing a priority 
document, are not multiplied. Such charges, appearing in the 
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associate and miscellaneous categories, are calculated at only 
20% of the full amount for all classes after the first. 

•••• No Miscellaneous Costs are added for an initial PCT Patent 
application. The assumption is that these costs are added to the 
amount you have specified for In-House Service Charges. 

••••    Associate’s Charges have been included for all countries. If the 
user prefers, they may change the associate’s charges for any 
country. (See Chapter 8, Edit Menu, User Defined Associate 

Charges for a discussion.) 

••••  A set of In-House Charges has been provided. The user may 
opt to change all in-house charges. (See Chapter 8, Edit Menu, 

In-House Charges.) Another option provided is to exclude all in-
house amounts from an estimate for any country. (See Chapter 8, 

Edit Menu, Country Specific Settings for further information.) 

One country may be set as the Home Country. The estimates for this 
country include only Official Fees and In-House Charges controlled 
by the User. Additional information about the Home Country 
charges may be found in Chapter 8, Edit Menu, Home Country 

Charges. 
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5 Scenarios 

Introduction 

A scenario contains all the elements required to generate an estimate: the 
application type, countries, and application information. It is one way to 
“save an estimate” so that the information can be used again when 
creating future estimates. 

Scenarios can be filtered by application type, and sorted by the owner’s 
name, the name of the scenario, or the description, making it quick and 
easy to find exactly the scenario desired in multiple-user situations. 

Until at least one scenario is defined, the menu item titled Scenarios in 
the main program screen will appear gray and be unavailable. 

Creating a Scenario 

•••• To define a Scenario, you must first select an Application Type 
from the ‘Global IP – Main’ screen.  

•••• Once selected, proceed to the ‘Specify Destination(s) of 
Application’ screen and select countries for the estimate. 

•••• Once you have selected the countries and any other additional 
boxes from the options supplied, proceed to the ‘Enter 
Application Information’ screen. 

•••• Enter Application Information if the values are to be saved with 
the scenario. The values may be left unchanged if only the 

application type and countries are required to define the scenario. 

•••• The Save Scenario button appears on bottom middle of this 
screen, as shown in Figure 5-1: 
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Figure 5-1  Enter Application Information screen 

•••• Click the Save Scenario button. The ‘Save Scenario’ screen will 
appear, as shown below in Figure 5-2. 

 

Figure 5-2  Save Scenario screen 

•••• Enter the Owner’s Name (up to eight characters), a Scenario 

Name (up to 15 characters), and a brief scenario description 
(up to 100 characters). 

 

5-46 GLOBAL IP ESTIMATOR 

•••• To save the Scenario, click the Save button. If you do not wish 
to save this scenario, click the Cancel button. 

Using Saved Scenarios 

To use a saved scenario:  

•••• Click on the Scenarios button on the ‘Global IP – Main’ screen. 
Click on the Proceed button. The ‘Select a Previously Saved 
Scenario’ screen will be displayed as shown in Figure 5-3: 

 

Figure 5-3  Select a Previously Saved Scenario screen 

••••    Click the Filter by Application Type drop-down list located 
towards the top of the screen to choose either a specific 
application type (Patent, Trademark, or Design) or All Types of 
scenarios. Once a type of scenario has been chosen, a list of the 
relevant saved scenarios will appear in a list below. If you 
haven’t saved any scenarios for that type, no scenarios will be 
listed. If you have many scenarios stored, a scroll bar will appear 
on the right side of the scenario listing to allow you to view more 
of them. 
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You also have the option of sorting the scenarios by the name of the 
owner, the name of the scenario, or the scenario description. To sort 
the scenarios, click on the appropriate radio button in the Sort 

Scenarios By section at the bottom left side of the screen. 

••••    Highlight the Scenario you wish to use and click on the Proceed 
button. This will take you to the ‘Specify Destination(s) of 
Application’ screen with your scenario selections already 
showing. Click the Proceed button on this screen and on the 
‘Enter Application Information’ screen to proceed to the report 
screen to print the estimate report. 

Editing Scenarios or Creating Scenarios Based on Existing 

Scenarios 

To edit a scenario or create a scenario based on an existing scenario: 

•••• Click on the Scenarios button on the ‘Global IP – Main’ screen. 
Click on the Proceed button. The ‘Select a Previously Saved 
Scenario’ screen will be displayed. 

••••    Click the Filter by Application Type drop-down list located 
towards the top of the screen to choose either a specific 
application type (Patent, Trademark, or Design) or All Types of 
scenarios. Once a type of scenario has been chosen, a list of the 
relevant saved scenarios will appear in a list below. 

••••    Highlight the Scenario you wish to use and click on the Proceed 
button. This will take you to the ‘Specify Destination(s) of 
Application’ screen with your scenario selections already 
showing.  

•••• Make any needed changes to the ‘Specify Destination(s) of 
Application’ screen. When all changes have been made, click on 
the Proceed button.  

•••• Make any needed changes to the ‘Enter Application Information’ 
screen. When all changes have been made, you can click on the 
Save Scenario button to save your changes.  

To update this scenario with the changes you have just made, click 
the Save button. 
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•••• To save your changes as a new scenario, change the owner’s 
name, the name of the scenario, and the scenario description as 
relevant. Click the Save As New Scenario checkbox at the 
bottom left side of the screen and then click the Save button. 

Note: Do not reuse the same name as another scenario, even if you 
change the owner’s name or the description; you will overwrite the 
existing scenario. 
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6 Reports 

Introduction 

The estimate created by the program consists of three reports: the 
Condensed Summary, the Summary, and the Detail Reports, which you 
can view in turn by clicking the appropriate View button at the bottom of 
each screen. This section discusses the layout of the reports and the 
command buttons located at the bottom of the ‘Report’ screen. For 
information on editing the report settings see Chapter 8, Edit Menu, 

Report Settings. For information on how to view and print some of the 
underlying report data, see Chapter 9, Reports Menu.  

Note: Some of the fee categories listed in the reports as well as the 
comments that appear on each report can be modified by the user; see 
Chapter 8, Edit Menu for further details.  
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 Report Screen 

As shown in Figure 6-1, the top part of each screen contains the 
report itself. Various command buttons, including those to print the 
reports, are located at the bottom of each screen.  

 

Figure 6-1  Example of Report screen 

Each page will also show the date of the report and the page number. 
Below that are the estimates for each country selected. 

 To Navigate Within The Report 

The top bar of the screen shows several navigation tools available to 
the user. To view sections of the report page not visible on the 
screen, use the navigation tools at the top of the screen and the scroll 
bar on the right side of the screen. Use the scroll bar until you reach 
the end of the page. To go forward in the report click the � button; 
the �| button takes you to the end of the report. Likewise, to view 
the previous page, choose the � button; the |� button returns you to 
the beginning of a report. 

A Print Report icon is available on the top bar of the screen. When it 
is clicked, a Print box will appear giving options for the number of 
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copies and pages to be printed. To the right of the Print Report Icon 
is a drop-down list with view magnifications options. Click on the 
drop-down list and click on the desired view option. 

 Command Buttons 

Command buttons are located at the bottom of each report screen. 
Following are the functions of each button: 

Display Currency This shows the currency of the report. 
The home country currency will be 
added to the “favorite” currencies, if it is 
not already in the list. 

Edit Favorite Display You can add any world currency to the  
Currencies display currencies by clicking on the 

Edit Favorite Display Currencies 
button and double-clicking the country 
name on the next screen. You cannot 
delete your home country currency, nor 
can you delete the currency in which 
reports are currently displayed. 

View Condensed Report Clicking this radio button presents the 
Condensed Summary Report. 

View Summary Report Clicking this radio button presents the 
Summary Report. 

View Detail Report Clicking this radio button presents the 
Detail Report. 

Print Report Clicking this button prints the report that 
is currently being viewed. 

Email/Save Report Allows the option to email saved reports 
to any one email address. Saves report 
being viewed as MS Word document 
(and most other word processing 
programs). Additional information about 
the Email/Save functionality is included 
in the Saving the Reports section below. 
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Email/Save Condensed Allows the option to email saved  
to Excel reports to any one email address. Saves 

Condensed Report in Excel format. 
Additional information about the 
Email/Save functionality is included in 
the Saving the Reports section below. 

Email/Save Timeline When the TIMELINE software is  
to Excel activated, this button will replace the 

Save Condensed to Excel button. 
Allows the option to email saved reports 
to any one email address. Saves 
Timeline Reports along with the 
Condensed Report to Excel format. 
Additional information about the 
Email/Save functionality is included in 
the Saving the Reports section below. 

Return Returns to the ‘Enter Application 
Information’ screen. The current 

estimate is not kept. 

Return to Beginning Returns to the initial ‘Global IP – Main’ 
system screen. Countries selected and 

application information are not kept. 

Exit Exits the GLOBAL IP ESTIMATOR 
program entirely. 

Application Information Section  

The “Application Information” appears at the top of the Condensed 
Summary and Summary Reports and contains the attributes of the 
application that were previously entered in the ‘Enter Application 
Information’ screen (see Figure 6-1). The Detail Report does not 
include an Application Information section, but does list the numeric 
Application Information Items applicable to the report. 

Categories of Costs 

The reports include different categories of costs. They are described 
in the following table: 
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Official Official Fees in the country, as 
published by the Patent and Trademark 
Office for that jurisdiction. For some 
smaller countries, these fees may not be 
clearly identifiable. In such cases, the 
Official fees, if any, are combined with 
the Associate charges. 

Associate Foreign associate charges, including 
VAT if any. 

Translation Translation costs, if necessary.  

Miscellaneous Miscellaneous in-house costs, such as 
fax charges, calculated from numbers 
entered by the user.  

In-House In-House fees for various stages of the 
estimate, calculated from numbers 
entered by the user. 

Condensed Report 

The Condensed Report presents column totals in a single row for 
each country, with totals for all countries immediately beneath. Four 
formats are available. (The format desired can be chosen as 
described in Chapter 8, Edit Menu, Report Settings.) 

These formats are described as follows: 

 The Default Format  

This format divides the estimate into four to six columns of 
expenses, depending on the application type: The Official/Associate 
column totals the amounts of the Official and Associate’s Charges; 
the Translation column shows the totals for all translation costs; the 
In-House/Miscell. column totals the amounts of all the in-house fees 
and miscellaneous expenses; the Total column totals the cost of 
these first three columns.  

If you have selected a Patent type, two more columns will appear: 
The Annuities column totals the annuities for the number of 
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annuities years selected; and the Total Incl. Annuities column, 
which totals the costs of all the previous columns.  

 The Totals Only Format  

Shows only a Totals column. The Patent report includes Total 

Annuities. 

 The Miscell. in Associate Column Format 

Like the default format, but with the Miscell. total added to the 
Official/Associate total, leaving the In-House total in its own 
column. 

 The Associate, In-House in Attorney Column 

This format replaces the In-House/Miscell. column with a column 
labeled Attorney, which contains the Associate, Miscellaneous, and 
In-House charges, leaving the Official total in its own column. 

An example of the Default Format of the Condensed Summary 
Report is shown in Figure 6-2: 
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Figure 6-2  Condensed Summary Report screen 

Summary Report  

Figure 6-3 illustrates the layout of the Summary Report. In this 
figure, the Application Information is visible, followed by a 
summary estimate for the EPO. 
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Figure 6-3  Summary Estimate Report screen 

The columns of the estimate each represent different categories of 
costs. 

The rows of the summary contain estimates for stages of the 
application. For Patent types, an additional row contains the Total 
Annuities. 

The next row contains exchange rates used in the estimate. There 
may be more than one, e.g., for the EPO. This is followed by the 
“Country Comment” entered by the user in the Country-Specific 

Settings for that country. 

Detail Report 

The Detail Report lists each item used in the calculation of the 
estimate. Figures 6-4 and 6-5 illustrate respectively the upper and 
lower sections of this report.
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Figure 6-4 and 6-5  Upper and lower sections of Detail Report screens 

In general, the Detail report is structured to correspond to items in 
the Fee Schedules of foreign associates. The report divides the costs 
by Stages. For each stage, the Official Fees, Associate’s Charges 
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and Translation fees are shown, followed by the Miscellaneous and 
In-House Charges with a description of each cost.  

For Patents, Annuities are printed in a chart toward the end of the 
estimate. Annuities are separated into Official, Associate and In-
House amounts and totaled by year. A Total Annuities is also added 
to the body of the estimate. 

Both the exchange rates used and the Country Comments 

previously entered for the particular country appear at the end of the 
report. 

 Saving the Reports 

Any of the three GLOBAL IP ESTIMATOR reports can be saved as 
Word documents: the Condensed Report, the Summary Report, or 
the Detail Report. The saved Excel workbook contains an expanded 
version of the Condensed Report. Enter information for the estimate 
as usual – identifying the countries and application information. 
Once you proceed to the ‘Reports’ screen, you will find the buttons 
at the bottom of the screen, as shown below in Figure 6-6. 

 Saving the Report as a Microsoft Word Document  

There are two save formats available: a save to a “.doc” file and to a 
“.rtf” file, as shown below: 

 

Figure 6-6  Email/Save Report Buttons screen 

There is also the option to email the reports to any email address 
desired. The option labeled “Word” creates the “.doc” file. The 
option labeled “RTF (Exact)” creates the “.rtf” file, and the emailed 
reports are identical to the saved reports. 

The “.doc” file is an easily editable Microsoft Word document. 
However, some of the formatting of the report cannot be saved, e.g., 
the page numbering is missing, the spacing between lines is 
different, and the lines above totals are missing. 
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The “.rtf” file is an exact replica of the report. This format can be 
read and printed via Microsoft Word. However, the document uses 
text boxes, which makes extensive editing not practical. 

If the save is done in order to modify some of the wording, or to cut 
and paste portions of the report into another document, choose the 
“Word” option. If the save is done in order to save or email the 
report for review, or for printing exactly as generated, choose the 
“RTF (Exact)” option. 

 The Save Process 

To save a report as a Microsoft Word document, the report must first 
be viewed on the screen. To view a report, click the radio button next 
to the report. For example, for the Summary Report, click the View 

Summary Report radio button.  

Once you are viewing the report that you wish to save, choose the 
format (“Word” or “RTF (Exact)”), and click the EMail/Save 

Report button. A ‘Save As’ window will appear on the screen as 
shown below. Use this screen to enter the name of the document and 
set the “Save in:” folder. 

 

Figure 6-7  The Email/Save screen 

Once you have made your changes to the ‘Save As’ screen, click 
Save. The saved report will be created and saved in the folder 
specified by you. 
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 Saving the Report in Microsoft Excel Format  

For Timeline reports, two Excel spreadsheets are generated. More 
information about these reports is given below, and in Chapter 12, 

Timeline Module. 

The default folder that will be used is identified (see Default Folder 

for Saved Reports section below for instructions on setting the 
default path) and can be changed here. 

To save the Condensed Report in Excel, click the Email/Save 

Condensed to Excel button. An ‘Email/Save Excel Condesned 
Report’ window will appear on the screen. Use this screen to enter 
the name of the document and set the “Save in” folder.  

Note: If the Timeline Module has been activated, the label for the 
Excel save button will read Email/Save Timeline to Excel. Clicking 
this button will result in saving the Condensed Summary Report 
in addition to the other Timeline format spreadsheets. The name 
given to the Condensed Summary Format spreadsheet has 
“_Condensed.xls” as a suffix. 

A typical Windows “Save As” screen will appear, using the default 
folder identified as a starting point. However, the user can easily 
navigate to any folder desired. After clicking the Windows Save 
button, you will be returned to the GLOBAL IP ESTIMATOR 
‘Email/Save Excel Condensed Report’ screen, and the location the 
worksheet will be saved in will show in the Filename path. See 
Default Folder for Saved Reports section below for instructions on 
setting the default path.  

Once you click the Proceed button the saved report will be created 
and saved in the folder specified by you. 

 Saved Condensed Summary Format 

The saved Excel Condensed Summary Spreadsheet is generated with 
the format shown in Figure 6-8: 
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Figure 6-8  Condensed Summary Saved Spreadsheet screen 

The Application information is shown at the top. Then there is one 
line per country with totals for Official, Associate, Translation, 
Miscellaneous, and In-House categories. For Patents, the annuities 
are shown, both totaled and on a year-by-year basis. Note that the 
annuities are allocated to years in a manner similar to that used for 
the annuity table in the Detail Report; the Timeline Module allocates 
the annuities to the actual years when they may be expected to occur.  

Default Folder for Saved Reports 

The File Menu item in the main program screen has an item labeled 
Default Path Setup for Saved Files. Clicking this menu item results 
in the typical Windows folder navigation screen. Identify the folder 
into which you wish to place any saved reports. The report name that 
shows on this folder navigation screen is “Global IP Report”. This is 
for illustration purposes only. The actual report names will reflect 
which report is being saved. The purpose of the menu item is to 
identify the folder into which to place the reports. 
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Once the default path has been set, it can be modified by either 
returning to the File Menu Export Default Path Setup item or at 
the time the Email/Save Report button is clicked on the ‘Report’ 
screen. There you can modify the folders where the reports are 
saved. 
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7 File Menu 

Introduction 

Figure 7-1 shows the File Menu, which is used to change the printer 
settings, the default path for saved files, and the password functions for 
the Edit Menu. 

 

Figure 7-1  The File Menu screen 

Printer Setup 

This menu item runs the Windows printer setup program. You can 
use it to change printer settings. Refer to the Microsoft Windows 
system manual, or Microsoft Windows Help for assistance in 
changing the printer settings. 

Default Path for Saved File Setup 

This item is used to designate the default path for all saved reports. 
(See Chapter 6, Reports for further information.) 

Edit Menu Password Setup 

This item allows the Edit Menu to be password protected. Because 
the Edit Menu accesses items that are user-defined, access to the 
menu may need to be restricted to ensure consistent estimates when 
the system is used on a network or by multiple users on the same 
computer.  
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The system initially does not require a password to access the Edit 

Menu, and the option can be enabled/disabled at any time. The Edit 

Menu Password Setup item controls the enabling/disabling process. 
The screen presented via this menu item is shown on the next page: 

 

Figure 7-2  Edit Menu Password Setup screen 

 Enable Password 

To enable the password requirement, choose Edit Menu Password 

Setup from the File Menu drop-down list. 

This will call up a screen requesting the “Activation Password”. This 
password is made available with the software. Please contact us to 
request the password. 

When you enter the correct “Activation Password”, the screen will 
show the “Require Password to Access Edit Menu” field. Click the 
Yes button. The screen will then show the “Edit/Confirm Menu 
Password” fields. Enter a password, which should contain five to 15 
characters. Enter this password again in the “Confirm Edit Menu 
password” field for verification. Click Save. 

 Change Password 

To change the password, choose Edit Menu Password Setup from 
the File Menu drop-down list. 

This will call up a screen requesting the “Activation Password”. 
Please contact us to request the initial password. 
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When you enter the correct “Activation Password”, the screen will 
show the “Edit/Confirm Menu Password” fields. In the “Edit Menu 
Password” field select the existing password and type over it with a 
new password, which should contain five to 15 characters. Enter this 
new password again in the “Confirm Edit Menu password” field for 
verification. Click Save.  

Once you have changed the password, the system is set up to allow 
you to access the Edit Menu items without having to enter your new 
password, as long as you do not exit the software. Once you have 
exited the software you will be required to enter your new password 
to access the Edit Menu items. 

 Disable Password 

To disable the password requirement, choose Edit Menu Password 

Setup from the File Menu drop-down list. 

This will call up the screen requesting the “Activation Password”.  

When you enter the correct “Activation Password”, a second screen 
will appear. Click the No button in the “Require Password to Access 
Edit Menu” field. Click Close. 

 Email Setup 

This option allows a user to set email configuration options in order 
to automatically send reports via email from within the program. 
When the user selects this option, the following screen is shown: 
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Figure 7-3  Email Setup screen 

Starting with version Office 2007, Microsoft ceased to support the 
email library MAPI (Messaging Application Programming 
Interface). New versions (2007 and up) use an alternative library 
called CDO (Collaboration Data Objects). GLOBAL IP 
ESTIMATOR supports both methods (MAPI and CDO) depending 
on the version of Microsoft Office. The “Configure Email Options” 
screen allows user to configure any necessary settings that enable 
full email functionality throughout the program (Sending reports via 
email or emailing the registration form). 

Description of the configuration fields required when using the CDO 
method only: 

Your email address:  Email address to be used in the FROM field 
when sending reports. MAPI method will automatically get the 
settings for this from Outlook, but the CDO method will fail unless 
user specifies his email address first. 

Proxy server address/port: This field is automatically populated. 
First, the program tries the alternative method (checking IE settings) 
to determine proxy settings. If that fails, it looks for the proxy.ini file 
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in the application folder and reads it. These checks are done only if 
the proxy connection was discovered. 

SMTP server address: Outgoing mail server address. When using a 
proxy connection this will typically be the proxy address. 

SMTP username: Outgoing mail server username (needed only if 
required by the server). 

SMTP password: Outgoing mail server password (needed only if 
required by the server). 

SMTP Server Uses SSL: If this option is checked, the CDO method 
will try the SSL ports instead of the regular port when accessing the 
outgoing mail server. 

Bypass proxy for local addresses: If this is checked, the CDO 
method will append a “<local>” string to its cdoURLProxyBypass 
field in order to access a local SMTP server. 

 Restore User Database 

After reinstallation, the user database containing the user settings can 
be restored for use. After choosing this option, either enter the full 
path to the location this database was moved to, or browse to the 
location of the database and choose the Proceed button.  

 Admin Options 

In order to choose this option, the user must start GLOBAL IP 
ESTIMATOR as an administrator, which is available in Windows 7 
and Vista by right-clicking on the icon, and selecting “Run as 
Administrator” from the pop-up menu. The following screen will be 
shown: 
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Figure 7-4  Admin Options 

The choices from this screen allow the administrator to either move 
the database to a new location or connect to an alternate location. 
This should generally only be done at the direction of GLOBAL IP 
ESTIMATOR’S technical support staff.  

 Restore In-House Charges Default Values 

Choosing this option will enable the user to restore the In-House 
Charges values to the default values included with GLOBAL IP 
ESTIMATOR when it is initially delivered. 
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8 Edit Menu 

Introduction 

Figure 8-1 shows the Edit Menu. This menu accesses options for 
modifying data that can be changed by the user. 

 

Figure 8-1  The Edit Menu screen 

A brief description of each menu item follows: 

 In-House Charges 

The In-House Charges item allows you to modify the default in-
house charges that are included with the software as well as to create 
additional in-house charges sets for use by different individuals using 
the software, in various scenarios, and with different clients. The 
user can also set the currency for In-House Charges, which is the 
default currency to be used for generating reports. 

 Home Country Charges 

The Home Country Charges item allows the user to set countries as 
the Home Country. The estimates for these countries include only 
Official fees and In-House charges controlled by the user. 
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 Calculation Settings 

From this edit item you can set adjustment factors (by percentage) 
for associate’s charges, translation costs, and official charges for the 
estimate in general.  

 Report Settings 

From here, you can choose whether countries will appear throughout 
the software program by code prefix or by country name, alter the 
Condensed Summary Report format, specify the Summary Report 
headings and the Detail Report headings for the in-house charges, 
and alter the text used in the standard estimate footnote. 

 PCT Offices 

This menu item is used to specify the Receiving Office, the Search 
Authority, the International Preliminary Examination Authority, and 
the Supplemental Search Authority for a PCT Patent Application. 

 Country Specific Settings 

For each country in the database, you can set adjustment factors (by 
percentage amounts) for associate’s charges, translation costs, and 
official charges, create notes that will appear on the estimate, choose 
whether the in-house charges will be included, and specify which in-
house charges set will be used for the country. 

 Exchange Rates 

You can change currency exchange rates used in the calculations. 

 Translation Settings 

You can use this screen to define translation costs for estimates. 
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 User Defined Associate Charges 

This menu item allows the user to add or replace the system-defined 
fee rules for each individual country, giving the user nearly unlimited 
ability to set the Associate’s Charges to exact specifications (unlike 
the Calculation and Country Specific Settings, which are by 
percentage). Three methods are provided for editing the fee rules, 
each increasing in complexity: Simple, Detailed Via Pre-Defined 
Templates, and Detailed via Advanced Method. Only the Simple 
method is described in this Edit Menu section. The other two 
methods are available in a separate software module. See Chapter 

13, User Defined Associate Charges – Detailed Module for further 
information. 

 Timeline Settings 

You can change settings for the Timeline Module. Please refer to 
Chapter 12, Timeline Module, for a detailed discussion of the 
Timeline Module settings. 

 Prosecution Settings 

You can change settings that are used in generating estimates 
including the prosecution stage. Please refer to Chapter 15, 

Prosecution Module for a detailed discussion of Prosecution 
Settings. 

Each of the above menu items (with the exception of the Timeline 
Module Settings and Prosecution Settings) will now be discussed in 
detail in this Section. 

 Enable Online Updates 

This enable/disable flag allows users to run the online updates. If 
disabled, the Help/Check for Updates menu item will be grayed out, 
and users will not be able to run the monthly update. 



 

GLOBAL IP ESTIMATOR 8-73 

 Edit Menu – In-House Charges 

In-House Charges are the fees and costs associated with processing 
the foreign applications, i.e., the fees and costs of sending the 
information to the foreign associates and handling responses. For 
example, the “original” application has been sent to the Official 
agency, and the client has decided to proceed with applications in 
various foreign countries. The in-house fees would then be included 
in the estimate as part of the charges that would be incurred in 
processing the application in these foreign countries. 

The category labeled “In-House” below refers to fees, and the 
category labeled “Miscellaneous” refers to costs. 

In-House Charges are entered in “sets”. There are two sets to begin 
with, a default set – the “01” set labeled “Main” and a “ZZ” set 
labeled “All Zeroes”. The information contained in the default “01 
Main” set may be changed by the user, but the set itself may not be 
deleted. The information contained in the “ZZ All Zeroes” set cannot 
be changed, except for the Patent/Design Annuities, on which the 
“EPO Grants in Year” value may be changed. The process of 
changing and adding sets of In-House Charges will be described 
after discussing what a set contains and each type of Application 
(Trademarks, All Patents except new PCT & EPO Regional, etc.). 

The screen displayed by this menu item is shown in Figure 8-2: 
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Figure 8-2  Sets of In-House Charges screen 

First, the user should choose the currency of the In-House Charges. 
The estimates are converted into this currency. To change the “In-
House Charges In Currency Of” setting, click on the down arrow to 
the right of the drop-down box and highlight the country whose 
currency you wish to use. The default is based on the country of 
registration of the licensee. Whenever this setting is changed, a 
Global IP Message box will appear, asking the user to confirm the 
change, and when the conversions are complete, another Global IP 
Message box will appear, informing of the completion. 

All sets of In-House Charges will be converted to that currency; you 
may wish to review the sets of In-House Charges, since you may 
wish to round the values. 

Once a user has chosen a set and selected an Application Type, a 
screen is displayed showing the details of the in-house charges for 
that selection. All the sets will show, in general, the same fees and 
costs format (except Patent Annuities, where the display has a 
different format – see subsection below, Patent Annuities).  
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An example of an In-House Charges detail screen is shown in 
Figure 8-3: 

 

Figure 8-3  Sample of In-House Charges screen 

The amounts are grouped by Category (In-House and 
Miscellaneous), and by Stage (Filing, Examination, and Granting). 
Amounts are entered in the currency selected by the user for the 
estimate reports. The name of the currency in use is displayed in the 
heading above the amount column. Use the tab key or arrow keys on 
the keyboard to move between the cells containing the amounts; 
highlight the amount to change it. The scroll bar is used to display 
additional items. All data should be entered before clicking the 
Update button. 

Following is a discussion of each Application Type and the 
associated fees and costs.  

 All Patents Except New PCT, New EPO, and EPO Validation  

The screen displayed for this option is shown in Figure 8-4: 
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Figure 8-4  In-House Charges: All Patents Except new PCT, new EPO and 

EPO Validation 

Amounts in this type are included in estimates as In-House Service 

Charges for an application which is: 

•••• Made directly to a country, or 

•••• A National Phase PCT Patent. 

They are not included in estimates for: 

•••• A new PCT application,  

•••• A new EPO application, or 

•••• An EPO Validation Phase Estimate. 

The item labeled “In-House Service Charges - countries after first” 
allows for a discounted amount to be charged for the second and 
subsequent countries being processed at the same time. If no 
discount is offered, the amount should be the same as the amount 
labeled “In-House Service Charges”. If no amount is entered for 
“countries after the first”, whenever an estimate is run that includes 
more than one country, no In-House Service Charges will appear in 
the estimate. 
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If a particular country needs to be charged the amount for the “first” 
country, if that country is selected first (i.e., clicked on first) via the 
‘Specify Destination(s) of Application’ screen, that country will be 
shown with this amount, regardless of the order in which it appears 
in the estimate. Note that if a scenario is used, the first country in 
alphabetic order will be shown with this amount. 

The following Miscellaneous Filing charges affect the calculations 
as follows: 

Conforming Drawings... Multiplies Number of Pages of 
Drawings 

Photocopying Multiplies Pages in Application 
Plus Pages of Drawings 

Priority Applic. Certified Copy Multiplies Number of 
Convention Priorities 

Facsimile Charges Multiplies Pages in Application 
Plus Pages of Drawings if 
“Application Sent by Facsimile” 
is clicked “Yes” 

Postage Multiplies Pages in Application 
Plus Pages of Drawings 

Courier Included if “Courier Used” is 
clicked “Yes” 

Miscellaneous In-House Costs Always included in estimate 

The Examination In-House Service and Miscellaneous Costs are 
added to their respective categories for countries which perform an 
examination for novelty. The Grant Stage Miscellaneous Costs are 
added for all countries. 

 New PCT Application  

The screen displayed for this option is shown in Figure 8-5: 
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Figure 8-5  In-House Charges: New PCT Patent Applications screen 

Amounts in this screen are included in the In-House Service 

Charges for a PCT (International) estimate only.  

The In-House Service - New PCT Application fees are added to the 
In-House category. 

The Convert U.S. Provisional Application amount is added to the 
Filing stage of a PCT application if the appropriate box on the ‘Enter 
Application Information’ screen is checked “Yes” when running the 
estimate. (This is a check box with the label Convert U.S. 

Provisional Application.) The amount specified is an additional 
amount; the In-House Service - New PCT Application amount will 
still be included in the estimate. 

The In-House Service - PCT Exam amount is included in the 
Examination stage. 

In-House Service Charges are added to the Prosecution stage. (A 
similar line is added for the All Patents except new PCT and EPO 

Validation In-House Charges as well.) 
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Miscellaneous Costs are added to the Filing stage for a new PCT 
application. They will appear in the Miscell. Category on the 
Summary and Detail Report. 

The Formalization of Drawings for PCT (Per Page) amount is 
multiplied by the number of pages of drawings. It is added to the 
Filing stage for a PCT application if the checkbox labeled Order 

PCT Formal Drawings, displayed on the ‘Enter Application 
Information’ screen, is checked to indicate “Yes”.  

 New EPO Application 

The screen displayed for this option is shown in Figure 8-6: 

 

Figure 8-6  In-House Charges: New EPO Patent Applications screen 

Amounts in this screen are included in the In-House Service 

Charges for a new EPO (European Patent Office) estimate only.  

The Filing EPO Application Service Charges are fees added to the 
Filing stage, as are the charges for Claiming Priority, Claims over 
15, Fee for each State Designation, Fee for each Extension, Pay 
Search Fee, and Miscellaneous In-House Costs. 
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The Fee for each State Designation will be multiplied by the 
number of state designations identified in the Application 

Information numeric items (“Number of Designations for EPO”). 
The Designation Fees will appear in the Examination stage if the 
“EP Designation Fee in Exam Stage” Application Information 
item is checked “yes”. 

The Service Charge re EPO Exam will appear in the Examination 
stage; the fee for Prepare Response(s) will appear in the 
Prosecution stage; and the Complete Grant Procedure will appear 
in the Granting stage. 

 EPO Patent Application Validation Phase 

The screen displayed for this option is shown below: 

 

Figure 8-7  In-House Charges: EPO Regional Patent Application 

(Validation Phase) screen 

The amounts on this screen are included in the In-House Service 

Charges in estimates for the EPO Regional phase (which may also 
be called the Validation phase), after the EPO Grant.  
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 Patent/Design Annuities 

The screen displayed for this option is shown in Figure 8-8: 

 

Figure 8-8  In-House Charges: Patent/Design Annuities screen 

Amounts in this screen are included in Patent and Design Estimates 
in the Total Annuities on the Summary Report and on a separate 
row within the Annuities section of the Detail Report. 

The first row of boxes, labeled 1-10, is for the in-house charges that 
are incurred in handling the first 10 annuity payments. Similarly, the 
row labeled 11-20 contains the charges for the 11th to the 20th 
payments. The amounts for any of the charges may differ from each 
other. 

The “EPO Grants in Year” applies to EPO and EPO Regional 
Application Estimates. For an EPO Application estimate it will be 
used to calculate an Annuity Total including years up to and 

including the year entered in the box. For an EPO Regional phase 
application estimate, the annuity totals for each country are 
calculated from the year after the year entered in that box. 

Make all changes before clicking the Update button. 
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 Trademarks 

The screen displayed for this option is shown in Figure 8-9: 

 

Figure 8-9  In-House Charges: Trademarks screen 

For Trademarks, In-House Service Charges can be specified for each 
stage. An amount is specified for the first class (in the “In-House 
Service Charges” field), with the ability to specify additional service 
charges for each class after the first. The additional service charges 
are specified separately for multi-class and non-multi-class countries 
(in the “Service Per Addn’l Class -…” fields). The non-multi-class 
countries require a separate application for each class, and therefore 
an additional charge is often applied. Additional charges may be 
specified for processing a Madrid Protocol application (in the 
“Additional Service Charge re Madrid Protocol T/M” field), and a 
European Community application (in the “Additional Service Charge 
re E.C. T/M” field). 

Also, for Madrid Protocol Trademark applications, in both the Filing 
and Renewal stages, there is a “Charge Per Class Over 3” and a 
“Charge per Designation”. These charges are set to zero, and should 
be updated to reflect your practice. 
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The following Miscellaneous Filing charges affect the calculations 
as follows: 

Priority Application Certified Multiplies Number of Convention  
Copy (Per Copy) Priorities 

Courier Included if “Courier Used” 
clicked “Yes” 

Miscellaneous In-House Costs Always included in estimate 

 In-House Charges for the Madrid Protocol Trademark 

There are several In-House Charge amounts that may be 
specified, as follows: 

•••• Additional Service Charge re Madrid Protocol T/M: This 
is the additional amount you charge for processing the 
application (in addition to the usual In-House Service 
Charges for Trademarks). 

For both the filing and renewal stages, the following In-House 
Charges may also be specified: 

•••• Charge per Class Over 3: This amount multiplies the 
number of classes over 3. 

•••• Charge per Designation: This amount multiplies the total 
number of countries designated. 

Note that there are no Associate fees in the estimate. The program 
assumes that the Madrid Protocol application is handled by the user 
of the software. 

 Designs 

The screen displayed for this option is shown in Figure 8-10: 
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Figure 8-10  In-House Charges: Designs screen 

Both the In-House Filing Service Charges as well as the 
Miscellaneous Charges for Design Estimates can be edited from 
this screen.  

The following Miscellaneous Filing charges affect the calculations 
as follows: 

Priority Applic. Certified Copy Multiplies Number of 
Convention Priorities 

Courier Included if “Courier Used” 
clicked “Yes” 

Miscellaneous In-House Costs Always included in estimate 

 Assignment and Modification 

The GLOBAL IP ESTIMATOR allows the user to set Assignment as 
well as Name and Address modification in-house charges for 
Patents, Trademarks, and Designs. To change the Assignment and/or 
modification charges, the Assignment Module, a separate software 
module, must be purchased and activated. Please refer to Chapter 14, 
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Assignment/Modification Module for additional information on these 
capabilities.  

Changing, Adding, and Deleting Sets of In-House Charges 

GLOBAL IP ESTIMATOR allows you to modify existing sets of In-
House Charges as well as create additional sets of In-House Charges 
for use in various scenarios, with different clients or for use by 
different individuals.  

The “01 Main” set can be edited but not deleted. The “ZZ All 
Zeroes” set cannot be deleted, and with the exception of changing 
the “EPO Grants in Year” value on the Patent/Design Annuities 
screen, cannot be edited. Each new set of In-House Charges will be 

based on the default set at the time of creating the new set. 

 Changing an Existing In-House Charges Set 

To modify any existing In-House set:  

•••• Go to the Edit Menu and select the In-House Charges item from 
the drop-down list. 

•••• The ‘Sets of In-House Charges’ screen will appear. Click on the 

set you wish to modify and then select the Application Type. 
Click Proceed. 

•••• Make the changes to the fees and costs fields. When you have 
completed your changes, click Update. This will take you back 
to the ‘Sets of In-House Charges’ screen. From here you can 
either continue choosing different Application Types to be 
modified for that set, choose other sets to be modified or click 
Return to be taken back to the ‘Global IP – Main’ screen. 

 Creating an Additional In-House Charges Set 

To create a new In-House Charge set:  

•••• Go to the Edit Menu and select the In-House Charges item from 
the drop-down list. 
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• The ‘Sets of In-House Charges’ screen will appear. Click the 
Add Set button. (Note: The program will use the default set as its 
starting point when creating an additional set of charges.) 

•••• A “Global IP In-House Code” box will appear into which you 
enter the code number (two characters, either alphabetic or 
numeric) and a brief description (50 characters). After entering 
this information, click the Save button.  

•••• The new set will be added to the “Sets of In-House Charges” list 
of sets. Click the Close button to close the box and return to the 
‘Sets of In-House Charges’ screen. From this screen, you can 
choose the new set you just created and modify it following the 
Changing an Existing In-House Charges Set instructions as 
described above. 

There is no limit to the number of sets of charges you can create. 

 Setting the Default In-House Charges Set 

You can specify any one of your In-House sets as the default set.  

To change the default set:  

•••• Go to the Edit Menu and select the “In-House Charges” item 
from the drop-down list. 

•••• The ‘Sets of In-House Charges’ screen will appear. Click the 
Charges Set in the list that you want to set as the default to 
highlight it. Click the Set Default button. The “Default In-House 
Code: XX” above the sets of charges list will change to the new 
default set. You can either proceed with In-House Charges 
modifications or click Return to go back to the ‘Global IP – 
Main’ screen. 

 Copying In-House Charges Set 

To copy an In-House Charges set: 

•••• Make the set the Default Set, as described above in the Setting 

the Default In-House Charges Set section. 

•••• Create the new set, as described above in the Creating an 

Additional In-House Charge Set. 
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•••• Change the Default Set back to the setting used before 
beginning this process. 

 Changing the Name of an In-House Charges Set 

You can change the name of any set. 

To change the name of a set:  

•••• Go to the Edit Menu and select the “In-House Charges” item 
from the drop-down list. 

•••• The ‘Sets of In-House Charges’ screen will appear. Click the 
name of the set in the list you wish to change. Click the Add Set 
button.  

•••• The ‘Add In-House Code’ screen will appear. Change the name 
in the “Description” field and click the Save button. 

•••• A dialog box will appear that says, “This In-House Code exists. 
The Description has been updated.” Click the OK button. 

 Deleting an In-House Charges Set 

You can delete any of your In-House sets, except the “01 Main” set.  

To delete a set: 

•••• Go to the Edit Menu and select the “In-House Charges” item 
from the drop-down list. 

•••• The ‘Sets of In-House Charges’ screen will appear. Click the 
Delete Set button. A Global IP Message box will appear asking 
“Are you sure you want to delete the set?” If yes, click the Yes 
button.  

If you are deleting the Default set, you will next see a message that 
says, “You have deleted your In-house default code – the default 
code has been set to 01.” Click OK button. 

Note: The program checks to see if the In-House set has been 
specified for one or more countries in the “Country Specific 
Settings” and will not delete the set if that is the case. 
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 Edit Menu – Home Country Charges 

Any number of countries may be set as the Home Country. The 
estimates for these countries include only Official fees and In-House 
charges controlled by the user. 

The Edit Menu item “Home Country Charges” displays the 
following screen: 

 

Figure 8-11  Home Country Charges screen 

There is no Home Country initially selected. To specify a Home 
Country, double-click a country name from the left-hand list at the 
top of the screen. To remove a country from the Home Country list, 
double-click the name of the country on the right-hand list. A 
confirmation screen will appear, and once the user chooses Yes or 
No, the action will take place.  

Once a home country is selected, the user can specify additional in-
house charges for use specific to that country. After selecting a 
country (or countries) as a home country, a “Proceed” button will 
appear at the bottom of the “Home Country Charges” screen. 
Selecting the application type radio button and then selecting the 
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“Proceed” button will take the user to a Home Country Charges 
screen identical to those illustrated in the Edit Menu – In-House 
Charges section. These charges will only be applied if the home 
country is selected from the “Specify Destination(s) of Application” 
screen. 

Because there are generally no translation costs for the Home 
Country, GLOBAL IP ESTIMATOR will set the Translation Cost 
for the Home Country language to .001 per page, which will create 
translation values of nearly zero, and which will be ignored by the 
program. (See Edit Menu – Translation Settings later in this section 
for additional information.) 

If the user has User Fee Rules specified for a country via “User 
Defined Associate Charges – Simple”, that country cannot be the 
Home Country. The User Fee Rule amounts need to be zeroed out 
first for the country to be selectable as Home Country. 

For a country set as the Home Country, in the case of a PCT National 
Phase application to the Home Country, the In-House fees will be 
calculated with the “general” In-House code used for the estimate. 
This means the default In-House code settings are used, or the 
settings for the In-House code specified in the ‘Specify 

Destination(s) of Application’ screen when running the estimate. 

The reasoning for this is as follows: 

For most “In-House codes” there is the ability to specify an In-House 
amount for the “first application” and a different amount for 
subsequent applications. These amounts are used for both Direct 
applications as well as PCT National Phase applications. 

For the Home Country In-House code (“HC”), there is only the 
ability to specify an amount for the “Original Application”. “Original 
Application” means the application which takes considerably more 
work than filing foreign applications. This is the application where 
the specification is first drafted, where the claims are first written, 
etc. This can cost from $5,000 to $15,000, or more, depending on the 
work involved. To use this amount for a PCT National Application 
to this Home Country would not make sense. For PCT National the 
application has already been drafted; it makes more sense to use the 
amount for a PCT National Phase application to any country. Being 
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the Home Country, a different amount may be desired. (However, 
this additional provision has not been made.) 

The File Patents to the EPO Directly checkbox is available for use 
by EPO attorneys, who wish to file applications directly to the 
European Patent Office. Checking this option will affect numeric 
values and calculations as follows: 

•••• No “associate” charges will be included for the EPO application, 
and 

•••• For an EPO Validation phase estimate, no charge for 
“Forwarding by EP Associate” will be included. 

By default, a forwarding charge is included in each EPO Validation 
estimate, for forwarding the application to each country. The user is 
able to control whether to include this charge, and to control the 
amount of the charge. The user can choose to include the system 
default charges by checking the “Include charge” box, or specify an 
amount to be used instead by entering an amount, which will be used 
for every country with a charge for forwarding by an EP associate. 

The system default charge will be included by leaving the “Include 
charge” checkbox checked, as well as leaving the Amount box at 
“0”. These charges can be excluded by unchecking the “Include 
charge” checkbox. 

The program will include a user-set amount by leaving the “Include 
Charge” checkbox checked, and entering an amount in the “Amount” 
box. This charge is in the currency specified on the In-House 

Charges screen, and if the In-House Charges currency is changed, 
the forwarding charge currency is also changed. 

The charges for each Application Type are set by selecting the 
appropriate application type button, and clicking the Proceed button. 

The charges are very similar to the In-House charges entered via the 
“In-House Charges” Edit Menu item, and will not be described here. 

In fact, these charges are given the In-House code of HC for all 
countries chosen as Home Countries. This can be confirmed by 
viewing the countries in the “Country Specific Settings” Edit Menu 

item.  
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 Edit Menu – Calculation Settings 

In this screen you can set the adjustment factors (by percentage or a 
fixed amount) for associate’s charges, translation costs, and official 
charges for the estimate in general. (Adjustment factors for 
individual countries can be edited in the ‘Country Specific Settings’ 
screen – see instructions in this Chapter, Country Specific Settings.) 

The screen presented by this menu item is shown below: 

 

Figure 8-12  Calculation Settings screen 

You can tab from one field to the next, or click the mouse button 
directly into the box you wish to update. 

A detailed description of each field follows: 

 Adjustment Factors 

You can enter separate adjustment factors by percentage amounts, or 
a fixed amount, which apply to all countries that do not have 
adjustments entered in the Country Specific Settings. The adjustment 
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factors are for the Associate’s Charges, Translation Costs, and/or 
Official Charges categories.  

Lines are created in the Detail Report with the adjustments 
calculated for each category for each stage. These amounts then 
affect the totals and the Summary Reports. 

Note: The percentage entered does not affect the Patent annuity 
stage of the estimate. 

To enter or change the “Adjustment Factors”, click or tab into the 
appropriate adjustment box and enter or replace data. First select the 
Category. You can change the Description or leave it as 
“Adjustment”. Whatever text is entered here appears as an additional 
line in the Detail Estimate Report. 

For all fees in the selected range (choose the lower value (OVER this 
amount) and upper value (up to and including this amount), add a 
fixed amount and/or a percentage amount. For example, for all fees 
in the range of 0 to $1000, add a fixed amount of $100 and a 
percentage increase of 10%.  

By checking the next box, you can add a second range. The lower 
range will be defaulted to the first upper range, and you may add a 
new upper range. Unchecking the box will remove that range. 

Click Update after each Category changed/adjusted. A message will 
be displayed with the date and time of the change. 

To cancel a previously entered percentage, replace it with the 
number “0”. Click the Update button. 

Choosing Return will return you to the ‘Global IP – Main’ screen. 
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 Edit Menu – Report Settings  

From here, you can choose whether countries will appear throughout 
the software program by code prefix or by country name, alter the 
Condensed Summary Report format, specify the Summary Report 
headings and the Detail Report text headings for the In-House 
Charges, and alter the text used in the standard estimate footnote. 

The screen presented by this menu item is shown below: 

 

Figure 8-13  Report Settings screen 

You can tab from one field to the next, or click the mouse button 
directly into the box you wish to update. 

A description of each field follows. 

 Country Code Prefix 

If you wish to list the countries throughout the program by the 
standard two-letter country code, click the Country Code Use: Prefix 

Country Name with Country Code? box. Click the Update button. 
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All countries listed, including on reports, will now be alphabetized 
by country code, accompanied by the country name.  

 Bypass Word 2.0 Document Conversion 

GLOBAL IP ESTIMATOR Word reports are in a format that 
requires a conversion to be compatible with newer versions of 
Microsoft Office. This conversion happens automatically without 
user interaction. Check this box only should user experience any 
technical  issues when saving an estimate in a Word format. 

 Condensed Summary Format 

You must choose one of the four formats listed. These four formats 
are described in detail in Chapter 6, Reports.  

 Text Used in Reports for In-House 

You can change the report headings and text for two categories of in-
house costs: the In-House Charges and the Miscellaneous In-

House Costs.  

In the Condensed Summary and Summary Reports, the report 
headings defaults, In-House and Miscell., can be changed to 
accommodate new headings for each. To change these headings, 
click into the appropriate box, highlight the existing text, and enter 
new text to a maximum of 11 characters.  

In the Detail Report text, the text for the In-House Categories 
defaults to In-House Charges and Miscellaneous, respectively. To 
change this text, click into the appropriate box, highlight the existing 
text and enter new text to a maximum of 20 characters.  

To reset the “Summary Report Heading” and “Detail Report Text” to 
the default values, click the Reset Defaults button in the center 
bottom of the screen.  
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 Disclaimer Footnote to Appear on Estimate 

The default disclaimer footnote appears at the bottom of every page 
of the Condensed Summary, Summary, and Detail Reports. You can 
alter this text from the default text, to a maximum of four lines of 
text. 

This disclaimer is used only if you have no Prosecution Module 
installed or choose to exclude the Prosecution stage costs from the 
estimate. If you exclude the Prosecution costs, please use the 
disclaimer found on the “Edit Menu => Prosecution Settings” 

screen. 

To reset the “Disclaimer Footnote” text back to the default 
disclaimer footnote, click the Reset Defaults button in the center 
bottom of the screen. 

Choosing Return will return you to the ‘Global IP – Main’ screen.  
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 Edit Menu – PCT Offices 

This menu item is used to specify the Receiving Office, the Search 
Authority and International Preliminary Examination Authority for a 
PCT Patent Application. 

The following screen is displayed. 

 

Figure 8-14  PCT Offices Selection Screen 

The current settings are displayed at the top.  

To change the settings, first select a Receiving Office from the 
dropdown list in the middle of the screen. Based on the Receiving 
Office selected, the Search Authority and Exam Authority list boxes 
will display the relevant offices. In many cases there will be only one 
office displayed. Clicking the arrow to the right of a list box displays 
the other choices available (if any). 

After selecting offices, click the Update button, or click the Return 

button to return without changing the office settings. 

If this screen was displayed via the ‘Specify Destination(s) of 

Application’ screen when running an estimate, a check box labeled 
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“Set as Default” will be shown. Check this box if the selection is to 
be the new default settings. (See Chapter 2, Country Selection.) 
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 Edit Menu – Country Specific Settings 

For each country in the database, you can set adjustment factors (by 
percentage amounts) for associate’s charges, translation costs, and 
official charges, create notes that will appear on the estimate, choose 
whether the in-house amounts will be included, and specify which 
In-House Charges Set is to be used for the country. You can also set 
the default number of prosecution actions per country. 

The screen presented by this menu item is shown below: 

 

Figure 8-15  Country Specific Settings screen 

Click on the country you wish to edit to highlight it. 

For all the settings discussed below, be sure to click the Update 
button after each country before moving on to the next; the program 
will respond with a note that the information for each specific 
country has been updated. 

You can tab from one field to the next or click the mouse button 
directly into the box you wish to update. 
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Choosing Return will return you to the ‘Global IP – Main’ screen 
without saving your changes. 

Once you have chosen the country you wish to edit: 

 Comments to Print on Estimate  

You can enter or change a comment by clicking into the “Comments 
to Print on Estimate” box. This comment will then appear on both 
the Summary and Detail Estimates just below the estimate itself. 

 Include In-House Amounts 

You can direct the In-House costs to be included in the estimate for 
the country by clicking the Include In-House Amounts checkbox. 
This box is checked by default. If you do not wish for In-House 
Amounts to be included in the reports, you must uncheck the box.  

An example of not including In-House Amounts would probably 
arise when you are doing an estimate for your home country. In this 
case, you would probably also click the Allocate Associate amounts 

to the In-House category instead of to the Associate category box. 
In essence, the software would then represent the Associate’s fees in 
the In-House column, and thus eliminate the Associate’s fees. (To 
change the Associate’s fees from the system-defined fees to fees you 
enter yourself, see Chapter 8, Edit Menu, User Defined Associate 

Charges.) 

 In-House Code 

You may also select the In-House Code set to use for the country, in 
case the set of In-House Codes you want to use for the country is 
different from the default set of In-House Codes. By leaving this 
field blank, the default set of In-House Codes will be used for the 
country. 

 Allocate Associate Amounts to the In-House Category 

As described briefly above, by checking this box the program 
allocates the Associate’s costs to the In-House costs category. If the 
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Include In-House Amounts box is left unchecked, both the values 
from the In-House set and the Associate’s charges will appear as In-
House Charges. 

 Primary Country For Translation 

This setting allows the user to select which country’s charges will be 
used for translation if the Translation Re-Use box is checked on the 
“Translation Settings” page. GLOBAL IP ESTIMATOR’S default 
setting is to use the country with the lowest translation charge.  

 Adjustment Factors 

The adjustment factors are expressed as percentages. You can enter 
separate adjustment factors for the categories Associate’s Charges, 

Translation Costs, and/or Official Charges.  

Lines are created in the Detail Report with the adjustments 
calculated for each category for each stage. These amounts then 
affect the totals and the Summary Reports. 

Note: The percentage entered does not affect the Patent annuity stage 
of the estimate. 

To enter or change the “Adjustment Factors”, click or tab into the 
appropriate adjustment box and enter or replace data.  

To cancel a previously entered percentage, replace it with the 
number “0”. 

If you enter a percentage factor, there must also be an entry in the 
“Text to Use on Estimate to Describe this Amount” field or the 
program will issue an error message. In order to prevent this error 
message from appearing, the text “Adjustment” is already entered as 
a default setting. Whatever text is entered here appears as an 
additional line in the Detail Estimate Report.  
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 Edit Menu – Exchange Rates 

This screen allows you to change currency exchange rates used in the 
program. Currency rates are entered as the number of currency units 
per $US expressed in decimal form. 

The screen displayed by this menu item is shown in Figure 8-16: 

 

 

Figure 8-16  Exchange Rates screen  

Click in the “Exchange Rate” column for the country you wish to 
change and enter the new rate. 

Use the tab key or arrow keys on the keyboard to move from one 
field to the next, or click the mouse button directly into the box you 
wish to update. 

Some countries do not need an exchange rate entered because costs 
are already presented in $US. (Fee schedules from those countries 
are received in $US.) In this case, the country is not listed on the 
‘Exchange Rates’ screen. 

Updates to exchange rates are included as part of the monthly 
maintenance package provided by Quantify IP. You will not 

 

8-102 GLOBAL IP ESTIMATOR 

generally need to change the exchange rates. Exchange rates entered 
via this menu item are overwritten by the monthly update. 

Choosing Return – before clicking the Update button – will return 
you to the ‘Global IP – Main’ screen without saving your changes. 

If the program detects an active internet connection, and detects that 
the user has the computer rights to be able to change the data file, 
then two new buttons are displayed on the ‘Exchange Rates’ screen: 

•••• Auto Update: This button retrieves the latest exchange rates and 
updates the data with these rates. 

•••• Reset Defaults: This button resets the exchange rates to those 
sent out with the monthly data. 
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 Edit Menu – Translation Settings 

This screen is used to edit translation costs. These changes affect all 
estimates generated, and are not specific to any country. There are a 
number of settings that can be modified: You can change the number 
of words per page; select calculations based on total pages or on total 
words, specify that the translation done for one country be used for 
an application in another country and specify additional amounts to 
add to the estimate for re-using the translation; and lastly, change the 
per-page translation cost for any language. 

The screen presented by this menu item is shown below: 

 

Figure 8-17  Translation Settings screen 

You can click the mouse button directly into the box you wish to 
update, or tab between items. 

Once you have opened the ‘Translation Settings’ screen, set the 
following options to your specifications: 
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 Number of Words per Page 

You can change this setting by clicking into the box labeled 
“Number of words per page”, and entering the desired number. The 
default setting assumes 300 words per page. For example, if you 
enter 250 words per page, the translation costs used by GLOBAL IP 
ESTIMATOR will be automatically multiplied by a factor of .83333 
(i.e., 250 divided by 300).  

If the number of words per page is different from 300, an entry will 
appear in the Application Information section at the top of each 
estimate indicating the number of words per page being used. 

If you specify the translation cost per page into a particular language 
by using the Set Translation Costs into Individual Languages 
button, the cost entered there continues to assume 300 words per 
page. If you have also entered a number of words per page different 
from 300, then the translation cost per page will be adjusted 
accordingly, as described above. (See Set Translation Costs into 

Individual Languages section below for further discussion on this 
setting option.) 

The program assumes the application is in English. 

 Calculate Based on Total Pages 

This is the default method of calculation for GLOBAL IP 
ESTIMATOR. Application Information item questions are asked, 
and calculations are based on the number of pages.  

 Calculate Based on Total Words 

If this option is chosen, then GLOBAL IP ESTIMATOR will ask the 
Application Information item questions based on the number of 
words, and the resulting calculations will reflect these values. 

 Translation Re-Use 

The option to re-use translations can be turned on or off by checking 
the Re-use translation done for one country for another country? 
This option affects only Patent Estimates (in the Filing stage). 
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If checked, which means yes, the translation cost used in the estimate 
is that of the selected country with the lowest translation cost. The 
user has the option of setting a specific country as the primary 
country for translation. (See Edit Menu - Country Specific Settings 
earlier in this section for more information.) 

You then enter the amount for re-using the translation either as a 
fixed amount or as a percentage, or both. To enter a fixed amount 
enter the amount in the “Fixed amount to add to estimate for re-using 
translation ($ US)” field. You can specify that a percentage of the 
original translation amount be used in addition to the fixed amount. 
Enter the percentage in the “Percentage of original translation cost to 
add to estimate for re-using translation” field.  

The Detail Report for each country where a translation is re-used will 
show the calculated amount as a separate line. The description in the 
detail line indicates which country’s cost has been used. If the user 
has a Home Country setting which does not accept applications in 
English, the Condensed Summary and Summary reports will have a 
line of text reading “Application in English or already translated into 
English.” 

In certain countries, it is possible to submit an application in one of 
several languages. In Switzerland, for example, the application, and 
therefore the translation, may be in French, German, or Italian. This 
possibility is included in the re-use logic. 

 Set Translation Costs into Individual Languages 

Clicking the button labeled Set Translation Costs into Individual 

Languages brings up the screen shown below: 
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Figure 8-18  Set Translation Costs into Individual Languages screen 

A list of the languages available in the system appears on the left of 
the screen. The scroll bar on the right of the screen can be used to 
display languages not visible. To enter a translation cost into a 
particular language, click or tab into the field next to the name of the 
language, and enter the per-page cost in $US. Costs may be entered 
for any number of languages. 

The assumption is that the cost given is for a page containing 300 
words. 

In the box to the right of the cost, enter the text description to appear 
in the Detail Estimate Report, e.g., the name of the translator. 

If no value is given for a language, the estimate will calculate the 
translation cost into that language in the usual system-defined default 
manner. A previously entered amount may be reset to zero, in which 
case the program reverts to the system-supplied translation cost.  

When all new data has been entered, click the Update button. 
Clicking the Return button will return you to the ‘Translation 
Settings’ screen without saving your changes. 
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 Edit Menu – User Defined Associate Charges 

Fee rules define the parameters used by GLOBAL IP ESTIMATOR 
to generate estimates for each individual country. GLOBAL IP 
ESTIMATOR uses Fee Schedules from Associates to determine the 
default fee rules. Some fee rules reflect fixed amounts, and some 
depend on the attributes of the application, such as the number of 
pages in the application or number of claims. 

This menu item allows the user to add to or replace the system-
defined fee rules, giving the user nearly unlimited ability to set the 
Associate’s Charges to exact specifications. 

Three methods are provided for editing the Fee Rules, each 
increasing in complexity: Simple, Detailed via Pre-Defined 
Templates, and Detailed via Advanced Process. All three methods 
may be used for any country. All rules specified will apply. 

The Annuity Service fee rule capability is also provided from this 
menu option. 

Note: While all three methods will be briefly described below, only 
the Simple method is described further in this section. Both Detailed 
methods require the purchase of a separate software module, the 
User-Set Fee Rules Module, and instructions for them can be found 
in Chapter13, User Defined Associate Charges – Detailed Module. 

• Simple Method 

Allows the user to enter amounts for basic charges. The user 
does not need to understand how fee rules are customized to use 
the Simple method. 

• Detailed via Pre-Defined Templates 

Greater detail may be specified. The user needs to understand 
something about how fee rules are constructed, but templates are 
provided which simplify the process. 

• Detailed via Advanced Method 

Any number of fee rules may be specified, with full access to the 
elements that comprise each fee rule. The user needs to 
understand exactly what a fee rule is, and how to construct one.  
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• Annuity Service 

This menu item is provided to aid the user in specifying 
Associate Charges for patent and design annuities that apply to 
all countries. This may be useful if, for example, an annuity 
service is used that charges a given amount for paying the 
annuity regardless of country.  

 Simple Method – General Description 

Once the user has chosen the Simple option from the User Defined 

Associate Charges under the Edit Menu, a screen titled ‘User 
Defined Associate Charges – Simple’ will appear, as shown below: 

 

Figure 8-19  User Defined Associate Charges – Simple screen 

The list of countries on the left is used to select the country for which 
user-defined associate charges are to be specified. The option buttons 
to the top right are used for settings that apply to all rules for the 
given country. The associate charges are specified in the spreadsheet 
grid to the bottom right of the screen.  

Choose the country whose associate charges you wish to modify. 
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Once you have chosen the country, review the option buttons on the 
top right of the screen and change their settings as required. 
Additional information about these options is presented below. 

Make your changes to the associate charges in the spreadsheet grid.  

Annuity associate charges are specified separately by clicking the 
Edit Annuities button at the bottom of the screen. (See Edit 

Annuities Associate Charges – Simple Method later in this section.)  

When your changes are completed, click the Update button at the 
bottom right corner of the screen.  

 Option Buttons 

Once you have chosen the country whose associate charges you wish 
to modify, review the option buttons at the top of the screen. The 
options chosen will apply to all the associate charges defined for this 
country. These buttons are now described in detail: 

 Fee Rules Activated 

When the screen is initially presented for the country, this 
checkbox is checked. This means that once the Update button 
has been clicked, the associate charges entered will be processed 
and used when generating an estimate. If you later wish to revert 
to the system-defined associate charges for the country, uncheck 

this box. You will not need to delete the rules if you wish to 
switch between the user-defined associate charges and the 
system-defined associate charges. 

 How to use these Fee Rules? 

This box delineates, if you have checked the Fee Rules 

Activated box, how your new fee rules will be applied. You can 
check either Use these Fee Rules Exclusively if you want your 
new user-defined associate charges to be used exclusively in 
place of the default system associate charges, or check Add To 

System Fee Rules if you prefer your new associate charges to be 
in used in addition to the default associate charges. 
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 Keep In-House/Allocation Options  

Keep In-House Charges 

You can direct the In-House costs to be included in the 
estimate for the country by clicking the Keep In-House 

Charges checkbox. This box is checked by default. If you 
do not want In-House Charges to be included in the reports, 
you must uncheck the box.  

An example of not including In-House Charges would 
probably arise when you are doing an estimate for your 
home country. In this case, you would probably also click 
the Allocate the charges to the In-House category instead 

of to the Associate category box. In essence, the software 
would then represent the Associate’s fees in the In-House 
column, and thus eliminate the Associate’s fees. 

Allocate these charges to the In-House category instead of to the 

Associate category 

As described briefly above, if you click the Allocate these 

charges to the In-House category instead of to the 
Associate category option, the program changes the 
category associated with all Associate’s amounts for this 
country (including the user-defined associate charges being 
entered in this screen) from the Associate category to the In-

House category. If the Keep In-House Charges box is left 
checked, both the values from the In-House set and the 
Associate’s charges will appear as In-House Charges. 

These Keep In-House/Allocation options are identical to the 
similarly labeled options that can be set via the Country-

Specific Settings Edit Menu item. Note: Changing the 
settings for these options in this ‘User Defined Associate 
Charges’ screen, is the same as changing the settings in the 
‘Country-Specific Settings’ screen with the exception that 
they are used from here only if non-zero fee rules are 
entered. 
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 Calculation Amounts are in Currency of Drop Down Field  

The currency to use in relation to the associate charges you are 
entering is selected via this drop-down list box. This entry may 
initially either default to the currency of the country being 
processed or be set to $US. 

 Fee Rules Spreadsheet 

Once the country and option buttons have been set, the Associate 
Charges for that country may be modified. The columns in the fee-
rules spreadsheet are interpreted as follows: 

Type: This refers to the Application type, which are: Direct 

Patent – an application directly to the country; PCT Patent – 

National Phase of a PCT Patent; EPO Patent – Validation Phase 
of an EPO Patent; Trademark; and Design. 

Stage: The stage that corresponds to the line item. If the rule 
results in a non-zero amount, the line will appear on the Detail 
report in this stage. The stage indicated cannot be changed.  

Text: The text that will appear on the Detail Report for this rule 
can be modified here. 

Amount: This column indicates a specific amount to include in 
the Total on the Condensed and Summary Report and on a 
separate line on the Detail report. If the Mult column is blank 
(has no “*”), then the amount specified is a fixed amount which 
will be used in the estimate. If the Mult column has an “*”, then 
the amount specified will be multiplied by the value given when 
running the estimate for the Application Information described in 
the Text column. 

Mult: If an “*” is shown here then the amount is a multiplicative 
amount (see Amount above). 

Access any field you wish by clicking within the field. You can also 
navigate from cell to cell using the arrow keys on your keyboard. 
The tab key does not navigate between these cells. 

To delete an Associate Charges item, zero out the amounts in the line 
to be deleted. 
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Note that the following Prosecution Cost entries are handled slightly 
differently than usual: 

Response Preparation Fee – This amount is multiplied by both 
the “Number of Prosecution Actions” in the country and the 
“Prosecution Cost Multiplier” entered when running an estimate. 

Response Processing Fee – This amount is multiplied by the 
“Number of Prosecution Actions” in the country. 

 Completing the Process 

When all the changes are made, click the Update button. A 
message box indicates that the changes have been made and 
offers the option to proceed to the ‘Edit Annuities’ screen for the 
country. The ‘Edit Annuities’ screen is described below. After 
processing that screen, or choosing not to, the ‘User Defined 
Associate Charges – Simple’ screen is displayed. At this point 
you can choose another country for which to edit the fee rules, or 
choose Return to go back to the main screen.  

Pressing the Return button – before clicking the Update button 
– will return you to the main program screen without saving your 
changes. 

 Edit Annuities Associate’s Charges – Simple Method 

To specify amounts for the Patent Annuities and Design Annuities, 
click the Edit Annuities button. 

Clicking the Edit Annuities button results in the screen shown 
below: 
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Figure 8-20  User Defined Associate Charges – Simple (Annuities) screen 

 Calculation Amounts are in Currency of Drop Down Field  

The currency to use in relation to the associate charges you are 
entering is selected via this drop-down list box. This entry may 
initially either default to the currency of the country being processed 
or be set to $US. 

 Option Buttons 

The option buttons to the top right of the screen are used as follows: 

 Fee Rules Activated 

When the screen is initially presented for the country, this 
checkbox is checked. This means the fee rules entered, once the 
Update button has been clicked, will be processed and used 
when generating an estimate. If you later wish to revert to the 
system-defined associate charges for the country, uncheck this 
box. You will not need to delete the rules if you wish to switch 
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between the user-defined associate charges and the system-
defined associate charges . 

 How to use these Fee Rules? 

This box delineates, if you have checked the Fee Rules 

Activated box, how your new associate charges will be applied. 
You can check either Use These Fee Rules Exclusively if you 
want your new user-defined associate charges to be used 
exclusively in place of the default system associate charges, or 
check Add To System Fee Rules if you prefer your new 
associate charges to be in used in addition to the default 
associate charges. 

Enter amounts for the Patent annuities and the Design Annuities 
in the boxes shown. The boxes labeled 1-10 are for years one to 
10; the boxes labeled 11-20 are for years 11 to 20. 

Click Update when done, or Return to return without any 
changes being made. 

 Annuity Service 

This menu item is used to enter Associate Charges associated with 
Patent and Design Annuities that are applicable to all countries. Any 
settings for annuities applied through User Defined Associate 
Charges, either Simple or Detailed, will override these charges for a 
specific country. (See Chapter 8, Edit Menu, User Defined Associate 

Charges, Simple Method – General Description or Chapter 13, User 

Defined Associate Charges – Detailed Module for additional 
information.) 

The Annuity Service menu item has been added to replace the 
repetitive process of entering these amounts separately for each 
country. 

To specify amounts for the Patent and/or Design Annuities, choose 
Annuity Service from User Defined Associate Charges in the Edit 
Menu. The following screen will be displayed: 
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Figure 8-21  Annuity Service screen 

Enter the desired amounts for each annuity year. When all amounts 
have been entered, click the Update button, or click the Return 
button to return to the previous screen without any changes being 
made. 

If all amounts are set to zero, the program assumes that the annuity 
service method of setting associate annuity amounts across countries 
is not to be used. If, in fact, the user wants to show zero amounts, set 
the amounts to “0.1”. The 0.1 will be rounded down to zero. 

 Calculation Amounts are in Currency of Drop Down Field 

The currency to use in relation to the amounts you are entering is 
selected via this drop-down list box. This entry defaults to the United 
States of America. 

 Option Buttons 

Once all the amounts have been entered, review the option buttons at 
the top of the screen. These buttons are now described in detail: 
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 Fee Rules Activated 

When the screen is initially presented, this checkbox is checked. 
This means that once the Update button has been clicked, the 
annuity amounts entered will be processed and used when 
generating an estimate. If you later wish to revert to the system-
defined annuity amounts for the country, uncheck this box. You 
will not need to delete the annuity amounts if you wish to switch 
between the user-defined amounts and the system-defined 
annuity amounts. 

 How to Use These Fee Rules? 

This box delineates, if you have checked the Fee Rules 

Activated box, how your new amounts will be applied. You can 
check either Use these Fee Rules Exclusively if you want your 
new user-defined amounts to be used exclusively in place of the 
default system amounts, or check Add To System Fee Rules if 
you prefer your new amounts to be in used in addition to the 
default annuity amounts. 
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9 Reports Menu 

Introduction 

Figure 9-1 shows the Reports Menu: 

 

Figure 9-1  The Reports Menu screen 

The Reports Menu gives you the option to view and print some of the 
data that underlies the GLOBAL IP ESTIMATOR, especially data that 
can be modified by the user via the various items of the Edit Menu. 

 To Navigate Within the Reports 

To view a report, click Reports and choose the report to bring it up 
on the screen. 

The top bar of each report screen shows several navigation tools 
available to the user. To view sections of the report page not visible 
on the screen, use the navigation tools at the top of the screen and the 
scroll bar on the right side of the screen. Use the scroll bar until you 
reach the end of the page. To go forward in the report click the� 
button; the �| button takes you to the end of the report. Likewise, to 
view the previous page, choose the � button; the |� button returns 
you to the beginning of a report. 

A Print Report icon is available on the top bar of the screen. When 
clicked, a Print box will appear giving options for number of copies 
and pages to be printed. To the right of the Print Report icon is a 
drop-down list with view magnification options. Click on the drop-
down list and click on the desired view option. 
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You can also print the report by clicking the Print Report button at 
the bottom of the report page. Clicking this button will print the 
entire report.  

An “Export Report” function is also available. To use this, click on 
the Export button on the top bar of the screen. An “Export” box will 
then be shown, allowing the user to choose the type of Excel format 
to use, as well as the destination of the file. 

To return to the ‘Global – IP Main’ Menu screen, click the Return 
button. 

View/Print Reports 

The Reports Menu items are detailed below: 

 View/Print In-House Charges 

In addition to the default “01 Main” set of In-House Charges that are 
part of the basic GLOBAL IP ESTIMATOR software, this report 
reflects the In-House Code sets that you may have created.  

You can view one set of charges at a time by highlighting the In-
House code you wish to view and clicking the Proceed button. If 
you wish to view all of the sets of charges, click the View All check 
box and then click the Proceed button. 

To close the box without viewing the report, click on the Close 
button, and you will be returned to the main menu. (See Chapter 8, 

Edit Menu, In-House Charges for more information.) 

 View/Print General Application Settings 

In addition to the default set of Report and Calculation values that 
are part of the software, this report reflects changes to these settings 
made by user within two Edit Menu items: the Report Settings and 
the Calculation Settings. (See Chapter 8, Edit Menu, Report 

Settings and Calculation Settings for more information.) 
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 View/Print Country Specific Settings 

The Country Specific Settings report reflects changes entered by the 
user through the Edit Menu, Country Specific Settings option. 

Each country will have an individual section on the report, reflecting 
the comments to be printed on the Summary and Detail reports, the 
In-House Code Charges to be used for that country, as well as the 
adjustment values. (See Chapter 8, Edit Menu, Country Specific 

Settings for more information.) 

 View/Print Exchange Rates 

This report shows the currency exchange rates and the date last 
modified for all countries in the GLOBAL IP ESTIMATOR. 
Countries using $US are also listed. While the most current currency 
exchange rates are provided with each Monthly Maintenance Update, 
changes to these figures can be made via the Exchange Rates item 
in the Edit Menu. (See Chapter 8, Edit Menu, Exchange Rates for 
more information.)  

 View/Print Translation Settings 

In addition to the default set of Translation Settings values that are 
part of the software, this report reflects changes to these settings 
made by user in the Translation Settings, an option of the Edit 

Menu. (See Chapter 8, Edit Menu, Translation Settings for 
additional information.) 

 View/Print Translation Cost Settings 

This report shows the values entered in the Set Translation Costs 

into Individual Languages screen, which is part of the Translation 

Settings, an option of the Edit Menu. This report shows the fixed 
amounts you assigned for translation from a specific language to any 
other language, as well as the text description you assigned. (See 
Chapter 8, Edit Menu, Translation Settings for additional 
information.) 
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 View/Print User Defined Associate Charges 

This report shows the user-defined associate charges that have been 
created for each country, whether using the Simple method, Pre-
defined Templates or the Advanced Process. (See Chapter 8, Edit 

Menu, User Defined Associate Charges for further additional 
information.) 

 View/Print Country List 

Choosing this item presents a screen for selection of the type of 
Application (i.e., Patent, PCT Patent - National Phase, EPO Patent - 
Regional Phase, Trade Mark, or Design). After making this selection, 
click Proceed to view and/or print the list of countries available in 
the GLOBAL IP ESTIMATOR for that type of application. 

 View/Print Timeline Settings 

This report shows changes made to the Timeline Settings, both for 
all countries and for individual countries. (See Chapter 12, Timeline 

Module for additional information.) 
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10  Licensing Menu 

Introduction 

GLOBAL IP ESTIMATOR requires an active license for each computer 
given access to the program. Each active license is identified via a 
unique Registration ID, which is associated with a particular computer. 
The hardware installed on the computer is used as part of the 
identification process. 

The Registration ID is allocated to a computer when the program is first 
used at the computer, and must be sent to Quantify IP for processing. We 
enter the Registration ID into the current validation table. This validation 
table is sent out with the next Maintenance Update. If the Registration ID 
for the computer is not included in the validation table, program use is 
disallowed. 

The Licensing Menu, Register License option allows the user to register 
the license for the computer in use, if it has not already been completed 
at the time of installation. Other options include allowing the user to 
activate additional software licenses and software modules as well as 
view and print licensing information and history. Lastly, an option is 
available that allows the Licensing Agreement to be brought up on the 
screen and printed out. 

Before discussing the Licensing Menu items, a brief description will be 
given of important information about licenses, registration, and 
activating software modules. 

 Registering 

Registration of each license is required. The Registration Form may 
be sent in as part of the program installation process, or later via a 
Licensing Menu option.  

Program Options (Modules) and Module Activation 

The functions provided by the GLOBAL IP ESTIMATOR program 
are divided into “modules”. The modules currently available are: 
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••••    System Module: the basic GLOBAL IP ESTIMATOR software 
module – required for all other modules.  

••••    Patent and Trademark Module: for Patent and Trademark 
Estimates. 

••••    Design Module: for Design Estimates. 

••••    Timeline Module: to create Excel spreadsheets with costs 
allocated to specific years. 

••••    User Defined Associate Charges: with the ability to specify 
User Fee Rules under complete user control. 

••••    Assignment/Modification Module: for Assignment and 
name/address change estimates. 

••••    Prosecution Module: for charges related to the Prosecution 
process of Patent applications. 

The System Module is always activated. Other modules are activated 
via authorization passwords. When you purchase a license for the 
software, you acquire the System Module and activate the Patents 
and Trademark Module via a password. 

The password to activate a module may be entered during initial 
program installation (as described in Appendix B, License 

Installation), or later via the Licensing Menu, as described in the 
Activate Additional Program Module section below. The 
authorization password for each module changes monthly. 

Multiple License Policy 

GLOBAL IP ESTIMATOR is typically an occasional use program – 
not used constantly, but invaluable when needed.  

The needs of many firms can be met by purchasing one license for 
the program. This license entitles the firm to install the software on 
one computer. This computer is then used to generate estimates for 
everyone in the firm.  

There are also situations where a firm has several frequent users. In 
this case, it may be more efficient to have several computers licensed 
to install the software.  
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We have attempted to balance these factors by providing the option 
to purchase a Main License for any given location, plus the option of 
purchasing Additional Licenses for that location at a significantly 
lower price than the main license. 

The availability of additional licenses is restricted as follows: 

1) Each additional license must be for the same company/business 
entity as purchased the main license. 

2) Each additional license must be for a computer at the same 
physical location (i.e., street address) as the computer on which 
the main license is installed.  

3) Every computer on which the software is installed must have its 
own license, and may be used by more than one person.  

4) In a network installation, the program may be placed on a 
network server. However, items 1 to 3 above still apply, in that 
any computer given access to the program (via a Windows 
desktop icon or other means) needs to have its own license. 
(Please note that this licensing agreement is not the same as the 
more common “concurrent user” software license.) Additional 
licenses must be for the same company, and be at the same 
address as the main license. If different addresses are involved, 
then each address must have its own main (and additional) 
license(s) for the computer(s) accessing the network server for 
the program and/or maintenance updates. 

It is also possible to purchase a Location License. This licensing 
option can be a cost effective choice when there is a desire to have 
more than 12 computers licensed to use the software at one location. 
Locations with a Location License are not required to register each 
registration ID. The software recognizes the Location License, and 
allows program use. 

Once a Main License has been purchased, additional software 
modules (Design, Assignment, Timeline, etc.) can be purchased to 
enhance various estimating capabilities. These additional modules, 
described above in the Program Options (Modules) and Module 

Activation section, are licensed to the Main License. All licenses 
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(Main and any Additional Licenses) at the location are licensed to 
use these additional modules at no additional charge.  

Licensing Menu Items 

The Licensing menu screen is shown on the next page:  

 

Figure 10-1  Licensing Menu screen 

 Activate Additional Program Module/License 

This menu item is used to activate additional licenses as well as 
additional program modules.  

Once a user chooses Activate Additional Program Module from 
the Edit Menu Licensing drop-down list, a screen will appear, as 
shown below: 
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Figure 10-2  Activate License screen 

 Activating Additional Licenses 

Once the Main License has been purchased and installed at a 
location, Additional Licenses may also be purchased and 
installed at that same location.  

To activate an Additional License, notify our office of your 
desire to purchase the license(s). Once the license(s) has/have 
been purchased, our office will send you the current password to 
activate the license(s). 

If the Additional Licenses are for a network installation, the 
password is entered in the “Full Version” field. If the Additional 
License(s) is/are for stand-alone computer(s), the password is 
entered during initial program installation on the computer(s). 

 Activating Additional Modules 

Additional modules may be purchased and installed at any time. 
These additional software modules are embedded in the software 
but must be activated with a password to become available for 
use. As mentioned above, once an additional module has been 
purchased for a location, all licenses (Main and any Additional 
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Licenses) at the location are licensed to use it at no additional 
charge.  

To activate an additional module, notify our office of your desire 
to purchase the module(s). Once the module(s) has/have been 
purchased our office will send you the current password(s) to 
activate the module(s). 

Once you have the password(s) you can activate the module(s) 
for each license by choosing Activate Additional Program 

Module from the Licensing Menu drop-down list. Each module 
has a corresponding password field. Enter the password in the 
module’s field, click the Proceed button, and the license will be 
activated. 

If a module is already activated, the activation option for that 
module will not appear on the screen. 

 Register License 

As mentioned above, the Registration ID is allocated to a computer 
when the program is first used at the computer and must be sent to 
Quantify IP for processing.  

During initial program use, the user is invited to either email or print 
out and fax the registration form.  

To complete the registration process after initial use, click the 
Register License item on the Licensing Menu. The screen 
presented by this item is shown in Figure 10-3: 

 

Figure 10-3  Registration Information screen 
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Options are provided for printing the registration (Print) or sending 
via the Internet (Send). If the Print button is clicked the printer 
dialog box will appear. Click OK. This will print out the Registration 
Form so that it can be faxed in. Clicking the Send button will show 
the following screen, which allows you to send the registration 
information via the Internet. You can also save the information to a 
file and send it later. 

 

Figure 10-4  Send Registration screen 

To email the form, the user’s computer must have some type of 
emailing software program available on their computer (e.g., 
Outlook). If your email software is not up and running already, 
activate it now.  

Once the user clicks the Email button, the registration process is 
completed immediately. A dialog box saying “Thank you” appears. 
Click OK. 

 Demo Accesss 

This item may be used to enable a Program Module that you have 
not purchased, and would like to know more about. 

To activate this feature, you must first contact Quantify IP, and we 
will enable program modules for that single session of program use. 
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 About License in Use 

This menu item presents a screen showing licensee information for 
the current user. It also shows the expiration date of the license, and 
the “Data ID”, which contains the date of the last installed Monthly 
Update.  

Once a user chooses About License in Use from the Licensing 
Menu drop-down list, a screen will appear, as shown below: 

 

Figure 10-5  About License in Use screen 

When you have completed reviewing this screen, click Close to close 
the screen and go back to the ‘Global IP – Main’ screen. 

 View/Print License Information 

This menu item presents a report with detailed information about 
licenses on the current server. The server could be a single computer, 
or a network server.  

Once a user chooses View/Print License Information from the 
Licensing Menu drop-down list, a screen will appear which offers 
the user various options for sorting the data. Choose the Sort by: 
option by clicking the radio button to the left of your chosen sort by 
option. Choose whether this data is to be in Descending or 
Ascending order by clicking the appropriate radio button located at 
the bottom of the screen. Click the Proceed button. 

The items on the report are described as follows: 
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Licenses on this server: The number of licenses that are active and 
running from the current server. 

Licenses allowed at this location: The number of licenses that have 
been purchased for the current location (physical address).  

This is followed by information about each license, including the 
Registration ID, Computer Name (given when installed), Computer 
Location (given when installed), the Network Name, Install Date, 
Last Changed and Last Used. 

Regarding the counts of licenses described above, an example may 
clarify how the counts will appear. 

Example: If the location is licensed for four licenses; three of the 
licenses have been installed; and all three are being used via 
installation on a network server:  

The report will have “Licenses on this server” as 3; and “Licenses 
allowed at this location” as 4. The detailed part of the report will 
show all three licenses. 

If the location is licensed for four licenses, and three of the licenses 
have been installed, each on a separate computer (being used via 
local installation): The report will have the same counts at each 
computer with “Licenses on this server” as 1; and “Licenses allowed 
at this location” as 4. The detailed part of each report will have one 
license (the license locally installed at the computer). 

 View/Print License History 

This menu item presents a report with detailed information about the 
history of licenses on the current server. The server could be a single 
computer, or a network server.  

The use of this item, and the report itself, is similar to the View/Print 
License Information item described above. 
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 End User License Agreement 

This menu item displays the license agreement associated with use of 
the program, with the option to print it out. 

The End User License Agreement is printed in Appendix F.  
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11  Design Module 

Introduction 

The Design Module allows the user to generate estimates for Design 
patent applications. Design patents are completely different from 
trademarks with a design element. 

After activating this module, the user should review the in-house fees 
and costs associated with Design Estimates. These in-house charges are 
described in the In-House Fees and Costs for Design Estimates section 
below. 

Without activating the Module, you can run estimates for Denmark and 
Japan. 

Running a Design Estimate 

Go to the initial screen for GLOBAL IP ESTIMATOR titled ‘Global 
IP – Main’ screen. You will notice that, once you have installed the 
Design Module, the selection button for Designs will be activated 
(white). Click the Design radio button. 

The ‘Global IP–Main’ screen is shown in Figure 11-1: 
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Figure 11-1  Design Global IP – Main screen 

Once the Design radio button has been selected, click the Proceed 
button. 

The ‘Specify Destination(s) of Application’ screen is presented. 
Select the countries to include in the estimate by clicking on each 
one. Boxes are available to change the In-House set of charges to be 
used and to specify whether to include only Official Fees or only 
Official and Translation Costs. You can also choose to exclude 
various stages by clicking the buttons provided on the left bottom 
side of the screen. In-House Fees and Costs for Designs will be 
discussed in more detail in the following section.  

This screen is shown in Figure 11-2: 
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Figure 11-2  Design Specify Destination(s) of Application screen 

Once the country selection and any changes to the In-House Charges 
set, categories and stages to exclude selections have been completed, 
click the Proceed button. 

Based on the destinations you have selected, the program determines 
the relevant application parameters and presents the ‘Enter 
Application Information’ screen.  

This screen is shown in Figure 11-3: 
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Figure 11-3  Design Enter Application Information screen 

In this screen, enter the appropriate amounts into the boxes on the 
left. You can change the Yes/No options on the right by tabbing or 
clicking on the item and using the space bar to change the value. You 
can also use the arrow keys to navigate between items. 

At this point, you have the option of saving the scenario for future 
re-use or reference by clicking the Save Scenario button. A new box 
will appear, allowing you to name the scenario. Scenarios are 
discussed in more detail in Chapter 5, Scenarios.  

Once you have entered the amounts in the application parameters, 
click the Proceed button.  

The estimate is calculated and presented in report form. The first 
report to appear will be the GLOBAL IP ESTIMATOR – Condensed 
Summary. The screen is presented below: 
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Figure 11-4  Design Global IP Condensed Report screen 

You can also choose to view and print the Summary Report and the 
Detail Report.  

From the report screen, you have the option of returning to the 
beginning in order to create additional Design or other application 
type estimates.  

For further instructions on preparing estimates, please review the 
various sections devoted to estimating elsewhere within this Guide. 

In-House Fees and Costs for Design Estimates 

 Introduction 

The ‘In-House Charges’ Edit Menu item allows you to modify the 
default In-House Charges that are included with the software, as well 
as create additional sets of In-House Charges for use by different 
individuals using the software, in various scenarios, and with 
different clients. 
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Please review Chapter 8, Edit Menu, In-House Charges for a general 
description of In-House Charges, as well as to learn how to change, 
add, and delete sets of In-House Charges. The following section will 
focus on the specifics of Design In-House Charges. 

 Design In-House Charges 

Once a user has chosen the In-House Charges from the Edit Menu 
drop-down list, a screen titled ‘Sets of In-House Charges’ will 
appear. This screen has an option for selecting Designs. The ‘Sets of 
In-House Charges’ screen is shown below: 

 

Figure 11-5  Design Sets of In-House Charges screen 

Choose Designs by clicking on the Designs radio button. Click the 
Proceed button. The ‘Designs’ screen will appear. 

The screen is shown in Figure 11-6: 
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Figure 11-6  Design In-House Charges screen 

The first column specifies the Category of Charge. The second 
column specifies the Stage. The third column gives a description of 
each Type of Charge. The fourth column indicates the current 
Charge Amount.  

To modify an amount, either click or tab into the box. This will 
highlight the amount. Replace the amount with the new amount. To 
move from one Charge box to the next, use the tab key or the up and 
down arrow keys on the keyboard. 

 Completing the Process  

When all the changes have been made, click the Update button. This 
will take you back to the ‘Sets of In-House Charges’ screen. From 
here you can continue to create, modify, or delete sets of In-House 
Charges for Designs or other application types.  

Choosing Return will return you to the ‘Sets of In-House Charges’ 
screen without saving your changes. 
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12  Timeline Module 

Introduction 

The Timeline Module allocates the costs calculated by the program to 
particular years in the future. This capability is useful for budgeting 
future costs. For patents, the year associated with a stage is shown on the 
Detail Report, and years are shown for the annuities in the Annuity table 
in the Detail Report. The calculations are also saved to four Excel 
spreadsheets: one with the costs separated into categories (Official, 
Associate, In-House and Miscellaneous) for each country; one with the 
costs separated into stages (Filing, Examination, Grant for Patents) for 
each country; one with the totals for each country; and one with running 
totals, showing the cumulative amounts paid up to a specific year. 

The Timeline projection uses average times for each stage to be 
completed. Since this information is not typically included in fee 
schedules from foreign associates, we obtained the average processing 
times by communicating with associates and asking them for the 
information. The data is included in the monthly update, and may change 
as a country’s policies change, or as the data becomes more refined. 

While the module does come with system-defined Timeline data (as 
described above), the user can specify the average number of years for 
completion of stages of the application. These user-defined averages can 
be entered for any selected countries, to be used in place of system 
numbers. Entering this information is discussed in the Changing the 

Timeline Settings section below. 
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Dates Associated With Timeline Generation 

The ‘Country Selection’ screen for a Patent application will have 
date fields on the lower right of the screen, which varies per 
application type, as shown below: 

 

 Patent PCT Patent - EPO Patent - 

 National Phase Validation Phase 

Figure 12-1 Timeline Dates 
 

These date fields are used as follows: 

 Earliest Priority Date 

Definition: Date of the earliest priority claimed for the 
application being estimated. 

Program Use: Annuities are calculated for 20 years from this 
date. No other use by the program. 

Preset Value: Patent: Current date minus 12 months. 

 PCT National: Current date minus 42 months 

 EPO Validation: Current date minus ((“Years to 
EPO Grant”) x 12 months) minus 42 months 
(assumes EPO via PCT). The “Years to EPO 
Grant” is a value set by the user in the In-House 

Charges for annuities. (Pre-set to 4 years.) 
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 Parent Application Date 

Definition: Date of the initial application for this patent family. 

Program Use: PCT National Phase application dates are set to 30 
months from this date. PCT Exam date is set to 22 
months from this date.  

Preset Value: Patent: Current date minus 12 months. 

 PCT National: Current date minus 42 months 

 EPO Validation: N/A 

 PCT Filing Date 

Definition: Date the application was filed with the PCT 
Receiving Office. 

Program Use: Affects Exam dates and Annuity dates of PCT 
National phase country applications. 

Preset Value: Patent: N/A 

 PCT National: Current date minus 30 months 

 EPO Validation: N/A 

 PCT Filing (EP via PCT) or EP Filing (EP direct) 

Definition: For an EP application that was filed via the PCT, 
enter the date the PCT application was filed with 
the PCT Receiving Office. For an EP application 
filed directly, and not via the PCT, enter the date 
filed with the EP. 

Program Use: Affects Annuity dates for the EP Validation phase 
countries. 

Preset Value: Patent: N/A 

 PCT National: N/A 

 EPO Validation: Current date minus ((“Years to 
EPO Grant”) x 12 months) minus 30 months 
(assumes EPO via PCT). The “Years to EPO 
Grant” is a value set by the user in the In-House 

Charges for annuities. (Pre-set to 4 years.) 
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 This Application Date 

Definition: Date application being estimated is filed. 

Program Use: Affects Filing, Exam, Prosecution, Grant and 
Annuity dates. 

Preset Value: Current date for all types 

 Report Start Date 

Definition: Include costs from this date. 

Program Use: Costs are included from this date on. 

Preset Value: Current date for all types 

 Report End Date 

Definition: Include costs until this date. 

Program Use: Costs are included until this date. 

Preset Value: Current date plus 20 years  

For annuities, the calculation is by year. If an annuity occurs during 
or after the year of the Report Start Date, it will be included, 
regardless of the month. If an annuity occurs during or before the 
year of the Report End Date, it will be included, regardless of the 
month. 

Note that the “Include Maintenance From and To Year” fields are 
not displayed when the Timeline Module is activated. The selection 
of these years is done via the Report Start and End dates. 
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Generating the Timeline Spreadsheets  

A Timeline spreadsheet can be produced for any Patent or 
Trademark estimate. Enter information for the estimate as usual, 
identifying the countries and application information. Once you 
proceed to the reports screen, you will find the following buttons at 
the bottom of the screen, as shown in Figure 12-2. 

 

Figure 12-2  Timeline Report Buttons screen 

Clicking the EMail/Save Timeline to Excel button will result in 
another window appearing on the screen. Use this screen to specify 
one email address to which to send the saved file, or enter the name 
of the spreadsheet and set the folder. 

A default name for the spreadsheet, “Global IP Report Timeline.xls”, 
is given. To replace the existing name, highlight the existing name (if 
it is not already highlighted) and type in the new name. Whatever 
name is entered will be used for the main spreadsheets and for the 
Condensed Summary Format spreadsheet, which contains country 
totals only. 

The default folder that will be used is identified, and can be 
temporarily changed here. (See Default Folder for Saved 

Spreadsheets section below for instructions on setting the default 
path.)  

Once you have made your changes to the ‘Save As’ screen, click 
Save. The Timeline format spreadsheets will be created and saved in 
the folder specified by you. 

In addition to the Timeline format spreadsheets described below. a 
Condensed Summary Format spreadsheet is also produced, which is 
the default Excel save format, and is described in Chapter 6, 

Reports. The name given to this spreadsheet has “_Condensed.xls” 
as a suffix. 
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Timeline Spreadsheet – Details 

 Patents 

The average number of years to Patent examination and grant in each 
country is used to produce a yearly projection of when costs will be 
incurred. The annuities are then allocated to the appropriate years, 
based on whether annuities begin from filing date, from publication 
date, or from grant date. 

The Patent Timeline can be used with: 

•••• An estimate for applications sent directly to national Patent 
offices. 

•••• A two-part estimate – for example, to project PCT application 
costs with ensuing National Phase costs.  

•••• A three-part estimate – for example, to obtain the Timeline 
projection for a PCT application, followed by an EPO 
application, followed by the EPO Validation phase. 

Two Timeline spreadsheets generated contain detailed country 
information. The spreadsheet named “Category” has rows with 
Official, Associate, In-House and Miscellaneous totals by year. The 
spreadsheet named “Stage” has rows with Stage (for example, 
Filing) totals by year. 

Both a “Totals” and a “Running Totals” spreadsheets are also 
produced. The “Running Totals” spreadsheet shows the cumulative 
costs of the patent.  

Part of the Timeline spreadsheet by Stage for a three-part Patent 
estimate is shown in Figure 12-3: 
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Figure 12-3  Timeline Excel Spreadsheet Sample screen 

This is the timeline report for a PCT application followed by 
National Phase applications to the EPO and Japan, followed by 
validation of the EPO patent in Austria, France and Germany. The 
PCT application was filed in November 2005. 

There are several elements worth pointing out about the time 
allocation of the costs. 

• The PCT filing amounts are in 2005. 

• The Chapter II amounts are in 2007, since Chapter II is 22 
months after filing, and filing was in November 2005. If the 
filing had been February 2005, the Chapter II amounts would 
have been allocated to 2006. 

• The EPO and Japanese National Phase filing amounts are in 
2008 (30 months after filing the PCT application). Again, the 
filing month affects the allocation. With a filing month of 
February, the time allocation is to August 2007. If the filing 
month had been July or later, then the allocation would have 
been to 2008. 

• The EPO exam amounts are in 2008, three years after the 
international filing date. The grant is in 2012, four years after the 
EPO filing date. 
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• The EPO annuity amount calculations are based on the 
International Priority date. Since the date is in 2005, there is an 
annuity due in 2008, the same year as the EPO filing. EPO 
annuities are also added into the amounts for 2009, 2010, and 
2011. (The totals in any year include all sources of charges for 
that year.) 

• The Japanese exam amounts are in 2008 (2.5 years after the 
international filing date) and grant amounts are in 2012 (four 
years after filing in Japan), since our system settings have these 
numbers of years in the database. 

• The Austrian validation amounts are in 2012, the same year as 
the EPO grant. The Austrian annuities start the same year. The 
annuity amounts are based on the publication date, which is 
calculated as 18 months from the International Priority date. The 
French and German amounts are in similar years, except that 
their annuities are calculated based on the International filing 
date. 

• Annuity calculations stop 20 years from the filing date. 

Note the “Discounted Total” column next to the “Total” column. The 
discount rate is a user setting (0% above). If not zero, amounts in 
future years are discounted via the “Net Present Value” function in 
Excel. 
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 Trademarks 

For Trademarks, the Timeline projects application and renewal costs 
by year. An example of a Trademark Timeline spreadsheet is shown 
in Figure 12-4: 

 

Figure 12-4  Timeline Trademark Report Sample screen 

The amounts shown in Year 1 are Filing costs, the amounts shown in 
Year 2 are Registration costs, the amounts shown in Year 11 are 
Renewal costs. If the renewal was due in fewer years than 10 years 
after registration, the renewal costs would have been placed in the 
appropriate year. 

 Designs 

Timeline reports are not yet available for Designs. 

Changing the Timeline Settings 

As mentioned previously, while the Timeline Module does contain 
system-defined Timeline data, the user can specify the average 
number of years for completion of stages of the application for any 
of the selected countries. The user-defined Timeline settings, once 
entered, will take precedence over the system-defined settings. 

Once the user has chosen the Timeline Settings from the Edit Menu 
drop-down list, a screen titled ‘Timeline Settings’ will appear. Figure 
12-5 shows this screen:  
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Figure 12-5  Timeline Settings screen 

The top part of this screen includes user settings that apply for all 
countries without specific settings. The country-specific settings are 
entered in the lower part of the screen. 

 User Timeline Settings Across Countries 

These items on the top part of the screen are used as follows: 

••••    Years to Exam: (For Patents) Default years to Patent 
examination. Used only if there is no system-defined data for a 
country. (See discussion of “Precedence Rules” below.) 

••••    Years to Grant: (For Patents) Default years to Patent grant. 
Used only if there is no system-defined data for a country. (See 
discussion of “Precedence Rules” below.) 

••••    User discount rate: A percentage rate for use in calculating 
discounted totals. If not zero, amounts in future years are 
discounted via the “Net Present Value” function in Excel. 
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 Country Specific Timeline Settings 

Data for particular countries may be entered in the ‘Country Specific 
Timeline Settings’ section on the bottom half of the screen.  

To modify the data for a country, first select the country in the 
country drop-down list. Once the country is highlighted, you may 
proceed to enter the related data in the boxes to the right.  

The country items are shown with self-explanatory labels: 

••••    Patent Years to Exam 

••••    Patent Years to Grant 

••••    PCT Patent Years to Exam 

••••    PCT Patent Years to Grant 

••••    Trademark Years to Registration 

Note the added distinction of time settings for direct national Patent 
applications versus PCT National Phase applications. 

 Completing the Process  

Once you have made the data modifications for your selected 
country, click the Update button. A box will appear stating that the 
“Country Specific Timeline Settings have been updated”. Click OK. 
This latest user-entered data for the country modified will now take 
precedence over any other settings, including the system-defined 
settings for that country.  

You may continue to select countries and modify their Timeline data 
or click the Return button to return to the ‘Global IP – Main’ screen. 

Pressing the Return button – before clicking the Update button – 
will return you to the previous screen without saving your changes. 

Deleting User-Defined Timeline Data 

To delete the user-defined data for any or all fields and return to the 
system-defined data, select the country on the Timeline Settings 
screen that you wish to modify and replace the user-entered data in 
the specified field with “0”. Once you have made all your changes, 
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click the Update button. For every field that has “0” as its value, the 
system-defined data will take precedence. 

Precedence Rules 

There are several database fields that contain information about the 
timing of the same event. For example, the “Years to Exam” for 
Patents may be identified in several ways. The program uses the 
following rules to establish which number to use. The “Years to 
Exam” for Germany will be used for illustration purposes. 

•••• If the user has entered a non-zero value for “Patent Years to 
Exam” for Germany (in the ‘Timeline Settings’ screen shown 
above), that value is used. 

•••• If there is no user-entered value for “Patent Years to Exam” for 
Germany, the system-defined value for “Patent Years to Exam” 
for Germany will be used. (This value is sent as part of the 
database every month, and may change if we change the 
database because of additional information from foreign 
associates.) 

•••• If there is no user-entered value and no system-defined value for 
“Patent Years to Exam” for Germany, the user-entered default 

value for “Years to Exam” (if any) will be used, i.e., the non-
zero value entered in the “User Specific Timeline Settings” in 
the top part of the ‘Timeline Settings’ screen as shown above. 

•••• If there is no user-entered value and no system-defined value for 
“Patent Years to Exam” for Germany, and no user-entered 
default value for “Years to Exam”, then the system-defined 

default value for “Years to Exam” will be used. 

Default Folder for Saved Spreadsheets 

The File Menu item in the main program screen has an item labeled 
‘Default Path Setup for Saved Files’. Clicking this menu item results 
in the typical Windows folder navigation screen. Identify the folder 
into which you wish to place any saved reports. The report name that 
shows on this folder navigation screen is “Global IP Report”. This is 
for illustration purposes only. The actual report name will reflect 
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which report is being saved. The purpose of the menu item is to 
identify the folder into which to place the reports. 

Once the default path has been set, it can be modified by either 
returning to the File Menu Default Path Setup for Saved Files item 
or at the time the Email/Save Report button is clicked on the 
‘Report’ screen. There you can modify the “Save in” setting.  
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13  User Defined Associate Charges – 
Detailed Module 

Introduction 

Fee rules define the parameters used by GLOBAL IP ESTIMATOR 
to generate estimates for each individual country. GLOBAL IP 
ESTIMATOR uses Fee Schedules from Associates to determine the 
default fee rules. Some fee rules reflect fixed amounts, and some 
depend on the attributes of the application, such as the number of 
pages in the application, or number of claims. 

The User Defined Associate Charges – Detailed Module allows the 
user to add to or replace the system-defined fee rules via two 
methods: Pre-Defined Templates and Advanced Process. For each 
individual country, you can set individual fee rules for Associate’s 
Charges for each type of application available for that country. This 
module thus gives the user nearly unlimited ability to set the 
Associate’s Charges to exact specifications. 

Note: A third method, the Simple Method, is supplied as part of the 
basic GLOBAL IP ESTIMATOR software. It allows the user to enter 
a limited number of fee rules. To view instructions on this method, 
see Chapter 8, Edit Menu, User Defined Associate Charges. All 
three methods may be used for any country. All rules specified will 
apply.  

 General Description 

Once a user has chosen User Defined Associate Charges - Detailed 
from the Edit Menu drop-down list, a screen titled ‘User Defined 
Associate Charges Country and Type Selection’ will appear, as 
shown in Figure 13-1: 
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Figure 13-1  User Defined Associate Charges Country and Type Selection 

screen 

The list of countries on the left is used to select the country. The 
option buttons to the top right are used to select the Application 
Type. The option buttons on the bottom right are used to select the 
process (Pre-defined Templates or Advanced) to use.  

Choose the country whose Associate’s Charges you wish to modify.  

Once you have chosen a country, the Application types available for 
that country will become activated, with a white radio button. (Un-
available types will show a gray radio button.) The fee rules depend 
on the type of application: Patent, PCT Patent - National Phase, 

EPO Patent - Validation Phase, Patent Annuities, Trademark, 
Design, or Design Annuities. Choose the Application Type.  

You can choose between two methods for changing the associate 
charges: Pre-Defined Templates or Advanced Process. If you 
choose the Pre-Defined Templates method you will need to 
understand something about how fee rules are constructed, but 
“templates” are provided which simplify the process. If the 
Advanced Process is chosen, any number of associate charges may 
be specified, with full access to the elements that comprise each fee 
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rule. The user needs to understand exactly what a fee rule is, and 
how to construct one. The changes made by one method will not 
affect the changes made by the other method. 

Typically, if you make changes to any of the three Patent application 
types, you will also want to make changes to the Patent Annuities 
application type. Likewise, if you make changes to the Design 
application type, you will want to make changes to the Design 
Annuities application type. 

Each User Defined Associate Charge represents one line item in the 
Detail Report. These line items are accumulated into totals for the 
Condensed and Summary Report numbers. 

Once you have chosen the country, application type, and process 
(Pre-defined Templates or Advanced Process), click the Proceed 
button to move to the next screen. If Predefined Templates were 
chosen, this screen will be titled ‘User Defined Associate Charges - 
Template’. If the Advanced Process was chosen, a screen titled ‘User 
Defined Associate Charges List’ will appear. 

The rest of this chapter discusses these two process options, starting 
with the Pre-Defined Templates followed by the Advanced Process. 

Pre-Defined Templates 

Once the user has chosen the country, application type, and the Pre-
Defined Templates, a screen will be displayed, titled ‘User Defined 
Associate Charges - Template’. This screen shows all the fee rules 
and other processing options for that selection. All countries and 
Application Type selections for the Pre-Defined Associate Charges 
process will show, in general, the same basic screen layout. (The 
exception is the Patent Annuities screen, where the display has a 
different format. This will be discussed in the sub-section, Pre-

Defined Templates - Patent Annuities.) 

The procedures for modifying the Pre-Defined Templates Associate 
Charges will be illustrated via the example of Germany selected, 
Patent, and Pre-Defined Templates selected. This screen is shown 
in Figure 13-2: 
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Figure 13-2  User Defined Associate Charges Template screen 

There are option buttons at the top of the screen which apply to all 
the associate charges defined for this country and application type. 

 Fee Rules Activated 

When the screen is initially presented for the country/application 
type, this checkbox is checked. This means that once the Update 

button has been clicked, the fee rules entered will be processed and 
used when generating an estimate. If you later wish to revert to the 
system-defined fee rules for the country/application type, uncheck 

this box. You will not need to delete and re-enter these rules if you 
wish to switch between the user-defined rules and the system-defined 
rules. 

 How to use these Fee Rules? 

This box delineates, if you have checked the Fee Rules Activated 
box, how your new fee rules will be applied. You can check either 
the Use these Fee Rules Exclusively box if you want your new user-
defined associate charges to be used exclusively in place of the 
default system fee rules, or check the Add To System Fee Rules box 
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if you prefer your new fee rules to be in used in addition to the 
default fee rules. 

 Keep In-House/Allocation Options  

 Keep In-House Charges 

You can direct the In-House costs to be included in the estimate 
for the country by clicking the Keep In-House Charges 
checkbox. This box is checked by default. If you do not want In-
House Amounts included in the reports, you must uncheck the 
box.  

An example of not including In-House Fees would probably 
arise when you are doing an estimate for your home country. In 
this case, you would probably also click the Allocate these 

charges to the In-House category instead of to the Associate 
category box. In essence, the software would then represent the 
Associate’s fees in the In-House column, and thus eliminate the 
Associate’s fees. 

Allocate these amounts to the In-House category instead of to the 

Associate category 

As described briefly above, if you click the Allocate these 

charges to the In-House category instead of to the Associate 
category option, the program changes the category associated 
with all Associate’s amounts for this country (including the user-
defined associate charges being entered in this screen) from the 
Associate category to the In-House category. If the Keep In-

House Charges box is left checked, both the values from the In-
House set and the Associate’s charges will appear as In-House 
charges. 

These Keep In-House/Allocation options are identical to the 
similarly labeled options that can be set via the Country-

Specific Settings Edit Menu item. Note: Changing the settings 
for these options in this ‘User Defined Associate Charges - 
Template’ screen, is the same as changing the settings in the 
‘Country Specific Settings’ screen, with the exception that they 
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are used from here only if fee rules are also entered and 
activated. 

 Calculation Amounts Are in Currency of Drop-Down Field 

The currency to use in relation to the fee rules you are entering is 
selected via this drop-down list box. This entry may initially 
either default to the currency of the country being processed, or 
be set to $US. 

 Entering the Fee Rules  

For each type of application available in a specific country, a 
customizable list of fee rules (taking up the bottom half of the 
screen) is presented in spreadsheet form. This spreadsheet represents 
the logic for the line items in the Detail Report. You can make 
changes to these items, including the Text that will appear on the 
report for all items in white boxes; the items in gray boxes are fixed 
and cannot be altered. Additionally, lines for user-defined items are 
available; by default, these are labeled “Other action (REPLACE 
TEXT)” and are only for Fixed Amount items. If you use any of 
these to add new items to the Fixed Amounts, be sure to change the 
text so it reflects what these new items represent. 

Access any field you wish to change by tabbing to or clicking within 
that field. You can also navigate from cell to cell using the arrow 
keys on your keyboard.  

To delete a Fee Rule item, zero out the amounts in the line to be 
deleted. 

 Fee Rules Spreadsheet 

The columns in the fee-rules spreadsheet are interpreted as follows: 

Stage: The stage that corresponds to the line item. If the rule 
results in a non-zero amount, the line will appear on the Detail 
Report in this stage. The stage indicated cannot be changed. 

Text: The text that will appear on the Detail Report for this rule. 
This text can be modified here. 
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Based On: This column is critical to defining how the fee rule is 
used. This information corresponds to items that appear on the 

‘Enter Application Information’ screen. By defining a rule that is 
Based On a particular Application Information item, that item 
will appear in the ‘Enter Application Information’ screen the 
next time an estimate is run for that country/application type.  

For example, by defining a “multiply by” amount for the based 

On/# Pages in application, you are telling the program that, 
when you enter the number of pages for the estimate in the 
‘Enter Application Information’ screen, the number of pages will 
be multiplied by this amount. 

Fixed Amount: This column indicates a specific amount to 
include on the Detail Report. If based on a numeric ‘Enter 
Application Information’ screen item (e.g., number of pages), 
this amount will always appear. If based on a Yes/No item, the 
amount will appear if the ‘Enter Application Information’ screen 

item is marked Yes when running the estimate. 

Over# and Mult By: These options offer additional flexibility 
beyond the simple addition of a fixed amount. These columns 
are used when the ‘Enter Application Information’ screen item in 
the Based On box is numeric. 

Example: A flat fee of $100 may be charged for filing the first 
50 pages of an application (including drawings), but for more 
than 50 pages, the per-page rate becomes $5. To create this rule: 

•••• In the line based on # Pages in application, enter the amount for 
the first 50 pages in the Fixed Amount column: “$100”. 

•••• Enter “50” in the Over# column 

•••• Set the MultBy column to “5”. 

Suppose that later you are creating an estimate for 54 pages 
(excluding drawings) plus six pages of drawings, for a total of 60 
pages. When the Detail report for your 60-page application is 
generated, an additional line specifying $150 for Page Charges 
will appear in the Filing stage section. 
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 Completing the Process 

When all the changes are made, choose the Update button, which 
will return you to the ‘User Defined Associate Charges Country and 
Type Selection’ screen. At this point you can either proceed to the 
next application type for the country, choose another country for 
which to edit the fee rules, or choose Return to go back to the 
‘Global IP – Main’ screen.  

Pressing the Return button – before clicking the Update button – 
will return you to the ‘User Defined Associate Charges Country and 
Type Selection’ screen without saving your changes. 

 Pre-Defined Templates – Patent Annuities 

The screen presented by choosing the ‘User Defined Associate 
Charges Country and Type Selection – Pre-Defined Templates – 
Patent Annuities’ option is shown below: 

 

Figure 13-3  User Defined Associate Charges Country and Type Selection – 

Pre-Defined Templates - Patent Annuities screen 

The button and box options found on the upper portion of the ‘User 
Defined Associate Charges – Template’ screen for Patent Annuities 
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are the same as those found on the ‘User Defined Associate Charges 
– Template’ screen, described above. 

The lower part of the screen, where the calculation amounts are 
entered, is different from the other Pre-Defined Template screens. 
The amounts in this screen are the annuities for years 1 to 20. The 
first 10 annuities are entered in the first row; the second 10 in the 
second row. The amounts for any of the charges may differ from 
each other. 

In the case of annuities only, the Simple Method and the Pre-Defined 
Template Method change the same data. 

Changes made to the annuity amounts are applied only to the country 
you selected on the ‘User Associate Charges Country and Type 
Selection’ screen. The changes are included in the reports for Patent 
Estimates, showing in the Total Annuities on the Summary Report 
and on a separate row within the Annuities section of the Detail 
Report. 

Make all changes before clicking the Update button.   

Advanced Process 

The Advanced Process method is a more complex method, and the 
fee rules that are part of the system defined fee rules and Pre-Defined 
Templates method will be sufficient for most cases. However, we 
include the option to create the fee rules for advanced users, or for 
specialized situations. Note: It is advisable to read through the Pre-
Defined Templates instructions, above, before attempting to modify 
the fee rules using the Advanced Process.  

Once you have chosen the country, application type, and the 
Advanced Process, a screen will appear, titled ‘User Defined 
Associate Charges List’. 

The screen shows all the Advanced Process fee rules already entered 
for that country/application type in the main part of the screen. (The 
screen below shows no fee rules, as no rules have been entered yet.)  
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The process for the Advanced Process method will be illustrated via 
the example of Germany, Patent, and Advanced selected. This screen 
is shown below: 

 

Figure 13-4  User Defined Associate Charges List – Advanced Process 

There are option buttons at the top of the screen which apply to all 
the rules defined for this country and application type. These options 
are the same as with the Pre-Defined Templates method. If both 
methods have been used for a country/application type, then setting 
these options via either method applies to both methods. The Simple 
Method has similar option buttons.  

 Fee Rules Activated 

When the screen is initially presented for the country/application 
type, this checkbox is checked. This means that once the Update 

button has been clicked, the fee rules entered will be processed and 
used when generating an estimate. If you later wish to revert to the 
system-defined fee rules for the country/application type, uncheck 

this box. You will not need to delete and re-enter these rules if you 
wish to switch between the user-defined rules and the system-defined 
rules. 
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 How to Use these Fee Rules? 

This box delineates, if you have checked the Fee Rules Activated 
box, how your new fee rules will be applied. You can check either 
the Use these Fee Rules Exclusively if you want your new user 
defined associate charges to be used exclusively in place of the 
default system fee rules or check the Add to System Fee Rules if 
you prefer your new fee rules to be in used in addition to the default 
fee rules. 

 Keep In-House/Allocation Options  

 Keep In-House Charges 

You can direct the In-House costs to be included in the 
estimate for the country by clicking the Keep In-House 

Charges checkbox. This box is checked by default. If you 
do not want In-House Amounts included in the reports, you 
must uncheck the box.  

Allocate these charges to the In-House category instead of to the 

Associate category 

If you click the Allocate these charges to the In-House 

category instead of to the Associate category option, the 
program changes the category associated with all Associate 

amounts for this country (including the user-defined 
associate charges being entered in this screen) from the 
Associate category to the In-House category. If the Keep 

In-House Charges box is left checked, both the values from 
the In-House set and the Associate’s Charges will appear as 
In-House Charges. 

These Keep In-House/Allocation options are identical to the 
similarly labeled options that can be set via the Country-

Specific Settings Edit Menu item. Note: Changing the 
settings for these options in this ‘User Defined Associate 
Charges List’ screen is the same as changing the settings in 
the ‘Country Specific Settings’ screen, with the exception 
that they are used from here only if fee rules are entered and 
activated. 
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 Adding Advanced Process Associate Charges  

From the ‘User Defined Associate Charges List’ screen, choose Add 

Rule to move to the ‘User Defined Associate Charges Detail’ screen, 
where the rule will be defined.  

Each rule is associated with a stage (filing, examination, etc.), and 
involves specifying a rule about how the values of given ‘Enter 
Application Information’ screen items result in an amount to add to 
the estimate. Each rule will result in a separate line in the Detail 
Report.  

Each rule therefore specifies the stage, a description for the report, 
the application information items to use, and amounts to add or 
multiply. 

This screen is shown in Figure 13-5: 

 

Figure 13-5  User Defined Associate Charges Detail – Advanced Process 

Once on this screen you can access any field you wish to change by 
clicking within that field.  

The fields on the screen are used as follows: 
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 Stage  

Select the stage associated with the rule from the dropdown list 
under the heading Stage.  

 Fee Description 

Type in the text that you want printed in the Detail Report (up to 
40 characters). This is a required field. 

 Yes/No Items 

These items are chosen from the options presented in a drop-
down box, which differ depending on the application type. You 
can specify up to three Yes/No Items for the rule. Each item 
specified will result in a “Yes/No” type question being presented 
about that item when viewing the ‘Enter Application 
Information’ screen when preparing an estimate.  

An example would be to choose “Late Filing of Assignment” 
from the Yes/No Items drop-down list. Once this item is chosen 
as part of the fee rule for that country and type, a “Late Filing of 
Assignment” item will appear on the related ‘Enter Application 
Information’ screen. Choosing “Yes” will indicate that the rule, 
and thus the associated fee, will be applied as part of the 
estimate. Choosing “No” indicates that the rule will not be 
applied, and thus the associated fee will not be added as part of 
the estimate.  

If more than one “Yes/No” item for the rule is specified it is 
important to note that all these items must be marked as “Yes” 

on the ‘Enter Application Information’ screen in order for the 
rule, and thus the fees, to take effect and become part of the 
estimate.  

 Numeric Items  

You can specify up to three “Numeric Items”. These items are 
chosen from the options presented in a drop-down box, which 
differ depending on the application type. Each item specified 
will result in an ‘Enter Application Information’ screen question 
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being presented about that item when an estimate is being 
prepared. When the estimate is run, the values entered by the 
user are used to calculate the amount to add to the estimate based 
on the current rule.  

 Entered Values Should be Added/Multiplied 

You can determine whether the values based on the “Numeric 
Items” will be added together or multiplied before calculation by 
selecting the appropriate radio button. One of these options must 
be chosen in order for the rule to take effect. “Added” is the 
default setting. 

The result of choosing to add or multiply the Numeric Items will 
define the equation used when you enter the numeric information 
for each item (e.g., number of pages) for the estimate on the 
‘Enter Application Information’ screen. This aspect of the rule is 
called the User Entered Value. The equation for determining 
the value is further described in the Fee Calculation section, 
discussed below. 

It is crucial to understand the difference between Numeric Items 
and the Values for those items that affect the fee calculation 
amount. For example, if a calculation is based on the Pages of 
Claims, the Numeric Item is Pages of Claims. The Value is not 
entered on this screen. The Value is entered when running the 
estimate, on the ‘Enter Application Information’ screen. 

 The Fee Calculation  

Once the Yes/No Items and/or Numeric Items on which the rule 
is based have been identified, the actual fee calculation must be 
specified, i.e., how the amount for the estimate is calculated. 

The fee amount calculation contains a Fixed Amount (the “Fixed 
Amount” on the screen). It can also have an additional amount 
that varies dependent on the amounts entered in the “User 
Entered Value over” fields. 

Fixed Amount: Enter the amount that you wish to have as the 
Flat Fee for the fee rule you are defining. This value will be 
added to an estimate’s Detail Report if either the rule’s Yes/No 
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Item(s) are designated “Yes” on the ‘Enter Application 
Information’ screen when preparing an estimate, or if a flat fee is 
associated with the Numeric Item(s). 

Plus User Entered Value over: Enter a value that represents the 
lower limit the “User Entered Value” must reach before the rule 
is applied. This option will be used as part of the calculation 
when a “Numeric Item” is selected. 

up to: Enter a value that represents the upper limit the “User 
Entered Value” can reach for the rule to be applied. This option 
will be used as part of the calculation when a “Numeric Item” is 
selected.  

When creating a fee rule that uses a specified range (e.g., for 
pages in an application between 25 and 50), “50” would be 
entered to represent the high end of this range. 

When an “up to” value is present, the User Entered Value must 
fall within the range for the rule to apply. Conversely, if no “up 
to” value is present, the Fixed Amount always applies. Care 
should therefore be used when creating rules using ranges of 
values. In such cases, the final range should have a value of 
“999” for the “up to” value. See the examples at the end of this 
chapter for a discussion of this process.  

multiplied by: Enter the amount that represents the per-item 
value of the option selected (e.g., to create a per page charge of 
$25, enter “25” in the “Multiplied by” box). 

Calculation amounts are in Currency of:  The currency to use 
for these rules is entered via this drop-down list box. This entry 
may initially either default to the currency of the country being 
processed, or be set to $US. 

Sort Order for Report (within this stage): The fee rules you 
create will be added to the Detail Estimate Report. You control 
the position within the report via the Sort Order for Report 

(within this stage) box. You can enter two-position numbers or 
two-position alphanumeric data. 
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 Completing the Process 

When all the changes are made, choose the Update button, which 
will return you to the ‘User Defined Associate Charges List’ screen. 
At this point you can either add more rules via the Add Rule button, 
or choose Return to go back to the ‘User Defined Associate Charges 
Country and Type Selection’ screen and then either proceed to the 
next application type for the country, choose another country for 
which to edit the fee rules, or choose Return to go back to the 
‘Global IP – Main’ screen. 

Pressing the Return button – before clicking the Update button – 
will return you to the previous screen without saving your changes. 

 Annuities Associate Charges 

The data entry screen for fee rules for Patent and Design annuities is 
almost the same as the screen of Figure 13-5 for the other fee rules. 

The “Sort Order” to the lower right of the screen is replaced with 
boxes for the “From” and “To” years. 

 Editing User-Defined Associate Charges  

Each time a rule is added, the screen listing the rules for the 
country/application type is shown, with the just-added rule included 
in the list. The screen with some rules in the list is shown in Figure 
13-6. 
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Figure 13-6  User Defined Associate Charges List – Advanced Process – 

with Some Rules Defined 

To edit an existing associate charge, highlight the fee rule you wish 
to edit in the ‘User Defined Associate Charges List’ screen and click 
on the Proceed button. This will take you to ‘User Defined 
Associate Charges Detail’ screen. Make any needed changes and, 
when finished, click on the Update button. 

 Deleting User-Defined Associate Charges 

To delete an existing associate charge, highlight the associate charge 
you wish to delete in the ‘User Defined Associate Charges List’ 
screen and click on the Delete Rule button. A warning box alerting 
you that you are deleting the associate charge will appear; if you 
wish to continue with the deletion, choose the Yes option. The 
program will return a message that indicates the row has been 
deleted, and when you press OK, the screen will refresh and the 
associate charge will no longer be part of the list. 
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Examples of User Defined Associate Charges – Advanced 

Process 

For all these examples, first choose a country, application type, and 
the Advanced Process from the ‘User Associate Charges Country 
and Type Selection’ screen and then click Proceed. 

 1)  Flat Fee Amount  

In this example we will assume there is a charge of $500 in the 
Filing stage for processing the application. This is an example 
where a fee amount is always present. This item will thus not 
generate an item for the ‘Enter Application Information’ screen. 

To generate this fee rule: 

•••• Choose Filing from the Stage drop-down box 

•••• Enter a “Fee Description” 

•••• Choose Always present from the first Yes/No Items drop-
down box  

•••• Enter “500” in the “Fixed Amount” field 

•••• Specify the “Sort Order”, and 

•••• Click the Update button. 

 2)  Basic Addition of a Specified Amount – Based on One or 

More Yes/No Item(s) 

There is a charge of $150 in the Filing stage in the event the 
applicant is an assignee and the assignment was filed late. This is 
an example where the fee amount is a specified amount if 
“Yes/No Items” are designated “Yes” on the ‘Enter Application 
Information’ screen. 

To generate this fee rule: 

•••• Choose Filing from the Stage drop-down box 

•••• Enter a “Fee Description” 

•••• Choose Applicant is Assignee from the first Yes/No Items 

drop-down box  
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•••• Choose Late Filing of Assignment from the second Yes/No 

Items drop-down box  

•••• Enter “150” (which represents the additional flat fee 
charged) in the “Fixed Amount” field 

•••• Specify the “Sort Order”, and 

•••• Click the Update button. 

 3) The Fee Amount is Based on Single Numeric Item 

In the Filing stage, there is a fee of $20 per claim. This is an 
example where the fee amount is multiplied by the value entered 
for the item on the ‘Enter Application Information’ screen. 

To generate this fee rule: 

•••• Choose Filing from the Stage drop-down box 

•••• Enter a “Fee Description” 

•••• Choose Number of Claims from the first of the Numeric 

Items drop-down boxes 

•••• Leave the “Fixed Amount” field blank 

•••• Leave the “Plus (User Entered value) over” field blank 

•••• Leave the “up to” field blank 

•••• Enter a value of “20” in the “multiplied by” field, 

•••• Specify the “Sort Order” 

•••• Click the Update button. 

 4) The Fee Amount is Based on Two Numeric Items – 

Adding/Multiplying the Values Before Performing 

Additional Calculations 

In the Filing stage, there is a flat fee of $100 for the first 50 
pages of an application; the per-page charge increases to $5 
above 50 pages. [This creates results similar to the example 
detailed above in the Pre-Defined Templates section.]  
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To generate this fee rule:  

•••• Choose Filing from the Stage drop-down box 

•••• Enter a “Fee Description” 

• Choose Pages in Application (excluding Drawings) from the 
first of the Numeric Items drop-down boxes, 

•••• Choose Pages of Drawings from the second of the Numeric 

Items drop-down boxes 

•••• Leave the Entered values should be radio button option 
specified as Added 

•••• Enter “100” (which represents the flat fee amount) in the 
“Fixed Amount” field 

•••• Enter “50” (which represents the pages above which the per 
page charge will apply) in the “Plus (User Entered value) 
over” field 

•••• Leave the “up to” field blank 

•••• Indicate a value of “5” in the “multiplied by” field 

•••• Specify the “Sort Order” 

•••• Click the Update button. 

 5) The Fees Amount is Based on Numeric Values in Various 

Ranges - Different Fees Depending on Which Range 

Applicable  

In the Granting stage, there is a fee of $250 for between one and 
five claims, $40 per claim for the next five claims, and $25 for 
any additional claims. This situation will require several fee 
rules.  

To generate the first fee rule:  

•••• Choose Granting from the Stage drop-down box 

•••• Enter a “Fee Description” 

•••• Choose Number of Claims from the first of the Numeric 

Items drop-down boxes  
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•••• Enter “250” (which represents the flat fee amount) in the 
“Fixed Amount” field 

•••• Leave the “Plus (User Entered value) over” field blank or 
enter “0” 

•••• Enter “5” in the “up to” field 

•••• Leave the “multiplied by” field blank 

•••• Specify the “Sort Order” 

•••• Click the Update button. 

For the next part of this set of fee rules (in case the number of 
claims is between six and 10): 

•••• Choose Granting from the Stage drop-down box 

•••• Enter a “Fee Description” 

•••• Choose Number of Claims from the first of the Numeric 

Items drop-down boxes 

•••• Enter “250” in the “Fixed Amount” field (this is for the first 
five claims) 

•••• Enter “5” in the “Plus (User Entered value) over” field 

•••• Enter “10” in the “up to” field 

•••• Enter “40” in the “Multiplied by” field 

•••• Specify the “Sort Order” 

•••• Click the Update button. 

For the last part of this set of fee rules (in case the number of 
claims is over 10): 

•••• Choose Granting from the Stage drop-down box 

•••• Enter a “Fee Description” 

•••• Choose Number of Claims from the first of the Numeric 

Items drop-down boxes 

•••• Enter “450” in the “Fixed Amount” field (this is 250 for the 
first five claims plus 200 (5 times 40) for the next five 
claims 

•••• Enter “10” in the “Plus (User Entered value) over” field 
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•••• Enter “999” in the “up to” field (see the discussion below for 
why this is important) 

•••• Enter “25” in the “Multiplied by” field 

•••• Specify the “Sort Order” 

•••• Click the Update button. 

When an “up to” value is present, the “User Entered value” must 
fall within the “…over” and “up to” range for the rule to apply. 
Conversely, if no up to value is present, the “Fixed Amount” 
always applies. 

Suppose, in the final example above, we had left out the “999” in 
the “up to” box. Then if the number of claims was three, both the 
first rule with the flat fee of $250 would be included (since 
number of claims was in the range of zero to five) and the third 
rule would apply. The third rule would include an amount of 
$450, since the rule would be saying only that the fee is $450 
plus $25 for claims over 10. Without the “up to” value, the 
interpretation of the rule is very different! 
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14  Assignment/Modification Module 

Introduction 

The Assignment/Modification Module provides the functionality to run 
estimates for an Assignment or Name/Address Change for Patents, 
Trademarks, and Designs. A single estimate may be obtained for several 
assignments of the same application type (e.g., several Patents) at the 
same time.  

After activating this module, the user should review the In-House Fees 
and Costs associated with assignments and modifications. These In-
House Charges are described in the In-House Charges for 

Assignment/Modification section below. 

Without activating the Module, you can run estimates for Denmark and 
Japan. 

Running an Assignment/Modification Estimate 

From the ‘Global IP – Main’ screen (the initial screen) click the 
appropriate radio button to identify the type of 
Assignment/Modification application desired.  

The ‘Global IP – Main’ screen is shown in Figure 14-1: 
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Figure 14-1  Assignment/Modification Global IP – Main screen 

Once the Assignment/Modification Application Type has been 
selected, click the Proceed Button. 

The process of running the Assignment/Modification estimate is 
similar to running the other types of estimates. Therefore, the screens 
will not be displayed in this section of this chapter. 

The ‘Specify Destination(s) of Application’ screen is presented. 
Select the countries to include in the estimate by clicking on each 
one. Boxes are available to change the In-House Charges set to be 
used and to specify whether to include only Official Fees or only 
Official and Translation Costs. In-House Fees and Costs for an 
Assignment/Modification will be discussed in more detail in the 
following section.  

Once the country selection and any changes to the In-House Charges 
set and fees selection have been completed, click the Proceed 
button. 

Based on the destinations you have selected, the program determines 
the relevant application parameters, and presents the ‘Enter 
Application Information’ screen.  
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In this screen, enter the appropriate amounts into the boxes on the 
left. These parameters will include the number of assignments/ 
modifications to be included in the estimate. The default value for 
these parameters is zero. 

At this point, you have the option of saving the scenario for future 
re-use or reference by clicking the Save Scenario button. A new box 
will appear, allowing you to name the scenario. Scenarios are 
discussed in more detail in Chapter 5, Scenarios.  

Once you have entered the amounts in the application parameters, 
click the Proceed button.  

The estimate is calculated and presented in report form. The first 
report to appear will be the GLOBAL IP ESTIMATOR – Condensed 
Summary.  

You can also choose to view and print the Summary Report and the 
Detail Report.  

From the report screen, you have the option of returning to the 
beginning in order to create additional assignment/modification or 
other application type estimates.  

For further instructions on preparing estimates, please review the 
various chapters devoted to estimating elsewhere within this Guide. 

In-House Charges for Assignment/Modification 

 Introduction 

The In-House Charges Edit Menu item allows you to modify the 
default In-House Charges that are included with the software, as well 
as to create additional sets of In-House Charges for use by different 
individuals using the software, in various scenarios and with 
different clients. 

Please review Chapter 8, Edit Menu, In-House Charges for a general 
description of In-House Charges as well as to learn how to change, 
add, and delete sets of In-House Charges. The following section will 
focus on the specifics of Assignment/Modification In-House 
Charges. 
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 Assignment In-House Charges 

Once a user has chosen the In-House Charges from the Edit Menu 

drop-down list a screen titled ‘Sets of In-House Charges’ will appear. 
This screen has options for choosing Patent, Trademark, or Design 
Assignments (and Name/Address Changes).  

Choose the type of Assignment/Modification application for which 
you wish to modify the In-House fees. Click the Proceed button. For 
instruction purposes we have chosen Patent 
Assignment/Modification, and the following screens and details 
correspond to the fees and costs values for Patents. Similar In-House 
Charges screens and fees and costs are used for Trademarks and 
Designs. 

The screen presented by the Patent Assignment/Modification option 
is shown in Figure 14-2: 

 

Figure 14-2  Patent Assignment In-House Charges screen 

The first column specifies the Category of Charge. The second 
specifies the Stage. The third column gives a description of each 
Type of Charge. The fourth column indicates the Current Charge 

Amount.  
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Charges fall into three main categories: Assignment, Name Change, 
and Address Change. For each kind of charge a fee may be entered 
for the first change, and a different fee for the second and 
subsequent modifications of the same kind.  

There are also miscellaneous costs for each main kind of change 
which may be entered. These apply to each modification of the same 
kind. 

For example, suppose there are five Patents that are to be assigned 
from one entity to another entity in 10 different countries. The fee for 
“In-House Service Charges – first assignment” would apply to the 
first assignment in each of the 10 countries. The fee for “In-House 
Service Charges – assignment after the first” would be multiplied by 
four, and be included in the estimate for each of the 10 countries. 

In this example, the “Miscellaneous In-House Costs per assignment” 
would be multiplied by five, and be included in the estimate for each 
of the 10 countries. 

A similar logic applies to name changes and address changes. 

To modify an amount, click in the box. This will highlight the 
amount. Replace the amount with the new amount. To move from 
one charge box to the next, use the tab key or the up and down arrow 
keys. 

 Completing the Process  

When all the changes have been made, click the Update button. This 
will take you back to the ‘Sets of In-House Charges’ screen. From 
here you can continue to create, modify, or delete sets of In-House 
Charges for any of the Assignment types or other application types. 

Choosing Return will return you to the ‘Sets of In-House Charges’ 
screen without saving your changes. 
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15  Prosecution Module 

Introduction 

The Prosecution Module applies to Patent applications. The module adds 
a Prosecution stage between the Examination and Grant stages. As these 
fees do not typically appear on associates’ fee schedules, the numbers 
used in the estimate are based on surveys of foreign associates. 

Prosecution costs vary widely depending on the application. GLOBAL 
IP ESTIMATOR provides estimates for “straightforward” applications. 
Even these applications may expect to undergo Office Actions in a 
typical process.  

In our survey, we asked foreign associates how many Office Actions 
were to be expected in a straightforward case. This number is in addition 
to filing, examination, publication, and granting. We then calculated an 
average number of Office Actions for each country.  

For each Office Action there are charges for preparing a response (which 
incurs fees for a professional’s time); charges for processing the response 
in the Patent Office; translation costs, if any; and In-House Charges for 
each response. 

In addition, the program uses a Prosecution Cost Multiplier to reflect any 
anticipated difficulty with the application. This multiplicative factor is 
initially set to one, and is an Application Information item entered when 
running the estimate.  

These Prosecution cost items may be further described as follows: 

 Office Actions 

The database contains a number of Office Actions for most 
countries, based on the Associate survey. There is a “default 
number” that applies to countries without a specific number. 

The user may enter a number of Office Actions for any country, 
which will be used in place of the system-defined value. The user 
may also enter a default number of Office Actions. 
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 Preparing a Response to an Office Action 

The Associate charge for preparing a response is not always clearly 
defined in Fee Schedules. The amount that has been entered into the 
database is close to the amount the Associate charges for handling 
the initial application. This approach therefore approximates the 
different levels of costs in each country. This amount (the Associate 
Charge for preparing a response for each Office Action) can also be 
set by the user for any country.  

 Processing a Response to an Office Action 

The Associate Charge and (sometimes) Official Fee for handling 
each office action are often specified in Fee Schedules. These 
amounts are averaged just as other Associate amounts are averaged 
in the database. 

 Translation Costs 

The cost per page for the translation (if any) associated with each 
Office Action is calculated exactly as the translation of the initial 
application itself. The number of pages for each Office Action is an 
Application Information item entered by the user when running an 
estimate. A default number of pages is set in the program, and may 
be changed by the user. 

 In-House Charges 

There are In-House Charges items for Prosecution costs, as discussed 
in the Prosecution In-House Charges section below. 

 Prosecution Cost Multiplier 

This factor simply multiplies the cost for preparing each response. It 
does not affect the processing cost, the translation cost, or the In-
House Charges. 

For users with the Timeline Module, the Prosecution Costs are all 
allocated to the point in time halfway between the month/year 
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calculated for the Examination stage and the month/year calculated 
for the Grant stage. 

Including the Prosecution Cost in the Estimate 

The ‘Country Selection’ screen has a checkbox labeled Exclude 

Prosecution to the lower left of the screen, as shown in Figure 15-1. 
If the Prosecution Module has been purchased and activated, this 
checkbox is available for use. By default, it is not checked. The 
Prosecution stage will be included. To exclude this stage, check the 
box. 

 

Figure 15-1  Country Selection with Prosecution Excluded 

If the Prosecution stage is included, the Application Information 
screen will include one or two additional items. These items are as 
follows: 
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 Number of Translation Pages per Prosecution Action 

The user may change the default value that appears. Setting the 
default value is described in the Changing the Prosecution Settings 
section below. 

 Prosecution Cost Multiplier 

This multiplicative factor is initially always set to one, so that it has 
no effect. Any number entered for this multiplier is used to multiply 
the Associate Charges for preparing a response to each Office 
Action. No other costs in the Prosecution stage are affected. 

Note: The number of Office Actions is not an Application 
Information item. This number varies from country to country, and is 
calculated by the program according to the precedence rules 
discussed in the Precedence Rules section below. 

Changing the Prosecution Settings 

Most of the information used to calculate Prosecution Costs may be 
changed by the user. Once the user has chosen Prosecution Settings 
from the Edit Menu drop-down list, a screen titled ‘Prosecution 
Settings’ will appear. This screen is presented below:  
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Figure 15-2  Prosecution Settings screen 

The top part of this screen includes user settings that apply for all 
countries without specific settings. The country-specific settings are 
entered in the lower part of the screen. 

 User Prosecution Settings Across All Countries 

These items on the top part of the screen are used as follows: 

Number of Patent Prosecution Actions: If the number of 
Office Actions for a particular country is zero both in the User 
Country Setting (described below) and in the system-defined 
data for the country, then this number of Office Actions is used. 
The number replaces the system default shown in brackets next 
to the entry. 

Default Translation Pages Per Action: The Application 
Information screen for an estimate has a field for the number of 
Translation Pages per Office Action. The number that appears by 
default (and may be changed there) is the number entered here, if 
non-zero. If zero, the system default is used. 
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Associate Charge Per Action: The value entered here replaces 
the system-defined value for the Associate Charge for preparing 

each response to an Office Action, if the similar user-defined 
value for the particular country is zero. (See discussion of 
“Precedence Rules” below.) Note that the Associate Charge for 
processing the response to an Office Action is not affected. 

Disclaimer Footnote when Patent Prosecution included: The 
text entered here appears at the bottom of each page of the 
estimate when the Prosecution stage is included. 

This disclaimer is used only if you have the Prosecution Module 
installed and choose to include the Prosecution stage costs in the 
estimate. If you include the Prosecution costs, please use the 
disclaimer found on the “Edit Menu => Report Settings” 
screen. 

 Prosecution Country Specific Settings 

Data for particular countries may be entered in the ‘Prosecution 
Country Specific Settings’ section on the bottom half of the screen.  

To modify the data for a country, first select the country in the 
country list. Once the country is highlighted, you may proceed to 
enter the related data in the boxes to the right.  

The country items are: 

Number of Patent Prosecution Actions: If non-zero, this is the 
value used for the number of Office Actions in the country. The 
non-zero number entered here takes higher precedence than any 
other value.  

Associate Charge per Action: The value entered here replaces 
the system-defined value for the Associate Charge for preparing 

each response to an Office Action. Note that the Associate 
charge for processing the response to an Office Action is not 
affected. 
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Completing the Process  

Once you have made your data modifications to the settings that 
apply to all countries or for your selected country, click the Update 
button. A box will appear stating that the “Country has been 
updated”. Click OK. This latest user-entered data for the country 
modified will now take precedence over any other settings, including 
the system-defined settings for that country.  

You may continue to select countries and modify their Prosecution 
data or click the Return button to return to the ‘Global IP – Main’ 
screen. 

Pressing the Return button – before clicking the Update button – 
will return you to the previous screen without saving your changes. 

Deleting User-Defined Prosecution Data 

To delete the user-defined data for any or all fields and return to the 
system-defined data, select the country that you wish to modify on 
the ‘Prosecution Settings’ screen and replace the user-entered data in 
the specified field with “0”. Once you have made all your changes, 
click the Update button. For every field that has “0” as its value, the 
system-defined data will take precedence. 

Precedence Rules 

There are several database fields that contain information about 
similar Prosecution settings. For example, the “Number of Patent 
Prosecution Actions” may be identified in several ways. The 
program uses the following rules to establish which number to use. 
The “Number of Patent Prosecution Actions” for Germany will be 
used for illustration purposes. 

• If the user has entered a non-zero value for “Number of Patent 
Prosecution Actions” for Germany (in the ‘Prosecution Settings’ 
screen shown above), that value is used. 

• If there is no user-entered value for “Number of Patent 
Prosecution Actions” for Germany, the system-defined value for 
“Number of Patent Prosecution Actions” for Germany will be 
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used. (This value is sent as part of the database every month, and 
may change if we change the database because of additional 
information from foreign associates.) 

• If there is no user-entered value and no system-defined value for 
“Number of Patent Prosecution Actions” for Germany, the user-

entered default value for “Number of Patent Prosecution 
Actions” (if any) will be used, i.e., the non-zero value entered in 
the “User Prosecution Settings Across All Countries” in the top 
part of the ‘Prosecution Settings’ screen as shown in 
Figure 15-2. 

• If there is no user-entered value and no system-defined value for 
“Number of Patent Prosecution Actions” for Germany, and no 
user-entered default value for “Number of Patent Prosecution 
Actions”, then the system-defined default value for “Number of 
Patent Prosecution Actions” will be used. 

 Prosecution In-House Charges 

In-House Charges are the fees and costs associated with the home 
country portion of processing the foreign applications. The “All 
Patents except new PCT, new EPO and EPO Validation” and “New 
PCT Patent Application” application types both have entries for 
prosecution charges. You may wish to alter these entries to reflect 
your charges for these items. For additional information, refer to 
Chapter 8, Edit Menu, In-House Charges. 
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16  Utility Model Module 

Introduction 

The Utility Model Module allows the user to run estimates for Utility 
Model applications. The fees included in the estimates are obtained from 
official sources as well as from associates, following our common 
practices for calculating values for the various steps in Utility Model 
prosecution. 

After activating this module, the user should review the in-house fees 
and costs associated with Utility Model Estimates. These in-house 
charges are described in the In-House Fees and Costs for Utility Model 
Estimates section below. 

Without activating the Module, you can run estimates for Denmark and 
Japan. 

Running a Utility Model Estimate 

Go to the initial screen for GLOBAL IP ESTIMATOR titled ‘Global 
IP – Main’ screen. You will notice that, once you have installed the 
Utility Model Module, the selection button for Utility Models will be 
activated (white). Click the Utility Model radio button. 

The ‘Global IP–Main’ screen is shown in Figure 16-1: 
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Figure 16-1  Utility Model – Main Screen 

Once the Utility Model radio button has been selected, click the 
Proceed button. 

The ‘Specify Destination(s) of Application’ screen is presented. 
Select the countries to include in the estimate by clicking on each 
one. Boxes are available to change the In-House set of charges to be 
used and to specify whether to include only Official Fees or only 
Official and Translation Costs. You can also choose to exclude 
various stages by clicking the buttons provided on the left bottom 
side of the screen. In-House Fees and Costs for Utility Models will 
be discussed in more detail in the following section.  

This screen is shown in Figure 16-2: 



 

GLOBAL IP ESTIMATOR 16-191 

 

Figure 16-2  Utility Model Enter Application Information screen 

Once the country selection and any changes to the In-House Charges 
set, categories and stages to exclude selections have been completed, 
click the Proceed button. 

Based on the destinations you have selected, the program determines 
the relevant application parameters and presents the ‘Enter 
Application Information’ screen.  

This screen is shown in Figure 16-3: 
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Figure 16- 3  Utility Model Enter Application Information screen 

In this screen, enter the appropriate amounts into the boxes on the 
left. You can change the Yes/No options on the right by tabbing or 
clicking on the item and using the space bar to change the value. You 
can also use the arrow keys to navigate between items. 

At this point, you have the option of saving the scenario for future 
re-use or reference by clicking the Save Scenario button. A new box 
will appear, allowing you to name the scenario. Scenarios are 
discussed in more detail in Chapter 5, Scenarios.  

Once you have entered the amounts in the application parameters, 
click the Proceed button.  

The estimate is calculated and presented in report form. The first 
report to appear will be the GLOBAL IP ESTIMATOR – Condensed 
Summary. The screen is presented below: 
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Figure 16-4  Utility Model Global IP Condensed Report screen 

You can also choose to view and print the Summary Report and the 
Detail Report.  

From the report screen, you have the option of returning to the 
beginning in order to create additional Utility Model or other 
application type estimates.  

For further instructions on preparing estimates, please review the 
various sections devoted to estimating elsewhere within this Guide. 

In-House Fees and Costs for Utility Model Estimates 

 Introduction 

The ‘In-House Charges’ Edit Menu item allows you to modify the 
default In-House Charges that are included with the software, as well 
as create additional sets of In-House Charges for use by different 
individuals using the software, in various scenarios, and with 
different clients. 

Please review Chapter 8, Edit Menu, In-House Charges for a general 
description of In-House Charges, as well as to learn how to change, 
add, and delete sets of In-House Charges. The following section will 
focus on the specifics of Utility Model In-House Charges. 
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 Utility Model In-House Charges 

Once a user has chosen the In-House Charges from the Edit Menu 
drop-down list, a screen titled ‘Sets of In-House Charges’ will 
appear. This screen has an option for selecting Utility Models. The 
‘Sets of In-House Charges’ screen is shown below: 

 

Figure 16-5  Utility Model Sets of In-House Charges screen 

Choose Utility Models by clicking on the Utility Model radio 
button. Click the Proceed button. The ‘Utility Model’ screen will 
appear. 

The screen is shown in Figure 16-6: 
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Figure 16-6  Utility Model In-House Charges screen 

The first column specifies the Category of Charge. The second 
column specifies the Stage. The third column gives a description of 
each Type of Charge. The fourth column indicates the current 
Charge Amount.  

To modify an amount, either click or tab into the box. This will 
highlight the amount. Replace the amount with the new amount. To 
move from one Charge box to the next, use the tab key or the up and 
down arrow keys on the keyboard. 

 Completing the Process  

When all the changes have been made, click the Update button. This 
will take you back to the ‘Sets of In-House Charges’ screen. From 
here you can continue to create, modify, or delete sets of In-House 
Charges for Utility Models or other application types.  

Choosing Return will return you to the ‘Sets of In-House Charges’ 
screen without saving your changes. 
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A  Program Installation 

Introduction 

Download and run the installation package from our website. To get 
access to the package, go to: https://www.quantifyip.com/global-ip-
estimator/free-trial.aspx. Once you have downloaded and run the 
package, the Microsoft Windows Installer will begin. Depending on the 
version of Windows being used, a computer restart may be needed 
during the installation. 

The same installation process will be used for either an installation on a 
local / network drive for use on a single computer or an installation in a 
network environment where the program may be used from several 
computers located on the same network. 

 Uninstalling Previous Versions 

Before installing GLOBAL IP ESTIMATOR version 4, any previous 
versions must be uninstalled. You can uninstall it using the 
Add/Remove Programs function in the Windows Control Panel, or 
via the “Uninstall GLOBAL IP ESTIMATOR” item on the Start 
Menu under Global IP Net. There may be more than one entry in the 
Add/Remove programs. You must uninstall all versions of GLOBAL 
IP ESTIMATOR. It is also recommended to delete the Global IP Net 
folder along with the desktop shortcut before you proceed with the 
installation. If you wish to save your existing settings, see below. 

 Saving custom settings 

To save your existing settings (scenarios, in-house values, country-
specific settings), you must first save your gipuser.mdb file.  

For Windows XP users with a standard installation, this file is 
typically located in Program Files\Global IP Net\Global IP 
Estimator\Database. Copy the gipuser.mdb file only to your desktop, 
and after reinstallation, copy this file back to the database location. 
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For Windows Vista/Windows 7 users who run the program as a 
standard user, the gipuser.mdb file will typically be located in 
c:\users\your_username\appdata\local\virtualstore. For Windows 
Vista/Windows 7 users who run the program as an administrator, the 
gipuser.mdb file is typically located in the application folder 
(c:\Program Files\Global IP Net\Global IP Estimator\Database). 

 Installation 

Installation must be performed with full Administrator rights. On 
Windows XP, you must be logged in as an Administrator. On 
Windows Vista or Windows 7, you must right-click on 
‘gip_package.exe’ and choose “Run as Administrator”.  

Installations and upgrades are available in two packages: 

gip_package.exe - will perform an initial setup on a new machine. It 
will also perform an update if the GLOBAL IP ESTIMATOR 
has already been installed on that machine. 

gip_update.exe - is a “patch” package. It will perform an upgrade for 
an existing GLOBAL IP ESTIMATOR installation. The 
advantage of using the patch package is that it is a much smaller 
file to download than full gip_setup.exe. 

After the Windows Installer welcome screen for the GLOBAL IP 

ESTIMATOR, the End-User License Agreement (EULA) screen 
will appear. 

If you agree to the License Terms, select the appropriate checkbox, 
and proceed to select the program destination folder. The default 
folder displayed installs the program in the Program Files folder, and 
would typically be left unchanged (e.g., Figure A-1). Click Next, and 
then Install to begin the installation. 
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Figure A-1  Global IP Estimator InstallShield Wizard screen 

When the installation is completed, a GLOBAL IP ESTIMATOR 

program icon will be added to the Windows desktop.  

When the program is used for the first time, a license screen will 
appear with an option to choose to use a Free Version or to install a 
Full License. Further license installation is described in Appendix B, 

License Installation. The first time, the splash screen may stay 
onscreen for a while. During this period, the GLOBAL IP 
ESTIMATOR is performing some initial setup.  

You can now configure the program for a single-machine installation 
or a network installation, as described below. To begin the 
configuration, you must run GLOBAL IP ESTIMATOR as an 
administrator. On Windows XP you must be logged in as an 
Administrator. On Windows Vista or Windows 7, you must right-
click the GLOBAL IP ESTIMATOR icon and choose “Run as 
Administrator”. 

Full Install on Single Machine 

Download / Run (as Administrator) gip_package.exe 

Run (as Administrator) GLOBAL IP ESTIMATOR for the first time. 

When prompted to connect to a database, just click on the check box 
to indicate that you want local databases. (GLOBAL IP 
ESTIMATOR will then copy databases from the Database Install 
Folder into the normal Database Folder, and shut down). 
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GLOBAL IP ESTIMATOR is now ready to be run by the Standard 
User. 

Network Setups 

Software is always installed on every machine in a network. 
Consequently, there are multiple clients accessing a shared database 
on a network folder. This is a direct result of supporting the 
Windows Installer which has trouble installing / repairing / updating 
across a network. Each client machine will therefore have to be 
installed / updated separately. 

 Create a Network Install 

• Set up a network shared drive for database files.  

• On a client machine, do a Full Install as described above. 

• Run (as Administrator) GLOBAL IP ESTIMATOR and Move 
Databases to the network shared drive. To do this, select the 
“File” menu, then “Admin Options”. 

• GLOBAL IP ESTIMATOR is now ready to be run by the 
Standard User. 

 Add a Client Machine to a Network Install 

• Download / Run (as Administrator) gip_package.exe 

• Run (as Administrator) GLOBAL IP ESTIMATOR for the first 
time. 

• When prompted to connect to a database, enter network shared 
drive. 

• GLOBAL IP ESTIMATOR is now ready to be run by the 
Standard User. 

 Running the Program with Data stored on a Network Server 

If you want to share GLOBAL IP ESTIMATOR data on a network 
server, follow the instructions for the Full Install above (to install 
each user on their local machine). Then, at each of those computers, 
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start the program, and point to the location of the GLOBAL IP 

ESTIMATOR Database folder that is stored on the server. 

Uninstall 

Once the install has been completed, 1it may be uninstalled from the 
Windows Start Menu. Choose Programs | Global IP Net | Uninstall 
Estimator. 

The GLOBAL IP ESTIMATOR may also be uninstalled through the 
Windows Control Panel | Add/Remove Programs. 

 

                                                      

1 The client is responsible for periodic backups. Quantify IP assumes no 
responsibility for lost data. 
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B  License Installation 

Introduction 

GLOBAL IP ESTIMATOR requires an active license for each computer 
given access to the program. Each active license is identified via a 
unique Registration ID, which is associated with a particular computer. 
The hardware installed on the computer is used as part of the 
identification process. 

The Registration ID is allocated to a computer when the program is first 
used at the computer and must be sent to Quantify IP for processing. 
Registration information can be automatically sent via the Internet, or via 
email. If you are emailing it, it is suggested that you open an email 
program, if available, and leave it open and minimized before continuing 
with the registration process. 

License Installation on the First Local / Network Computer  

When GLOBAL IP ESTIMATOR is used for the first time, the 
following screen (Figure B-1) will appear to allow you to specify 
where you want to store your Estimator data. Choose the “Install a 
New Database to the following location:…”, or if you prefer another 
location such as a server, you may specify an alternate database 
location by selecting the “Connect to an Existing Database at the 
following location”. If you need to change the database location 
later, go to the main menu on the initial screen, and click File | 

Admin Options. (Contact your IT administrator or Quantify IP for 
more information.) After saving, restart the program to begin using 
the databases. 

 

B-202 GLOBAL IP ESTIMATOR 

 

Figure B-1  Connect to Database screen 

 License Options  

Next, a License Options screen will appear (Figure B-2) with an 
option to register a purchased license or to use the Free Version.  

 

Figure B-2  License Options screen 
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 Free Version 

Selecting the 'Continue Using Free Version' radio button bypasses 
the registration process, and allows the user to use the Free Version 
program. The Free Version enables the same program estimating 
features as the Full Version, except that the user is restricted to 
estimates for Denmark and Japan only.  

 Licensee Information 

Prior to installing a license for the computer, the user must have 
purchased a license. As part of the license purchase process, an 
Activation Password is provided for each program option being 
purchased. These passwords will be requested in a subsequent 
screen. If the Activation Password is known, choose the 'Install a 

new license for this computer' radio button (Figure B-2). 

The Licensee Information screen is presented next (Figure B-3). 

  

Figure B-3  Licensee Information screen  
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Please enter the Licensee Information as accurately as possible. This 
information is sent to Quantify IP as part of the registration process 
and is used to match the Licensee Information given at the time of 
purchasing the license. It is also used to minimize any 
communication issues when troubleshooting problems. This 
information is kept strictly confidential. 

You can now click PROCEED to open the License Activation 
screen. 

 

Figure B-4  License Activation screen 

The “Computer Name” in this screen is automatically set to the 
network name of the computer, if any. The name may be changed in 
this screen, if another name will describe the computer better. The 
“Computer Location” field is used to further identify the computer. 
These items are sent to Quantify IP as part of the registration 
process. If a substitute Registration ID needs to be generated in the 
future (in case of computer failure, for example), these items will 
help to identify which Registration ID is being discontinued. 

Enter the Activation Passwords for the modules purchased. 
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Typically, either the Full Version or a Trial Version has been 
purchased, and one of these passwords will always be entered. 

With the Full Version, additional modules may have been purchased. 
These passwords may also be entered in the appropriate field. 

 Registration 

After clicking PROCEED, the Send Registration screen (Figure 
B-4) appears with the options available for submitting the 
registration. GLOBAL IP ESTIMATOR requires an active license 
for each set of databases. A Database ID is allocated to a set of 
databases when the program is first used at the company and must be 
sent to Quantify IP for processing. Registration information can be 
automatically sent via the Internet, or sent via email. If you are 
emailing it, it is suggested that you open an email program first, if 
available, before continuing with the registration process. If a 
substitute Database ID needs to be generated in the future (in case of 
computer failure, for example), these items will help to identify 
which Database ID is being discontinued. 

Your registration information needs to be sent to Quantify IP. This 
will reduce program authorization issues in the future. 

 

Figure B-4  Send Registration screen. 
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The next Monthly Update will contain the validated Registration ID 
and the date that the license expires. The program will then no longer 
consider the license a temporary license. 

After completion of the Activate License process, program use is 
enabled and the main GLOBAL IP ESTIMATOR program screen 
will be displayed. 

License Installation for a Network Client 

After the main license has been installed, if more than one license 
was purchased, the licensing process recognizes that additional 
licenses are available. The screen presented when installing an 
additional license is shown in Figure B-5: 

 

Figure B-5  GLOBAL IP ESTIMATOR – Additional License screen 

Enter the computer identification requested, and click Proceed. 

The next screen will be the same as shown in Figure B-4, the Send 
Registration screen. Your registration information is sent to Quantify 
IP via the Internet, via email or can be faxed by the user, as 
described in the previous section.  

 Moving a License for a Network Client 

If a license needs to be moved from one computer to another, choose 
the Move option from the ‘License Options’ screen presented when 
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starting the program at the computer where the license is to be 
installed. See Figure B-6:  

  

Figure B-6  GLOBAL IP ESTIMATOR – License Options screen 

This option will present a screen with existing licenses. Choose the 
license to be allocated to this computer. The ‘Computer Information’ 
screen of Figure B-4 will be presented. Enter the requested 
information and email or print/fax the new registration. 

 Registering Later 

If the user opts to print the Registration Form and then, for some 
reason, does not send it to Quantify IP, the Registration Form may be 
printed at any time from the program, via the Licensing Menu 
Register License item. However, the new license will expire in 
approximately 45 days, and will require action for reinstatement. For 
more information, please see Chapter 10, Licensing Menu. 
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C  Initial Configuration of Data 

The following settings and items should be reviewed prior to intial 
use, as you may wish to customize them to reflect your individual 
business practices: 

•••• In-House Charges: These are the fees and costs associated with 
the home country portion of processing the foreign application, 
and reflect the fees and costs of sending the information to the 
foreign associates and handling responses. In-House charges are 
entered in “sets”; the default set installed with GLOBAL IP 
ESTIMATOR is in the currency of registration of the license. 
However, for a user within a company instead of a law firm, it 
may be appropriate to set the In-House Charges to zero (which 
can also be accomplished by checking the box labeled Exclude 

In-House/Misc on the ‘Specify Destination(s) of Application’ 
screen; see Excluding Stages, in Chapter 2, Country Selection.) 

In a law firm, you may wish to create a set of In-House Charges 
for the various levels of associates, i.e., one set of charges for 
partners, and another set of charges for associates. Please review 
Chapter 8, Edit Menu, In-House Charges for additional detail 
about changing these fees. 

Please print out the values for the In-House Charges using the 
Reports Menu at the top of the initial GLOBAL IP 
ESTIMATOR screen before making any adjustments to the 
values. Select the View/Print In-House Charges Menu option. 
A sample set of In-House Charges is shown on the next page. 

•••• Currency Used for Estimate Reports: The default currency is 
based on the country of registration of the Licensee. To change 
this setting: 

•••• Go to the Edit Menu, In-House Charges 

•••• Change the country in the “In-House Charges In Currency of” 
field. 

Changing this setting will also automatically convert the In-
House Charges to the currency selected. The converted values 
may need to be reviewed for rounding the amounts. 
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•••• Currency Used for In-House Charges: The currency used for 
In-House Charges is the same as the currency used for the 
estimate reports. See the previous section, Currency Used for 

Estimate Reports. 

•••• Translation Settings: Translation costs can be modified in 
many ways, from changing the default number of words per page 
and reusing translations done for one country in another country. 
Translation costs can also be set for individual languages, and 
the user may wish to make certain that the estimates run for a 
specific country do not include translation costs. Countries set as 
home countries are automatically adjusted by GLOBAL IP 
ESTIMATOR to have no translation costs, but the user can also 
set translation costs for other languages to zero. Additional 
information about Translation Settings is available in Chapter 8, 

Edit Menu, Home Country Charges, and Chapter 8, Edit Menu, 

Translation Settings. 

•••• Home Country Estimates: The Associate’s Charges provided 
for Home Country estimates will also need review. Use the 
Home Country feature described in Chapter 8, Edit Menu, Home 

Country Charges to enter appropriate In-House Charges. 

•••• Report Settings: The user may also wish to customize the 
Report Settings available for the reports. Additional information 
about changing the Report Settings is in Chapter 8, Edit Menu, 

Report Settings. 

EPO Attorneys 

Additional functionality has been added for attorneys who file 
applications directly to the EPO. For an overview of the settings 
affected by these changes, please review Chapter 8, Edit Menu, 

Home Country Charges.  

Users in Corporate Legal Departments 

The concept of In-House Charges will have a different meaning for 
users who are not in a law firm that charges clients or other 
departments for the processing of foreign applications. 
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These users may want to set the In-House Charges to zero. Please 
review Chapter 8, Edit Menu, In-House Charges, for instructions on 
changing the In-House Charges to zero. 

Estimates may also be run with the Exclude In-House/Misc 
checkbox marked. See Chapter 2, Country Selection, Excluding 

Categories of Costs for additional information. 
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D  System Administrator Notes 

Ensuring Uniform User Settings in a Multi-User Environment 

All user settings are kept in the file named “gipuser.mdb” in the 
Application Folder/Database Folder. 

If the program is installed on several computers and the same 
settings for user-defined data are required on all of them, one way to 
ensure this is to have the main “gipuser.mdb” file on one computer, 
and copy this file to other computers whenever a data change is 
made. 

If the program is re-installed, user settings may be retained by saving 
the “gipuser.mdb” file and copying it into the Application folder 
after re-installation. 

In a network environment, in which all users share the databases in 
the Application Folder, all users will automatically use the same 
values. 

Note: Do not copy the “gipuser2.mdb” file between computers. This 
file contains licensing data particular to the computer(s) being 
licensed. The incorrect file will cause unpredictable problems. 

Uninstall 

Always create a back up copy of your Database folder prior to 
uninstalling. As there are a number of pieces that need to be aligned, 
please contact Quantify IP customer support prior to attempting an 
uninstall/re-install.  

 How to uninstall 

From the Windows Start Menu (or icon), go to all Programs | Global 
IP Net | Uninstall Estimator. 

The GLOBAL IP ESTIMATOR may also be uninstalled through the 
Windows Control Panel, Add/Remove Programs. There may be 
more than one entry in the Add/Remove programs. You must 
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uninstall all versions of GLOBAL IP ESTIMATOR. It is also 
recommended to delete the Global IP Net folder along with the 
desktop shortcut before you proceed with the installation.  

Initial Installation Folders/Files 

 Application Folder 

This folder contains files relating to the Application. 

Default location: 

 32-bit PCs: C:\Program Files\Global IP Net\Global IP Estimator 
 64-bit PCs: C:\Program Files (x86)\Global IP Net\Global IP 

Estimator 

 Application Files 

The following Application files are installed during the initial 
installation process.  

 Installation Path: 

Application Folder specified during installation.  
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 Files: 

GlobalIP.exe Application exe 
gip4.ini The gip4.ini is updated using 

File Menu | Admin Options. 
Demo.exe 
\Demo\MadridDemo.exe 
\Demo\MenuDemo.exe 
\Demo\PatentDemo.exe 
\Demo\TrademarkDemo.exe 
\dlls The \dlls folder contains 

redistributables necessary for 
the Estimator.  

\images  

 DLLs 

Installation Path: 

Application Folder specified during installation/Dlls 

Files: 

cpeaut32.dll 
craxddrt.dll 
craxdrt.dll 
Crpaig80.dll 
crpe32.dll 
crtslv.dll 
crviewer.dll 
crviewer.oca 
crxf_rtf.dll 

ExportModeller.dll 
P2smon.dll 
pg32conv.dll 
sscsdk80.dll 
u2dapp.dll 
u2ddisk.dll 
u2fwordw.dll 
u2fxls.dll 

 Images 

Installation Path: 

Application Folder specified during installation/Images 

 Files: 

Various .gif/.jpg/.bmp/.ico files used by program 
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 Common User Folder 

In a network environment, all users share the databases in the 
Database folder. (The Database folder location is specified 
during the initial run of the program.)   

 Installation Path: 

XP: C:\Documents and Settings\All 
Users\Documents\Global IP Net 
Common\Estimator  

Vista/W7: C:\Users\Public\Documents\Global IP Net 
Common\Estimator 

 Files:  

\Database 
Getting Started Chapters of User's Guide.pdf 
gip.sys 
Global IP Estimator User's Guide.pdf 
GlobalIP.chm 
GlobalIP.chm Note: The Help files are local to 

each machine  
Major Changes.pdf 
\Updates 
Whats New.rtf 

 Temp Database Folder 

These database files are saved, as part of the installation, to a path 
under Common User Folder. When the program is run for the first 
time, the user may select to use these default databases. If so, the 
databases installed here (labeled “Database Install – Estimator”) are 
copied to “Global IP Net Common\Estimator\Database”. 
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 Installation Path for Default database files: 

XP: C:\Documents and Settings\All 
Users\Documents\Global IP Net 
Common\Database Install - Estimator 

Vista/W7: C:\Users\Public\Documents\Global IP Net 
Common\Database Install - Estimator 

 Files:  

gipdata.mdb 
gipuser.mdb 
gipuser2.mdb 
gipuser3.mdb 
gipuser3_base.mdb 
gipuser_base.mdb 
gipuser_base_AT.mdb 
gipuser_base_AU.mdb 
gipuser_base_BE.mdb 
gipuser_base_CH.mdb 
gipuser_base_DE.mdb 
gipuser_base_DK.mdb 
gipuser_base_ES.mdb 
gipuser_base_FI.mdb 
gipuser_base_FR.mdb 
gipuser_base_GB.mdb 
gipuser_base_GR.mdb 
gipuser_base_IE.mdb 
gipuser_base_IT.mdb 
gipuser_base_LU.mdb 
gipuser_base_NL.mdb 
gipuser_base_NO.mdb 
gipuser_base_PT.mdb 
gipuser_base_SE.mdb 
gipuser_base_US.mdb 
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System Files that are part of Supplementary Standard Windows 

Modules installed: 

 Installation Path: 

32-bit PCs: “[path to windows]\SysWOW64\” (e.g. 
C:\Windows\system32\) 

64-bit PCs: “[path to windows]\System32\” (e.g. 
C:\Windows\SysWOW64\)  

 Files: 

MSXML 3.0 
Microsoft OLE 2.40 for Windov4s NT and Windows 95 
Microsoft C Runtime Library 6.0 
Microsoft C++ Runtime Library 6.0 
Microsoft Visual Basic Virtual Machine 6.0 
Microsoft Data Formatting Object Library 6.0 
Microsoft Masked Edit Control 6.0 
Microsoft MAPI Controls 6.0 
Microsoft Internet Transfer Control 6.0 
Microsoft Hierarchical FlexGrid Control 6.0 
Microsoft DataGrid Control 6.0 
Microsoft Windows Common Controls (6.0) 
Microsoft Data Binding Collection VB 6.0 
ADO Data Control 6.0 
MFC 6.0 
Microsoft Common Dialog Control 6.0 
Microsoft Component Category Manager Library 
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 Shortcuts 

[Desktop]/Global IP Estimator 

[TaskBar][Start Menu][Programs Menu]/Global IP Net/ 
Estimator Demo 

[TaskBar][Start Menu][Programs Menu]/Global IP Net/ 
Estimator User's Guide 

[TaskBar][Start Menu][Programs Menu]/Global IP Net/ 
Estimator 

[TaskBar][Start Menu][Programs Menu]/Global IP Net/ 
Uninstall Estimator 

 Registry 

Items Added to Registry during the Install: 

[HKLM\Software\Global IP Net\Global IP Estimator\ 
V4_Installer] 

The GLOBAL IP ESTIMATOR also uses the system registry to 
save various user settings. These settings are stored under: 

[HKEY_CURRENT_USER]/[SOFTWARE]/Global IP Net/ 
Global IP Estimator 

 Files Installed During a Maintenance Upgrade 

Any of the files initially installed may be updated during a 
maintenance upgrade. There are two types of updates that may occur. 
These updates are for: 

Cost data maintenance (e.g., exchange rates and fees) and 

Upgrades to the software 
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E  System Requirements 

Introduction 

The GLOBAL IP ESTIMATOR installation package can be downloaded 
from our website. To access the package, go to: 
http://www.globalip.com/downloads/downloads.asp. Once you have 
downloaded and run the package, the Microsoft Windows Installer will 
begin. Depending on the version of Windows being used, a computer 
restart may be needed during the installation. For installation 
instructions, refer to the “Program Installation” portion of this document. 

Hardware Requirements 

Initially, GLOBAL IP ESTIMATOR uses only 50 Megabytes of 
hard disk space. This size increases with the monthly updates and 
with database backups stored in the application folders. It is therefore 
recommended that there be a minimum of 1 gigabyte of available 
disk space on the drive letter where the application is installed. 
Additionally, for a smooth program operation, a minimum of 512 
megabytes of RAM is needed. 

Internet Connectivity 

Certain program features (program registration, sending reports via 
email, automatic updates) use the Internet connection. In order for 
these features to work, a computer must have a network card and a 
valid Internet connection configured. If your network uses proxy, an 
additional program configuration may have to be performed. 

Software Requirements 

GLOBAL IP ESTIMATOR program runs as a stand-alone 
application and requires a version of Microsoft Windows. The 
following versions are supported: Windows XP, NT or Windows 
2000, Windows Vista, Windows 7 32bit and 64bit, Windows 8 32bit 
and 64bit. 
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Some of the reports are created in Excel. Therefore, in order to see 
these reports; a version of Microsoft Excel must be installed on the 
computer running the program. For a smooth operation: 

Set the Macro Security Level to “Low”, 

Check the “Trust VB” (or Trust VBA) option, and 

Set the “default Number of sheets in a new workbook” to at least 
“3”. 

User Permissions 

The GLOBAL IP ESTIMATOR requires read and write access rights 
to folders storing database files, user reports and the \Updates folder. 
Additionally, if the program is configured to access database files 
over the network, proper read and write permissions to the network 
share are needed. 

For a list of paths used on different versions of Windows, refer to the 
“System Administrator Notes” part of this help document. 
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F  End User License Agreement 

By purchasing this GLOBAL IP ESTIMATOR software product OR 
exercising your rights to make and use copies of the SOFTWARE (as 
may be provided for below), you agree to be bound by the terms of this 
agreement. If you do not agree to the terms stated in this document, 
promptly return this SOFTWARE.  

SOFTWARE LICENSE 

GRANT OF LICENSE. 

Quantify IP grants you the right to use the GLOBAL IP 
ESTIMATOR software product (the SOFTWARE) on a single 
computer, and for a limited period of time (see Duration of License 
below). The SOFTWARE is considered to be in use on a computer 
when it is loaded into temporary memory or installed into permanent 
memory of the computer. For program use on a CITRIX Server (or 
other “thin-client” use), the license is granted to a single user, and 
the Server setup must restrict access to the SOFTWARE to that user 
only. 

MULTIPLE LICENSES. 

Each physical location of each Licensee Company must have a 
MAIN License.  

The availability of (lower-priced) additional licenses is restricted 

as follows: 

1. Each additional license must be for the same company/business 
entity as purchased the main license. 

2. Each additional license must be for a computer at the same 

physical location (i.e. street address) as the computer on 

which the main license is installed.  

3. Every computer on which the SOFTWARE is installed must 
have its own license.  For CITRIX Server (“thin-client”) use, 
each user given access to the SOFTWARE must have a separate 
license. 
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4. In a network installation, the program may be placed on a 
network server. However, items 1 to 3 above still apply, in that 
any computer (or user for CITRIX Server (“thin-client”) use) 
given access to the program (via a Windows desktop icon, or 
other means) needs to have its own license. (Please note that this 
licensing agreement is not the same as the more common 
“concurrent user” software license.) Additional licenses must be 
for the same company, and be at the same address as the main 
license. If different addresses are involved, then each address 
must have its own main (and additional) license(s) for the 
computer(s) accessing the network server for the program and/or 
maintenance updates.  

COPYRIGHT. 

The SOFTWARE is owned by Quantify IP or its suppliers and is 
protected by United States copyright laws and international treaty 
provisions. Therefore, you must treat the SOFTWARE like any other 
copyrighted material except that you may either (a) make one copy 
of the SOFTWARE solely for backup or archival purposes, or (b) 
transfer the SOFTWARE to a single hard disk. You may not copy 
the written materials accompanying the SOFTWARE. 

OTHER RESTRICTIONS. 

You may not rent or lease the SOFTWARE, but may transfer the 
SOFTWARE and accompanying written material on a permanent 
basis provided you retain no copies and the recipient agrees to the 
terms of this agreement. You may not reverse engineer, decompile, 
or disassemble the SOFTWARE. You may not rent, lease or sell data 
from the program, or program reports. 

DURATION OF LICENSE. 

The license is for a limited period of time, until an expiration date 
built into the SOFTWARE. The expiration date is determined by the 
length of your maintenance contract with Quantify IP. 

CAPABILITIES OF SOFTWARE. 

You acknowledge that you understand that the data used in the 
SOFTWARE to generate estimates are averages based on minimum 
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fee schedules and other communications from IP practitioners. The 
estimates generated provide for the basic processing of straight-
forward applications. They do not include charges for responses to 
office actions, arguments and other work. You acknowledge that you 
understand that it is possible for the actual costs incurred in the 
processing of IP applications to differ significantly from the costs 
reported by the SOFTWARE. 

LIMITED WARRANTY. 

This program, instruction manual, and reference materials are sold 
“as is”, without warranty as to their performance, merchantability, or 
fitness for any particular purpose. The entire risk as to the results and 
performance of this program is assumed by the purchaser. However, 
to the original purchaser only, the publisher warrants the magnetic 
media on which the program is recorded to be free from defects in 
materials and faulty workmanship under normal use for a period of 
ninety days from the date of purchase. If, during this ninety-day 
period, the media should become defective, it may be returned to the 
publisher for a replacement without charge, provided proof of 
purchase of the program accompanies the return. Your sole and 
exclusive remedy in the event of a defect is expressly limited to 
replacement of the media as provided above. If failure of the media 
has resulted from accident or abuse the publisher shall have no 
responsibility to replace the media under terms of this warranty. Any 
implied warranties relating to this product, including any implied 
warranties of merchantability and fitness for a particular purpose, are 
limited to a period of ninety days from date of purchase. Publisher 
shall not be liable for indirect, special, or consequential damages 
resulting from the use of this product. Some states do not allow the 
exclusion or limitation of incidental or consequential damages, so the 
above limitations might not apply to you. This warranty gives you 
specific legal rights, and you may also have other rights which vary 
from state to state. 

PRIVACY POLICY. 

To ensure that the GLOBAL IP ESTIMATOR is properly licensed 
and to enable all required features / program modules, we ask that 
you activate it by following the License Registration process and 
submitting a License Registration Form. 
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During the program activation, when installing updates, whenever 
licensing errors occur, or during a typical program use, we may 
collect basic information about the current license and technical 
details identifying your computer such as an IP address, a MAC 
address, or a computer name. 

Quantify IP uses this information to ensure license compliance, to 
activate various features, to provide technical support, critical 
updates and notifications regarding the software, to improve software 
quality and user experience, and to develop new products and 
services. The information collected this way is encrypted and sent 
via a secure protocol to Quantify IP’s licensing server. Quantify IP 
does not share this information with any third party. 
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G  Item Definitions for Application 
Information Screen 

Patents 

These are frequently referred to as Patents, Invention Patents, or 
Patents of Invention. 

 Numeric Items 

Pages in Application (excluding Drawings): The number of pages 
in the application, but not including the pages of drawings. These are 
typically, but not always, the pages of text which may need 
translation. (Note that you specify the number of pages needing 
translation separately in the Pages for Translation item.) 

Pages of Claims: The number of pages in the application that 
contain the claims.  

Pages of Drawings: The number of pages in the application that 
contain drawings. 

Pages for Translation excluding Claims: The number of pages in 
the application (exluding claims) that need translation. 

Pages for Translation: The number of pages in the application that 
need translation. 

Pages Priority App Differences for Transl: For this item you 
should enter only the number of pages in the priority application that 
are different from the country application. This option is available 
because some countries require that the application used for claiming 
priority be translated, but the priority document may largely 
duplicate the country application which has already been translated. 
If the country application is essentially identical to the application 
used to claim priority, then leave this item as zero. 

Pages in Applic (excl. Claims, incl. Dwgs): The number of pages in 
the application (excluding pages of claims, but including drawings). 

 

G-226 GLOBAL IP ESTIMATOR 

Pages in PCT Application Request Form: The number of pages in 
the request form that accompanies the initial PCT application. This 
number is typically five or six. 

Number of Claims: The number of claims in the application. 

Number of Claims for Japan: The number of claims used for the 
Japanese application for the examination, granting, and annuity 
stages. This allows for the fact that applications to Japan are 
sometimes modified to reduce the number of claims, since the 
Japanese charges for these stages increase with the number of claims. 

Number of Claims for EPO: The separate entry for the number of 
claims used for the European Patent application allows for the fact 
that the application to the EPO may be modified to reduce the 
number of claims, so as to reduce the official fees. 

Number of Independent Claims: The number of independent 
claims in the application. 

No. of U.S. Claims used for Mult Dependency: If any number of 
multiple dependent claims is present, there is a single surcharge at 
the current fee amount. This “Number of U.S. Claims used for Mult 
Dependency” add to the “Number of Claims”, and the total is used 
for the excess claims (over 20) calculation for U.S. estimates. 

Number of Convention Priorities: The number of earlier 
applications which are being used to claim priority for the current 
one.  

Number of Designations for EPO: The number of countries 
designated in the EPO application. 

Number of Designations for ARIPO: The number of countries 
designated in the ARIPO application. 

Number of Extensions for EPO: The number of extension 
countries (Albania, Bosnia and Herzegovina, etc.) designated in the 
EPO application. 

Number of Designations for EA: The number of countries 
designated in the EA application. 
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Number of Documents for Legalization: This represents the 
number of documents which must be legalized. 

Number of Translation Pages per Prosecution Action: The cost 
per page for the translation (if any) associated with each Office 
Action is calculated exactly as the translation of the initial 
application itself. A default number of pages is set in the program, 
and may be changed by the user. Additional information about 
prosecution costs can be found in Chapter 15, Prosecution Module. 

Prosecution Cost Multiplier: This factor simply multiplies the cost 
for preparing each response. Additional information about 
prosecution costs can be found in Chapter 15, Prosecution Module. 

 Yes/No Items 

PCT Chapter II filed: If “Yes” is selected, this indicates that the 
PCT Chapter II request has been or will be filed prior to the 
application’s entry to the national process. 

Applicant is Assignee: If “Yes” is selected, this indicates that the 
application is being made by the assignee. 

Late Filing of Assignment: If “Yes” is selected, this indicates that 
the Assignment (if required) will be filed late. 

Late Filing of Priority Documents: If “Yes” is selected, this 
indicates that Priority documents (if required) will be filed late. 

Late Filing of Power of Attorney: If “Yes” is selected, this 
indicates that the Power of Attorney (if required) will be filed late. 

Translation Extension: If “Yes” is selected, this indicates that the 
time extension to file the translation for the national phase of the 
PCT applications will be requested. The estimate then contains the 
associated fees.  

EP Designation Fee in Exam stage: The designation fees associated 
with an EPO application may be paid at the examination stage. If 
“Yes” is selected, the estimate allocates these fees to the examination 
stage instead of the filing stage. 
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EP Examination with Filing: The examination charges associated 
with an EPO application may be paid at the filing stage. If “Yes” is 
selected, the estimate allocates these fees to the filing stage, instead 
of the examination stage. 

Filer is Large Entity - CA: If “Yes” is selected, this indicates that 
the filer meets the Large Entity requirements for Canada. 

Filer is Large Entity - US: If “Yes” is selected, this indicates that 
the filer meets the Large Entity requirements for the United States. 

Filer is a Large Entity: If “Yes” is selected, this indicates that the 
application is being filed by a large entity. In this case, the lower fees 
that may be available for a small entity are not used in the estimate. 

Filer is US Microentity: If “Yes” is selected, this indicates that the 
filer meets the Microentity requirements for the United States. 

Applicant is an Individual: If “Yes” is selected, this indicates that 
the application is being filed by an individual. 

Application Sent by Facsimile: If “Yes” is selected, this indicates 
the application is being sent by facsimile. The associated In-House 
charges are then added to the estimate. 

Courier Used: If “Yes” is selected, this indicates that a courier is 
being used with the application. The associated In-House charges are 
then added to the estimate. 

Order PCT Formal Drawings: If “Yes” is selected, this indicates 
that PCT formal drawings will be ordered. The program will then 
add the associated In-House charges to the PCT estimate. 

US Request for Prioritized Examination: If “Yes” is selected, the 
application will use the appropriate charge for a prioritized 
examination in the U.S. 

U.S. Provisional to PCT: If “Yes” is selected, this indicates that this 
is a U.S. provisional application being converted to a PCT 
application. The program will then add the associated In-House 
charges to the PCT estimate.  

PCT App Priority Document: If “Yes” is selected, the PCT 
application has a Priority Document. 
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PCT Request NOT Character-Coded: If “Yes” is selected, this 
indicates that the international application is filed on paper together 
with a copy in electronic form, in character coded format (i.e., PDF, 
TIFF, or XML), of the request and abstract; or if the international 
application is filed in electronic form, the request not being in 
character coded format. This corresponds with the e-filing reduction 
labeled CHF 100 on Table 1(a) of the PCT Fee Tables, issued 
monthly by WIPO. 

PCT App Electronic, Request Character-Coded: If “Yes” is 
selected, this indicates that the international application is filed in 
electronic form, the request being in character coded format (i.e., 
PDF, TIFF, or XML). This corresponds with the e-filing reduction 
labeled CHF 200 on Table 1(a) of the PCT Fee Tables, issued 
monthly by WIPO. 

PCT App Fully Electronic, All Character-Coded: If “Yes” is 
selected, this indicates that the international application is filed in 
electronic form, the request, description, claims and abstract being in 
character coded format (i.e., PDF, TIFF, or XML). This corresponds 
with the e-filing reduction labeled CHF 300 on Table 1(a) of the 
PCT Fee Tables, issued monthly by WIPO. 

PCT Supplementary Search Requested: If “Yes” is selected, the 
PCT Supplementary Search is requested. 

Application Filed Electronically: If “Yes” is selected, this indicates 
that the application is filed electronically. Some countries offer fee 
reductions to official charges with this option. 

JP applic filed after April 1, 2004: The official fees associated with 
filing an application in Japan changed on April 1, 2004. A “Yes” 
answer to this question will use those fees.  

JP exam request after April 1, 2004: The official fees associated 
with requesting an examination in Japan changed on April 1, 2004. A 
“Yes” answer to this question will use those fees.  

TW applic filed after January 2, 2010: The official fees associated 
with requesting an examination in Taiwan depend on whether filing 
date is after January 1, 2010. A “Yes” answer to this question will 
use those fees. 
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SG application filed after July 1, 2004: The official fees associated 
with filing an application in Singapore changed on July 1, 2004. A 
“Yes” answer to this question will use those fees.  

SG – Use PCT Search Report: The official fees associated with 
granting of an application in Singapore depend on whether Filing 
date is after July 1, 2004. A “Yes” answer to this questions will use 
those fees.  

Applicant is Inventor: If “Yes” is selected, this indicates that the 
application is being filed by the inventor. 

SE – Voluntary International Type Search: If “YES” is selected, 
the official fees for an International-Type Search will be added. 

Lic of Right (AL,DE,ES,FR,GB,LT,MW,SK): If “Yes” is selected, 
this indicates that the appropriate discount for the annuities for 
license of right will be applied. The license of right is a public offer 
of a non-exclusive right by the patent owner, subject to agreement on 
royalties. 
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Trademarks  

Global IP Estimator calculates the charges for single verbal/word 
trademarks, not collective or series trademarks, not design, symbol, or 
logo trademarks. 

 Numeric Items 

Number of Classes: The number of international Trademark classes 
being applied for. 

Number of Pages for Translation of Goods: The number of pages 
of goods in the Trademark application. 

Number of Items of Goods: The type of goods is a subcategory of 
the classes as defined under the International Classification of Goods 
and Services. 

Number of Convention Priorities: The number of earlier 
applications which are being used to claim priority for the current 
one.  

Number of Seniority Claims for E.C. T/M: The number of 
Trademarks granted elsewhere that are used as seniority claims when 
filing for the European Community Trademark. 

Number of Designations for ARIPO: This number is the count of 
countries designated that are members of ARIPO. 

Number of Documents for Legalization: This represents the 
number of documents which must be legalized. 

 Yes/No Items 

Applicant is Assignee: If “Yes” is selected, this indicates that the 
application is being made by the assignee. 

Late Filing of Assignment: If “Yes” is selected, this indicates that 
the Assignment (if required) will be filed late. 

Late Filing of Priority Documents: If “Yes” is selected, this 
indicates that Priority documents (if required) will be filed late. 
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Late Filing of Power of Attorney: If “Yes” is selected, this 
indicates that the Power of Attorney (if required) will be filed late. 

Filer is a Large Entity: If “Yes” is selected, this indicates that the 
application is being filed by a large entity. In this case, the lower fees 
that may be available for a small entity are not used in the estimate. 

Applicant is an Individual: If “Yes” is selected, this indicates that 
the application is being filed by an individual. 

Courier Used: If “Yes” is selected, this indicates that a courier is 
being used with the application. The associated In-House amount is 
then added to the estimate. 

Application Filed Electronically: If “Yes” is selected, this indicates 
that the application is filed electronically. Some countries offer fee 
reductions to official charges with this option. 

JP - Reclassification Required: If “Yes” is selected, this indicates 
that reclassification of the specification of goods under the former 
Japanese classes to the international classes is required. 

Renewal Includes TM Maintenance: If “Yes” is selected, this 
indicates that maintenance fees, such as yearly taxes or quinquennial 
fees, that would become due prior to the renewal of a trademark 
should be included in the estimate. 

CA-File Declaration of Use: This allows for a distinction between 
“Intend to Use” and “Use Based” trademark applications.  

Extended Search in All EU: Searches among identical and similar, 
national, international, and Community Trademarks in all 27 EU 
member countries. 

Extended Search in Core EU: Searches among identical and 
similar, national, international, and Community Trademarks in 
Austria, Belgium, Denmark, Finland, France, Germany, Greece, 
Ireland, Italy, Luxembourg, Netherlands, Portugal, Spain, Sweden, 
United Kingdom. 
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Madrid Protocol 

 Numeric items 

Number of Classes: The number of international Trademark classes 
being applied for. 

 Yes/No items 

MP T/M filed with USPTO: If marked “Yes”, this indicates that the 
Madrid Protocol Trademark was filed with the United States Patent 
Office and the Official Certification Fee charged by the USPTO is 
added to the estimate. 

MP T/M filed with UKIPO: If “Yes” is selected, this indicates that 
the Madrid Protocol Trademark was filed with the United Kingdom 
Intellectual Property Office. 

MP - Subsequent Designation: If “Yes” is selected, this option 
includes the costs for extending the scope of the international 
registration to members of the Madrid Union for whom either no 
designation has been recorded to date, or the prior designation is no 
longer in effect. 
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Designs 

These are also referred to as Industrial Designs or Industrial 
Models. 

 Numeric Items 

Pages in Application (excluding Drawings): The number of pages 
in the application, but not including the pages of drawings. These are 
typically, but not always, the pages of text which may need 
translation. (Note that you specify the number of pages needing 
translation separately in the Pages for Translation item.) 

Pages of Drawings: The number of pages in the application that are 
drawings. 

Pages for Translation: The number of pages in the application that 
need translation. 

Number of Designs: The number of designs in the application. 

Number of Classes: The number of international classes applied for. 

Number of Drawings: The number of drawings in the application.  

Number of Convention Priorities: The number of earlier 
applications which are being used to claim priority for the current 
one. 

Number of Designations for ARIPO: This number is the count of 
countries designated that are members of ARIPO. 

Number of Documents for Legalization: This represents the 
number of documents which must be legalized. 

 Yes/No Items 

Applicant Is Assignee: If “Yes” is selected, this indicates that the 
application is being made by the assignee. 
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Late Filing of Assignment: If “Yes” is selected, this indicates that 
the Assignment (if required) will be filed late. 

Late Filing of Priority Documents: If “Yes” is selected, this 
indicates that Priority documents (if required) will be filed late. 

Late Filing of Power of Attorney: If “Yes” is selected, this 
indicates that the Power of Attorney (if required) will be filed late. 

Filer is Large Entity – US: If “Yes” is selected, this indicates that 
the filer meets the Large Entity requirements for the United States. 

Filer is a Large Entity: If “Yes” is selected, this indicates that the 
application is being filed by a large entity. In this case, the lower fees 
that may be available for a small entity are not used in the estimate. 

Applicant is an Individual: If “Yes” is selected, this indicates that 
the application is being filed by an individual. 

Courier Used: If “Yes” is selected, this indicates that a courier is 
being used with the application. The associated In-House cost is 
then added to the estimate. 

Application Filed Electronically: If “Yes” is selected, this indicates 
that the application is filed electronically. Some countries offer fee 
reductions to official charges with this option. 

Applicant is Inventor: If “Yes” is selected, this indicates that the 
application is being filed by the inventor. 
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Utility Models 

These are frequently referred to as Petty Patents, Short-Term 
Patents, or Patent of Innovation. 

 Numeric Items 

Pages in Application (excluding Drawings): The number of pages 
in the application, but not including the pages of drawings. These are 
typically, but not always, the pages of text which may need 
translation. (Note that you specify the number of pages needing 
translation separately in the Pages for Translation item.) 

Pages of Drawings: The number of pages in the application that are 
drawings. 

Pages for Translation: The number of pages in the application that 
need translation. 

Number of Claims: The number of claims in the application. 

Number of Claims for Japan: The number of claims used for the 
Japanese application for the examination, granting, and annuity 
stages. This allows for the fact that applications to Japan are 
sometimes modified to reduce the number of claims, since the 
Japanese charges for these stages increase with the number of claims. 

Number of Independent Claims: The number of independent 
claims in the application. 

Number of Convention Priorities: The number of earlier 
applications which are being used to claim priority for the current 
one. 

Number of Designations for ARIPO: This number is the count of 
countries designated that are members of ARIPO. 

 Yes/No Items 

Late Filing of Priority Documents: If “Yes” is selected, this 
indicates that Priority documents (if required) will be filed late. 
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Late Filing of Power of Attorney: If “Yes” is selected, this 
indicates that the Power of Attorney (if required) will be filed late. 

Filer is a Large Entity: If “Yes” is selected, this indicates that the 
application is being filed by a large entity. In this case, the lower fees 
that may be available for a small entity are not used in the estimate. 

Applicant is an Individual: If “Yes” is selected, this indicates that 
the application is being filed by an individual. 

Application Filed Electronically: If “Yes” is selected, this indicates 
that the application is filed electronically. Some countries offer fee 
reductions to official charges with this option. 

Applicant is Inventor: If “Yes” is selected, this indicates that the 
application is being filed by the inventor. 
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Assignments 

The Assignment Module is the one place in GLOBAL IP 
ESTIMATOR where it is possible to obtain an estimate for multiple 
patents, trademarks, or designs at one time. For example, if the 
assignment document for trademarks has several trademarks, the user 
can get one single estimate, as long as each trademark has the same 
number of classes. 

 Numeric Items 

Pages for Translation: The number of pages in the assignment 
application that need translation. 

Number of Classes: The number of international classes applicable 
to the assignment. 

Number of Designations for ARIPO: The number of countries 
designated in the ARIPO application. 

Number of Documents for Legalization: This represents the 
number of documents which must be legalized. 

Number of Assignments: The number of patents, trademarks, or 
designs being assigned on the application. 

Number of Name Changes: The number of patents, trademarks, or 
designs with name changes in the application.  

Number of Address Changes: The number of patents, trademarks, 
or designs with address changes in the application.  

 Yes/No Items 

Filer is a Large Entity: If “Yes” is selected, this indicates that the 
application is being filed by a large entity. In this case, the lower fees 
that may be available for a small entity are not used in the estimate. 

Applicant is an Individual: If “Yes” is selected, this indicates that 
the application is being filed by an individual, and lower fees may be 
available. 
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Application Filed Electronically: If “Yes” is selected, this indicates 
that the application is filed electronically. Some countries offer fee 
reductions to official charges with this option. 
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H  Global IP Directory 

Please take advantage of our FREE WEB SERVICE for IP 
practitioners. 

Global IP Directory 

What is it? It lists legal practices all over the world specializing in 
Intellectual Property, and has been created to meet your needs as 
an IP practitioner. Listings are organized by country. Each firm 
has its own page, which includes information about the size of 
the firm, the specialties of practitioners, and comments about IP 
applications for that country. You will also find a link to the 
firm's web site. 

Where is it? Got to our web site at www.quantifyip.com, and click 
on the Global IP Directory tab at the right side of the page. 

How are firms selected for listing? The condition for selection is 
that they send us their fee schedules on a regular basis. These 
schedules are incorporated into the database for GLOBAL IP 
ESTIMATOR, continually enhancing its accuracy. (For your 
information, the database incorporates information from many 
more firms than are currently listed.) 

DO YOU HAVE A FEW MINUTES TO HELP US GATHER 
MORE LISTINGS? 

Additional listings serve you, us, and the firms listed. 

• Global IP Directory serves you as a source for new associates, 
and as a source of continually updated contact information for 
associates you already know. 

• Global IP Directory serves the firms by providing them with 
another method of announcing their services. 

• Global IP Directory serves us by providing yet another source 
for the latest worldwide fee information, which is incorporated 
into GLOBAL IP ESTIMATOR, and serves you in turn. 
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TO RESPOND, please email us at research@quantifyip.com with 
the subject "Global IP Directory". We will communicate with you to 
arrange the most appropriate method of contacting your foreign 
associates. 

We hope that Global IP Directory will become a well-used resource 
for you and your firm, and we thank you for your help in adding 
listings to the site. 
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